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Getting Started
This section is intended to provide users with an introduction to the STEP system and concepts. Additionally,
it provides detailed information needed to perform basic data maintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around STEPWorkbench, but the concepts and functionality presented are often
applicable to both the workbench andWeb UI interfaces. Because of this, it is helpful for users of either
interface to be familiar with the material in this guide. For documentation specific to the Web UI, refer to the
Web User Interfaces guide.

The Getting Started guide contains the following sections.

Introduction: This section includes a terminology table and an overview of some basic STEP concepts.
This material should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.
STEPWorkbench UI: This section introduces the user to the workbench interface, as well as providing
detailed reference information for the various functions, including toolbar actions and menu options.
Object Maintenance in the Tree Tab: This section provides an overview of creating, editing, and deleting
objects in the workbench, as well as providing detailed information for working with particular types of
objects.
Navigating and Searching: This section introduces the user to basic search and navigation functionality
in STEPWorkbench, as well as providing detailed descriptions of the search criteria available on the
Advanced Search tab.
STEPWorkbench Keyboard Shortcuts : This topic provides a list of keyboard shortcuts that can be used
in the workbench.
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Introduction
This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.

STEP Terminology: A table defining basic STEP terms, including links to topics with additional
information.
Basic STEP Concepts: Introduces some core concepts in STEP to facilitate understanding of the
Getting Started and System Setup guides.
Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.
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STEP Terminology
This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the
online help. Links to additional material on related topics are also provided, when appropriate. This should not
be considered a complete list of all STEP terms as it is intended to cover only the more commonly used terms
that users are likely to encounter throughout the online help.

A

Term Definition Further Reading

Action Type of business rule that can be executed to manipulate data or
perform an action. Actions can be executed by various processes and
events within the system. For example, at approval of an object, within
a workflow (on entry to a state, exit from a state, on the transition
between tasks, or when a deadline has been met), as part of an import
process, or from a bulk update process.

Refer to the
Business Actions
topic in the
Business Rules
documentation.

API refer to Public API Refer to the
Technical
Documentation
link on the Start
Page.

Approval The process of pushing data from the Maintenance workspace to the
Approved workspace in STEP. Approval can be associated with
business logic that may prevent approval or may perform automated
data updates during approval. Approvals are often the triggers for
sending data to downstream systems.

Refer to the
Approval of
Objects topic in
the Getting
Started
documentation.

Asset Any type of digital media, such as an image, Word document, PDF,
Excel file, PowerPoint, JPG, GIF, etc.

Refer to the
Assets topic in
the Getting
Started
documentation.

Asset Push A process that exports assets from STEP to a file system. Conversion
templates can be applied to transform images, for example from high
res to low res, resizing, applying color scales, etc., though assets can

Refer to the Asset
Push topic in the
Digital Assets
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Term Definition Further Reading

also be sent as-is to make them available on the file system. documentation.

Assignee The user or group to which a task is assigned for work to be performed
within a workflow. User states can be assigned directly to a named user
or to a user group. When a state is assigned to a user group the task is
"offered" to all members of that group. To perform the task associated
with the state, a member of the group has to claim the task. Once a task
is claimed it is no longer visible in the group task list; only the person
who claimed the task is able to view it. A user may subsequently
release a task back to the group.

Refer to the
Assignees in
Workflows topic
in the Workflows
documentation.

Attribute A characteristic or detailed piece of information related to a particular
object. Attributes can be one of two types, description or specification.
Description attributes are available on most object types in STEP, while
specification attributes are only available on objects in the Primary
Product Hierarchy.

Refer to the
Attributes topic in
the System Setup
documentation.

Attribute
Group

Groups attributes, reference types, and/or link types. Attribute groups
can have sub-groups.

Refer to the
Attribute Groups
topic in the
System Setup
documentation.

Attribute
Value

The value stored in a particular attribute on a particular object. Refer to the
Attributes topic in
the System Setup
documentation.

B

Term Definition Further Reading

Bookmark A placeholder created by the user that serves as a shortcut to a
previously viewed location.

Refer to the
Bookmarks topic in
the Getting Started
documentation.

Business Automated piece of programming logic that may implement Refer to the Business
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Term Definition Further Reading

Rule customer-defined rules, such as validations, automatic updates,
notifications, data-driven workflow routing, etc. Also refer to
Condition and Action.

Rules topic in the
Business Rules
documentation.

C

Term Definition Further Reading

Calculated
Attribute

An attribute where the value is calculated according to a specific
formula defined for this attribute. The formula may include static
text, other attribute values, information from references on the
object, and a number of other options.

Refer to the
Calculated
Attributes topic in
the System Setup
documentation.

Category Profile View in STEP that helps product managers and data analysts to
get an overview of an entire section of the Product Hierarchy
through various metrics that are displayed in dashboard format.

Refer to the Data
Profiles topic in
the Data Profiling
documentation.

Character Tag An entry that begins with “<” and ends with “/>” such as <check/>.
These tags represent characters that may not be found in the
special character map in Unicode, or may be used instead of the
Unicode character.

Refer to the Tags
topic in the
System Setup
documentation.

Claim The action that a user performs to take a task in a workflow out of
a group queue and assign to himself / herself.

Refer to the
Claiming and
Releasing Tasks
in Workflows
topic in the
Workflows
documentation.

Classification A particular type of hierarchy that organizes groups of objects or
assets. Objects are linked to classifications via references, and
may have references to multiple classifications. Also referred to as
"yellow folders."

Refer to the
Classifications
topic in the
Getting Started
documentation.
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Term Definition Further Reading

Collection An object that holds a static set of objects, or a dynamic search
criteria that can be refreshed as needed to find the latest matching
objects. Using collections, the resulting data can be displayed,
bulk actions can be performed, or the objects can be exported.

Refer to the
Collections topic
in the Getting
Started
documentation.

Completeness
Score

A measurement within STEP, expressed as a percentage, to
indicate the proportion of key data that has been completed for a
particular object. This key data is configurable, as is the weighting
of importance.

Refer to the
Metric
Visualization
topic in the
System Setup
documentation.

Condition A condition is a type of business rule that evaluates to either true
or false, and does not change data. In relation with approval, a
condition can act as validation for whether an approval action can
be carried out. In relation to workflows, conditions can be used to
prevent a transition from being taken if certain conditions are not
met.

Refer to the
Business
Conditions topic
in the Business
Rules
documentation.

Context A specific filter placed on the system data. Each context is a
combination of different dimensions such as language, country,
and so forth, for example, English US, French CA, or German DE.
Data may vary based on context.

Refer to the
Contexts topic in
the System Setup
documentation.

D

Term Definition Further Reading

Data
Container

An object type for modeling complex entity or product data
structures with a single record. Data containers make use of
composite attributes which are composed of other data structures,
and they are intended to ensure that all create, read, update, and
delete operations can be performed as a whole.

Refer to the Data
Containers topic in
the System Setup
documentation.

Data Model Basic system configuration defining the allowable structures and
make up of data within STEP. Consists of system setup data,
including: dimensions, contexts, object types, reference types, keys,
component models, attribute groups, attributes, lists of values, units,

Refer to the
sections within the
System Setup
documentation.
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Term Definition Further Reading

and tags.

Dimension-
Dependent
Attribute

An attribute that can have different values for different dimension
points, where the actual value is determined by the context in which
the attribute is presented.

Refer to the
Dimension
Dependent
Attributes topic in
the System Setup
documentation.

E

Term Definition Further
Reading

Entity A group of master data that has a specific business meaning. Entities
typically store product-neutral data in STEP according to client-
specific groupings of information, such as customers, employees,
suppliers, and addresses. Entities are also often used to store
reference data that is utilized within the system. Entities can be
grouped into a hierarchy using reference types that are only valid from
an entity object to an entity object. A source object can be displayed
as a child of the target object or the target as a child of the source.

Refer to the
Entities topic in
the Getting
Started
documentation.

Externally
Maintained
Attribute

A characteristic of an attribute or reference that can be set to ’Yes’ or
’No’. A ’Yes’ selection indicates that the data point is maintained
externally, and a change in it does not trigger a change in approval
status and/or a new revision on the STEP object on which the data
was changed. A ’No’ selection indicates that the data point is
maintained internally and a change in it has the potential to trigger a
change in the approval status and/or a new revision on the STEP
object on which the data was changed.

Refer to the
Externally
Maintained
Attributes topic in
the System
Setup
documentation.

© Stibo Systems - Internal - 2024.4 - December 2024 13



F

Term Definition Further Reading

Function A type of business rule that allows for input parameters to
produce an output. These operations are side-effect free,
and it do not change STEP data.

Refer to the Business
Functions topic in the
Business Rules
documentation.

G

Term Definition Further Reading

Golden
Record

Collection of data from a variety of sources, based
on matching, linking, and survivorship rules. The
Golden Record is considered the trusted data
record, compiled from the various source objects.

Refer to the Survivorship in Match and
Merge topic, the Survivorship in Match
and Link topic in the Matching, Linking,
and Merging documentation.

GUI Graphical user interface. For STEP, this can be the
workbench or Web UI. A GUI

Refer to the GUI Setup topic in the
System Setup documentation or the
Design Mode Basics topic in the Web
User Interfaces documentation.

H

Term Definition Further Reading

Hierarchy A data structure composed of
parents and children.

Refer to the Object Type Hierarchy topic in the
System Setup documentation.

Hotfolder File system of folders where data
can be dropped for automatic
loading into STEP, based on the
particular configurations and/or
code applied to the hotfolder.

Refer to the IIEP - Choose Receiver topic in the Data
Exchange documentation, Configuring an
Asynchronous File Exchange Service topic in the
Data Integration documentation, or the Asset Importer
topic in the Digital Assets documentation.
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I

Term Definition Further Reading

ID The unique identifier for all objects within STEP. It cannot be
translated or edited once created, and cannot contain special
characters.

Image
Conversion

A series of parameters defining the way in which an image is
transformed from the standard high resolution asset that exists in
STEP to the required downstream format. Several conversion
options are available by default, and additional conversions can be
added via configuration and/or extensions. Note that conversions
change assets as they are pushed from STEP, leaving the
originating file unchanged in STEP.

Refer to the
Image
Conversion
Configuration
topic in the Digital
Assets
documentation.

Inbound
Integration
Endpoint
(IIEP)

Communication channel defining how data is received by STEP.
Each endpoint defines how data is received from an external system,
specifying location, transport protocol, data to be exchanged and
other configuration parameters.

Refer to the
Inbound
Integration
Endpoints topic in
the Data
Exchange
documentation.

Integration
Endpoint
(IEP)

Communication channel between STEP and external systems. Refer
to Inbound Integration Endpoint and Outbound Integration Endpoint.

Refer to the Data
Exchange
documentation.

Inheritance The ability to make data available in the product or classification
hierarchy to lower nodes by linking it to a higher node in the
hierarchical structure.

Refer to the
Inherited
Attributes topic in
the System Setup
documentation.

© Stibo Systems - Internal - 2024.4 - December 2024 15



J

K

L

Term Definition Further Reading

Library Set of functions that can be reused in multiple business rules or
other libraries. Libraries cannot be called independently and must
be referenced from other actions, conditions, or functions.

Refer to the
Business Libraries
topic in the Business
Rules
documentation.

Link A parent/child relationship between objects within the STEP system. Refer to the
Reference and Link
Types topic in the
System Setup
documentation.

List of
Values
(LOV)

A validation base type for an attribute that only allows a value to be
considered valid if it belongs to a respective list of pre-configured
values assigned to the attribute. Also used to refer to the value list
itself. LOVs are also referred to as 'Domains' at times.

Refer to the List of
Values (LOV) topic
in the System Setup
documentation.

Localized
Value

An attribute value that is set directly on an object and is not inherited
from any level above in the hierarchy.

Refer to the
Inherited Attributes
topic in the System
Setup
documentation.

M

Term Definition Further Reading

Mandatory
Attribute

Indicates that the product and all its sub-products
must have a value for the specified attribute in order
for the object to be approved.

Refer to the Mandatory Attributes
topic in the System Setup
documentation.
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Term Definition Further Reading

Multi-Valued
Attribute

An attribute that can contain more than one value for
a specific object.

Refer to the Editing Multi-Valued
Attributes topic in the System
Setup documentation.

N

O

Term Definition Further
Reading

Object An element within the system, for example, a product, image,
classification, attribute, workflow, business rule, etc.

Refer to the
Basic STEP
Concepts topic in
the Getting
Started
documentation.

Object Type A specific label for levels within a taxonomy, given to different
elements within the system. Nearly every object in STEP is labeled
with an object type to help identify what it is (i.e., a product or entity
rather than an image, a TIF rather than a PDF, etc.). This includes
entities, products, product categories, alternate hierarchies, images
and other assets, attributes, and LOVs. Through the use of object
types, system administrators can control how rigid or loosely defined
the database will be in terms of object creation and where objects are
allowed to ‘live’ and/or be used. This labeling also becomes very
important when working with exported data so that each type of object
in STEP can be identified for special handling in web applications or
other uses outside of STEP.

Refer to the
Basic STEP
Concepts topic in
the Getting
Started
documentation.

Orphan
Attribute

A specification attribute that has a value, which has been deleted from
/ not linked to a product node or classification and is denoted by italics.

Refer to the
Linking Orphan
Attributes topic in
the System
Setup
documentation.
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Term Definition Further
Reading

Outbound
Integration
Endpoint
(OIEP)

Communication channel defining how data is sent by STEP. Each
endpoint defines how data is sent to an external system, specifying
location, transport protocol, data to be exchanged and other
configuration parameters.

Refer to the
Outbound
Integration
Endpoints topic
in the Data
Exchange
documentation.

P

Term Definition Further Reading

Post-processor A plugin component within the IEP
framework that allows STEP to act on the
result of the import / export such as
starting workflows, sending notifications,
etc.

Refer to the IIEP Configuration Section of
the Maintaining an Inbound Integration
Endpoint topic and the OIEP - Event-
Based - Output Templates Section and
OIEP - Select Objects - Output Templates
Section topics in the Data Exchange
documentation.

Pre-processor A plugin component within the integration
endpoint framework that allows STEP to
modify the message prior to import /
export. It can be used for various
functionality such as pre-validation,
format conversion, filtering, etc.

Refer to the IIEP Configuration Section of
the Maintaining an Inbound Integration
Endpoint topic and the OIEP - Event-
Based - Output Templates Section and
OIEP - Select Objects - Output Templates
Section topics in the Data Exchange
documentation.

Primary
Product
Classification
(PPC)

Hierarchy that allows for different types of
objects to be stored once in the database;
each object within this hierarchy has a
unique ID / identifier and may have only
one location within the hierarchy. Also
referred to as the 'blue hierarchy'.

Refer to the Object Type Hierarchy topic in
the System Setup documentation.

Product One of the object super types, referring to
any object within the Primary Product
Classification (blue hierarchy).

Refer to the Products topic in the Getting
Started documentation.
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Term Definition Further Reading

Product
Template

InDesign templates that determine what
type of data will appear on a printed page,
including the positioning and styling.

Refer to the Product Templates topic in the
Publisher (Adobe InDesign Integration)
documentation.

Product Variant Data type used to model multiple variants
of a similar object. For example, T-shirts
in various sizes and colors could all be
variants of a single product.

Refer to the Product Variants topic in the
System Setup documentation.

Print Proof
View

A tab in workbench or Web UI that
displays a product template view ('proof')
of a selected node (typically a Product but
can also be an Entity or Classification)
without the user needing to access
InDesign.

Refer to the Print Proof View section of the
Publisher (Adobe InDesign Integration)
documentation.

Publication One of the super types, referring to
objects in the publication (green)
hierarchy.

Refer to the Publication Hierarchy topic of
the Publisher (Adobe InDesign Integration)
documentation.

Public API The set of server-side functions that have
been exposed to be used in the business
logic. This includes many functions to
create, get, and set data, such as values
and references. It also includes various
methods for logging as well as sending
emails.

Refer to the Technical Documentation link
on the Start Page.

Purge Removal of an object from the database.
Following purge, an object cannot be
revived.

Refer to the Revisions topic in the System
Setup documentation.

Q

Term Definition Further
Reading

Queue The mechanism within the IIEP framework that allows messages to be Refer to the
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Term Definition Further
Reading

processed in an asynchronous way. The queuing concept allows
separating processes from different integration endpoints as well as
controlling the degree of parallel imports (a queue size of one guarantees
sequential import, while a queue size larger than one allows parallel
processing of multiple messages for increased throughput where
sequential execution is not required).

Background
Processes and
Queues topic in
the System
Setup
documentation.

R

Term Definition Further Reading

Reference An association between objects
within the STEP system.

Refer to the Reference and Link Types topic in the
System Setup documentation.

S

Term Definition Further Reading

Setup Entity A configuration object that is based on a generic
type of object which has been expanded for the
specific need. For example: Completeness Metric,
Elasticsearch Configuration, Asset Importer
Configuration Type.

Setup entities are identified in the URL with
'step://SetupEntity', in STEPXML within the
<SetupEntities> tag, and in user privileges via the
Maintain Setup Entity action set. Setup Entities can
be exported using both the STEPXML and
Advanced STEPXML formats.

Refer to the URL Address
Field section of the Toolbar
topic and the Setup Actions
and Error Descriptions topic,
both in the Getting Started
documentation.

Also refer to the STEP-
ProductInformation Tag in
STEPXML topic and the
STEPXML Outbound
Parameters topic, both in the
Data Exchange
documentation.

Special
Character

A character that cannot be found on a standard
keyboard but can usually be found in the Windows
character map. Example: Trademark Symbol - ™

Refer to the Tags topic in the
System Setup documentation.
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Term Definition Further Reading

State A step within a workflow to which a specific user,
user group, or system can be assigned to complete
the task(s) associated with the state.

Refer to the Creating a
Workflow topic in the
Workflows documentation.

STEP Stibo Enterprise Platform master data software
application that provides business managers a
single source database to store, manage, and re-
purpose product information for publication or
syndication.

STEP’n’design STEP’s plugins for InDesign that allow data from the
STEP database to be pulled onto pages. This is an
outdated term and has been replaced with 'Print
Publisher.'

Refer to the Print Publisher
topic in the Publisher (Adobe
InDesign Integration)
documentation.

STEPXML The native XML language for STEP, which can be
used for importing / exporting STEP data, as well as
transferring configurations between STEP systems.

Refer to the STEPXML Format
topic in the Data Exchange
documentation.

Super type A major category of data within STEP including:
Asset, Classification, Entity, Product, and
Publication. Refer to the specific definition for each
super type for additional information.

Refer to the Object Super
Types topic in the Getting
Started documentation.

Super User A user that is given administrative privileges within
the STEP system.

Refer to the Action Sets topic
in the System Setup
documentation.

Superseded The 'Superseded' status displays with affected
components and serves as guidance to admin users
selecting which components to implement when
configuring their Web UI.

Refer to the Web UI
Component Basics topic in the
Web User Interfaces
documentation.

T

Term Definition Further Reading

Task The work and/or action that must be completed Refer to the Working with Tasks in
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Term Definition Further Reading

within a specific workflow state (whether by a user
or via automation).

Workflows topic in the Workflows
documentation.

Transition The change of tasks from one state to another
within a workflow.

Refer to Creating a Workflow topic in
the Workflows documentation.

U

Term Definition Further
Reading

Unique Key A unique key is a system entity that represents a specific object in
the STEP system. The entity is composed of one or more data
points, whether utilized as-is or in a combined and/or transformed
format using a specified formula. There can be exactly one record for
each object for each defined key. No two objects with the same
unique key for an active key can exist.

Refer to the
Unique Keys
topic in the
System Setup
documentation.

User
Permissions

Rules that allow or restrict users from performing certain functions
within the system.

Refer to the
Privilege Rules
topic in the
System Setup
documentation.

V

Term Definition Further Reading

Validation
Base Type

A characteristic of attributes that identifies the format of the
accepted data for the attribute value, such as whether the
value is a date, integer, fraction, text, LOV, etc.

Refer to the Validation
Rules topic in the System
Setup documentation.
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W

Term Definition Further Reading

Web UI A web-based interface to access the STEP database in order to
read, edit, or download data and assets. Multiple Web UIs can be
configured for each STEP installation.

Refer to the Web
User Interfaces
documentation.

Workbench An interface for managing data in STEP, as well as carrying out
administrative functions.

Refer to the STEP
Workbench UI
topic in the
Getting Started
documentation.

Workers A unit in SaaS to define how a process is run, one process runs on
one or multiple workers. One CPU can run on multiple workers.

Refer to the
Sensors for
External
Monitoring topic
in the
Administration
Portal
documentation.

Workflow Business process(es) modeled as a series of states and tasks that
can be executed by users and/or automatic processes within the
STEP system. Workflows prompt the next step of a process to be
started, by either creating a task for a user, or sending an alert.
Workflows may contain a number of process steps or tasks, as well
as business logic.

Refer to the
Workflows
documentation.

Workspace A set of independent ‘copies’ of the database objects that provides a
revision-specific view of objects. Workspaces are organized into
separate areas including Main and Approved. The Main workspace
is where data maintenance takes place. The approved workspace is
a non-editable snapshot of data that has been determined to have
been acceptable for publishing to downstream systems.

Refer to the
Workspaces topic
in the System
Setup
documentation.

X

Y

Z
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Basic STEP Concepts
This topic introduces some fundamental STEP concepts that provide a foundation for the rest of the material
in the Getting Started documentation, as well as the System Setup documentation. The focus of this topic is
on data structures and data management, and is not intended to be an introduction to the full capabilities of a
STEP system.

Object Types Overview
Technically, nearly everything in STEP is an object, and object types must be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different
elements within the system. Nearly every object in STEP is labeled with an object type to help identify what it
is (i.e., a product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products,
product categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of
object types, system administrators can control how rigid or loosely defined the database will be in terms of
object creation and where objects are allowed to "live" and/or be used. This labeling also becomes very
important when working with exported data so that each type of object in STEP can be identified for special
handling in web applications or other uses outside of STEP.

Object types in STEP can largely be divided into two categories:

Tree Object Types: Object types that make up the standard STEP hierarchies are accessible on the Tree
tab in workbench. Many of these object types can be further grouped into five categories of object types,
referred to as the super types. Tree object types are defined in System Setup, but instances of the object
types are accessed within the Tree.

System Setup Object Types: Also referred to as Basic Object Types. This category encompasses all of the
remaining object types that make up a STEP system. Among many other things, this includes attributes,
users, integration endpoints, workflows, and business rules. System Setup object types are defined in
System Setup, and instances of the object types are also accessed within System Setup.

For more general information on object types, including how to create and maintain object types, refer to the
Object Types and Structures topic of the System Setup documentation.

Object Super Types

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are
housed using the asset super type, which allows for automatic reading and storing of asset properties such as
size and format. Any number of individual object types within each super type can be created. For example, a
systemmay use both an 'Icon' object type and an 'Illustration' object type (along with any number of others)
within the asset super type.

The object super types are:
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1. Assets

2. Classifications

3. Entities

4. Products

5. Publications

For more information on the characteristics of the various super types, refer to the Object Super Types topic.

Object Types Versus Object Instances
Two core capabilities for managing data in STEP are the Tree tab and the System Setup tab. To successfully
use STEP, it is critical to understand the differences between the functions available in these two areas,
specifically in relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and
import configurations, products, classifications, images, etc. However, the term "objects" is more generally
used to mean assets, classifications, entities, products, and publications. In other words, the super types are
also all things that you can find on the Tree tab in STEP. This section focuses on the differences between
object types and object instances for Tree objects, specifically those that fall into the super types.

For example:
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The objects and structures available in the Tree will vary based on your particular data model, but the
concepts described can be applied across any data model. Regardless of the specific names or structures,
each node on the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user
can right-click on many of these objects and have a 'New...' option, such as 'New Product' or 'New
Classification', allowing them to create a new node in the hierarchy. For example, when right-clicking on the
'Apparel' object and selecting 'New Product', a dialog appears with an option to create an object with one of a
few possible object types.

Typing a Name and clicking Create would create a new object as a child to the Apparel node.

But consider these questions:

What defines that a 'Level 2' object can be created on this node?

What defines that it is a Product (blue) object rather than an Entity (gray) or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in System Setup.
Continuing with the above example, we can observe that the defined object types and structures include a
Primary Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which in
turn can only have a Level 3 child. However, a Level 3 object type can have a number of child object types,
including an Item Folder, Level 4, and a Sales Item Folder. A Sales Item Folder is a child of a Level 3 object
type, as mentioned, but can also be a child to a Level 4. Similarly, a Sales Item can be child to multiple things,
including a Sales Item Folder and a Sales Item Family.
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The object types defined in System Setup provide the "skeleton" for the allowable instances of objects that
can be created in the Tree. It is important to understand that only the structure and types of objects are
defined in System Setup, but any number of instances of the defined types can be created in Tree. This is best
illustrated by viewing System Setup and Tree side by side, as shown below. Object instances are displayed in
Tree, with red text indicating the corresponding object type designations from System Setup.

Notice in the above screenshots that a Level 2 object exists in System Setup only once, but there are multiple
instances of it in Tree.

The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For
example, an entity hierarchy could have a customer object type with allowable children of address and contact
object types. The object types and structures are defined in System Setup, and instances of these objects can
then be created in Tree.
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Object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy (blue
hierarchy) can only contain object types of the product super type, while an entity hierarchy (gray hierarchy)
can only contain objects of the entity super type. It is possible to have the visual appearance of mixed
hierarchies, but this is accomplished via references rather than actual data structures. For example, products
in the Tree may appear to be within a classification hierarchy, but this is due to references on the object, as
shown below.

Notice that the corresponding System Setup structure for the above does not include the product object types.
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The true residence of the product objects is within the Primary Product Classification, with a visual display of
the product references into various classification hierarchies being just that: a visual display of references.
However, assets are an exception to this concept. Assets are not part of the classification structure in System
Setup, but do exist within this structure in Tree. Each asset must be linked to one or more classifications, and
this is the only location in which they "live" in STEP. Each asset automatically has a reference applied to each
classification in which it is linked. More information on references can be found in the Reference and Link
Types topic in the System Setup documentation. More information on the various object super types and their
characteristics can be found in the Object Super Types topic.

Using the above information, the questions posed earlier in this topic can now be answered:

Why can we only create a Level 2 object under the Apparel node? Because in this particular data model
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be
created under a Level 1 object type.

Why can we not create an Entity or Classification under the Apparel node? Because only object types
within the same super type can exist within the same hierarchy. And even if this was not the case, the
structure defined in System Setup in this particular hierarchy only allows a Level 2 object type (of the
product super type) under a Level 1 object type.

Note: All text data is saved in the system in Unicode UTF-8. All standard data exports from the system are
also in UTF-8. Some system extensions may use a different character set on export, but the standard is
UTF-8.

UTF-8 can define more than one million characters. To do so, it uses up to 4 bytes of storage. Regardless
of whether it uses one, two, three, or four bytes, it is still one character, and as such, any character counts
that are imposed on the text attribute’s length are specified and counted in characters and not in bytes.
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As a standard, the Microsoft Arial Unicode font is used for display. Its character set supports most
languages of the Americas, and Western and Eastern Europe (including Cyrillic and Greek). In some
cases, as in the case with some Asian languages, additional fonts must be loaded onto the PC or MAC.
But for most cases, the character set provided by Arial Unicode MS is sufficient.

For more information on Unicode UTF-8, refer to the various web sites that describe its functionality, such
as the Wikipedia site: https://en.wikipedia.org/wiki/UTF-8.
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Object Super Types
This topic provides an introduction to the STEP object super types. It will be helpful to first read and
understand the Basic STEP Concepts topic.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in workbench are
referred to as Tree Object Types. Many of these object types can be further grouped into five categories of
object types, referred to as the super types. This topic introduces the primary object super types in STEP.
Understanding the differences between the various object super types is important when making decisions
about how to model data in STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are
housed using the asset super type, which allows for automatic reading and storing of asset properties such as
size and format. Any number of individual object types within each super type can be created. For example, a
systemmay use both an 'Icon' object type and an 'Illustration' object type (along with any number of others)
within the asset super type.

The object super types are:

1. Assets

2. Classifications

3. Entities

4. Products

5. Publications

Each is described below, along with links to more detailed information for working with the various super
types.

Assets
The asset super type is used to hold any type of digital media, including images, videos, documents, and text
files. Assets are organized within classifications, and can be linked to other objects in STEP using references.
Specifically, assets can be linked to objects of the classification, entity, or product object super types. Upon
import, STEP populates some basic information about each asset, which can be viewed under the System
Properties section on each asset, but cannot be edited. Default asset icons vary by file type, and can be
updated by admin users.
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For more information on working with assets, refer to the Assets topic.

Classifications
The Classification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these icons may be updated
by an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored
in appropriate subfolders under the 'Assets' classification folder. Product objects could also be linked into
classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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For more information on working with classifications, refer to the Classifications topic.

Entities
The Entity super type is used to create hierarchies and objects that do not require inheritance of data through
categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to
store reference data. In addition, entities are used to store source data for golden records. Entities are
represented by gray folders and white and gray cubes by default, but these can be updated by an admin user,
as is evident in the screenshot below.
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For more information on working with entities, refer to the Entities topic.

Products
The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy
are often categories and subcategories, with leaf nodes being actual objects. Whether an organizational
folder, sellable object, or something else, each node in the hierarchy is of the product super type, and all child
objects are able to inherit attributes and values from parental objects.
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For more information on working with products, refer to the Products topic.

Publications
The Publication super type is used to create hierarchies and objects used for print publishing solutions,
including Print Publisher, Print Flatplanner, and Print AutoPage. Publication objects are used to create
templates used in print solutions, as well as publications such as catalogs or pamphlets. Product objects can
be linked into publication hierarchies, meaning data from the product(s) will be reflected in the publication.
Publication objects use green icons by default, though these can be updated by an admin user.
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For more information on working with publication objects, refer to the Publication Hierarchy topic of the
Publisher (Adobe InDesign Integration) documentation.
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Accessing STEP System Information
The simplest way to access system information about your STEP installation to click the About STEP link on
the Start Page.

STEP system information is useful for system troubleshooting and new project planning, as well as helping
users ensure compliance with their contracted license terms.

The most straightforward way to view system information is to click About STEP from the Start Page. System
information is also available in the Admin Portal install.log or by running a Stibo Patch Operations Tool
(SPOT) command on the application server. For more information on the install.log, refer to the Logs topic in
the Administration Portal documentation. For on-premise systems, information on SPOT is included in the
'SPOT Program' topic in the 'System Administration Guide' found in 'Downloadable Documentation'. For
SaaS systems, contact Stibo Systems.

'About STEP' Page
When the About STEP icon is clicked, a new page is opened (e.g., http://[yoursystem]/about/step) that is
password protected to ensure that only STEP users have access to the information.

This 'about' page displays the following information:

'System name'
'STEP version' in a string (as shown below) that identifies the system by its baseline version that includes
the year (e.g., 2024); the quarter(e.g., .2); if there is an ad-hoc maintenance patch for the baseline, then,
the maintenance patch number will show after the quarter (e.g.,mp1); and the baseline creation date.
'Number of user accounts' and the 'Number of allowed user accounts'. Standard STEP users that do not
count against the number of licensed users are not included in the user count, such as DBA, STEPSYS,
SERVICE, and SWADMIN.
The approximate number of 'products', 'classifications', 'assets', and 'entities'. Object counts are
approximate because changes can happen in the background while the page is being viewed. Also, for
time purposes, the quick approximation number is preferable to an exact count, which could potentially tie
up system resources for a prolonged time.
The number of 'contexts', 'dimensions', and 'languages'.
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Detailed Version Information

A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g., http://
[yoursystem]/about/version) where you can access information about the add-on components,
customizations, and hotfixes applied to your system. If your system contains none of these, only the current
baseline version of the system is displayed.
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System Snapshot and Diagnostics Package Links

Below the bullet list, additional information is provided to assist users who need to access more complete
system information for support purposes.

Provided is a snapshot.spr link where you can download a snapshot file that contains full system information,
including installed bundles, metrics, and differences to previous snapshots. This file is intended to be
submitted to Stibo Systems along with support requests. For more information on snapshots and their
contents, refer to the Tools topic in the Administration Portal documentation.

Also included is a link to the Administration Portal page, in case you need to produce a diagnostics package.
This package is generated and uploaded to Stibo Systems from the 'Send Diagnostics' tab. For more
information, refer to the Send Diagnostics topic in the Administration Portal documentation.
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STEP Workbench UI
The screenshot below shows a basic view of the STEPWorkbench. Though system customizations and
variable access permissions may result in a slightly different view, the basic elements in this view of the
workbench's Main Window will be present for most users. The key elements of workbench UI are numbered
and defined below.

Important: A one-time installation of the STEPWorkbench Launcher needs to be done on each client
workstation before opening the workbench. STEPWorkbench users do not need Java installed separately
on their computers. After installation, the workbench will launch via conventional means. For details and
directions, click on the Workbench Launchers link, accessible on the Start Page.

Note: The STEPWorkbench is a Java client. STEP's backend is AdoptOpenJDK.

© Stibo Systems - Internal - 2024.4 - December 2024 42



1. The Title Bar includes system information including the name of the system accessed and the user's ID.

2. The Menu Bar contains a collection of various tools for users to perform actions in the workbench. For
more information, refer to the Menu Items topic.

3. The Toolbar contains actions that help with the view and navigation of the workbench. For more
information, refer to the Toolbar topic.

4. The Environment badge displays the environment's purpose using color coding and text. The available
environment badges include development, test, acceptance, production, retired, training, sandbox,
preproduction, permanent sandbox, and release preview sandbox. When the bar is collapsed, hover over
the badge text to display the full name of the environment.

5. The Tree tab navigates users to the object tree in the workbench. For more information, refer to the Tree
Tab topic.

6. The Advanced Search tab provides access to the advanced search functionality of the workbench where
users can filter results, save these results as a collection, export these results for external use, or perform
bulk updates on these results. For more information, refer to the Advanced Search Tab topic.

7. The BG Processes tab contains all the background processes occurring in the STEP instance. For more
information, refer to the BG Processes Tab topic.

8. The System Setup tab contains all the administrative actions to set up the workbench to maintain data. For
more information, refer to the System Setup Tab topic.

9. The Bookmarks tab contains all the bookmarks that are saved by the user. For more information, refer to
the Bookmarks Tab topic.

10. The STEPWorkflow tab contains all the workflows currently associated with STEP. For more information,
refer to the STEPWorkflow Tab topic.

11. The collapse bar button ( ) removes the text from the left navigation bar; the expand bar button ( )

adds text to the options.

12. STEP connection status displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

Reading - STEP is requesting information from the database.

Lost Connection to - STEP has lost connection to the server.
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Reconnected to - STEP has reconnected to the server after a lost connection. May alternate with the
'Lost Connection' to status if the connection to the internet is lost for a significant period.

13. Connection strength illustrates the connection strength between the user and the server, also known as
the 'Network Latency.' Hover the cursor over the graph to display how fast data is traveling between the
server and the user as measured in milliseconds.

14. The close button ( ) hides the hierarchy for the selected navigation bar option, which allows more space
for the Object Editor. Select a navigation bar option to display the hierarchy again. For more information,
refer to the Object Editor topic.

15. The Object Editor pushpin default is unpinned ( ) but allows users to pin ( ) the right-hand side of the

window. When pinned, a user can navigate to other items in the Tree or System Setup while the
information on the right side of the screen remains unchanged. This can be used to add objects to the
Flatplanner basket and to add objects to a change package. For more information, refer to the Adding
Objects Manually to Baskets topic in the Publisher (Adobe InDesign Integration) documentation and the
Editing a Change Package topic in the Configuration Management documentation.
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BG Processes Tab
The BG Processes tab shows all active and inactive background processes (BGPs). Activity such as an
import, export, bulk-update, collection creation, etc., generates a background process and a log and informs
users if the process was successful. In the event of an unsuccessful background process, an error message is
displayed showing the reason for failure.

Background processes are based on the type of activity, for example 'Approve recursively,' 'Bulk update,'
'Create Collection,' 'Download Report,' as well as 'Translation,' which is shown in the image below.
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BGP Execution Mechanism
The mechanism implemented for running background processes determines the options and data displayed
in the BG Processes tab. Refer to the Background Processes and Queues topic in the System Setup
documentation.
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Evaluating BG Processes
Select a BGP folder (not an individual BGP) to display all BGPs currently in that state. Select the columns in a
section, right-click and choose Copy (or use Ctrl+C) to copy the data. Only the data visible on the screen is
copied. For further evaluation, in Excel, paste the copied data using Ctrl+V and manually add the header row
information.

BG Processes Displayed
In the BG Process tab, a user can choose to view only the BGPs that they have initiated, or with the
appropriate privileges, they can view all the BGPs run by any user. The display is selected by clicking the
appropriate button highlighted in the image below.
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All Users displays all background processes started by any user. This button is enabled by the 'View

Background Processes of Other Users' setup action as defined in the Setup Actions and Error Descriptions
topic of the System Setup documentation.

My User displays only the background processes started by the user who is logged in.

Background Process Tab
The Background Process tab in the editor contains:

The Properties section includes the user who started the background process, an auto-generated unique
identifier, the type of BGP performed (export, import, bulk update, etc.), status (Succeeded, Failed),
creation date and time, start date and time, end date and time, time taken to process the request, number
of warnings, and number of error messages.

The Execution Report section includes detailed information about the process. If the process failed, a
message displays the reason.

The navigation buttons are:
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navigate back one page.

navigate back to the beginning of the log.

navigate forward one page.

navigate forward to the end of the log.

The Save button allows the user to download the execution report. Click the 'Save' button to display the
'Save File' window. Browse to the download location, add a file name, and click the 'Save' button. The file
can be saved as a CSV or HTML file type. For larger files, CSV files can be zipped.

Note: The 'CSV (Zipped)' option is available in the 'Files of Type' dropdown when there are more than
one million lines (presented as rows) within the execution report. This is a result of MS Excel having a
limitation of one million rows per file; the 'CSV (Zipped)' option allows multiple files to be saved.

Truncate - This button is available only on the 'Ended Processes' node.

When the Execution Report becomes cluttered or only specific information is needed (errors or warnings),
truncating the report permanently removes the unneeded information. Click the 'Truncate' button to display
the 'Truncate execution report' dialog.

Important: Once execution report lines are removed via truncate they cannot be recovered.
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For example, assume the execution report has 50 lines and a user wants to examine only 16 lines from the
report that are errors. With the settings shown in the image above, the user clicks theOK button and the
execution report retains only the first 16 error lines. All other lines are permanently deleted.

Queue Info Tab
The Queue Info tab in the editor only displays when the 'Multiple Queues' legacy BGP execution mechanism
is implemented. Refer to the Background Processes and Queues topic in the System Setup documentation.

The name of the queue being used for the process is displayed within the section title.
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Bookmarks Tab
The Bookmarks tab allows users to set bookmarks for any objects in the Tree and allows users to easily
access these objects without having to search or navigate the Tree.

A bookmark is a Uniform Resource Identifier (URI) that is stored to provide the user with a quick method of
retrieving the data at any time.

Bookmarks are accessed via:

1. The Navigate menu using the Bookmarks option.
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2. Clicking the Bookmarks tab.

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP
from a different computer.

Bookmarks are specific to individual users – just as in a web browser. This means that one user will not be
able to view the bookmarks created by another user.

To learn more about bookmarks and maintaining them, refer to the Bookmarks topic.
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Adding a Bookmark
Standard navigation Bookmarks are used to quickly access specific nodes in the Tree and System Setup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or
System Setup hierarchies can be added with the usage of Bookmarks functionality.

To save an object as a Standard Navigation Bookmark:

1. In Tree, select the item to be bookmarked.

2. On the Navigate menu, select Bookmark > Add Bookmark.
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Note: Notice that the existing bookmarks are displayed on the menu.

3. The new bookmark is displayed on the Bookmarks tab.

Note: The Standard Navigation Bookmark is saved under the Bookmark Tab. The bookmark is
represented with the product icon and automatically labeled with the product name and ID in
parenthesis.

4. Click the new bookmark.
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5. Navigate to the Bookmarks main tab, and go to the Product tab on an object to view the bookmark data.

Bookmarks can also be created using a shortcut. Select the object and press Ctrl+D. The bookmark is
created automatically.
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Removing a Bookmark
After saving a Bookmark, it may no longer be needed eventually. There is a right-click menu option that can
remove a selected bookmark.

Important:  If user deletes a bookmark (Maintain menu > Delete), the object is deleted and is moved to
the Recycle bin.

No confirmation window displays before removing a bookmark.

1. On the Bookmarks tab, right-click the bookmark to be removed and click Remove Bookmark.

2. The selected bookmark is removed.
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Editing a Bookmark
Both Standard Navigation (the link to specific objects) and Search Bookmarks may be edited in the
Bookmarks tab. To edit a bookmark:

1. On the Bookmarks tab, right-click the bookmark to be modified and click 'Edit Bookmark.'

2. If desired, change the name of the Bookmark then clickOK.

3. The name will be updated in the Bookmarks tab.

4. The object URL can be edited only if the Edit URL checkbox is activated. In the below screenshot, the
product URL has been modified which points to a new product URL.
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Similarly, 'Search Bookmark' can be edited by editing the 'Search URL,' if the 'Edit URL' checkbox is
edited.

5. Click theOK button to save any changes to this bookmark.
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Copying a Bookmark to the Clipboard
Bookmarks are direct addresses to a specific object, such as a product, entity, or publication, in STEP. These
bookmarks can be shared to other users by copying the bookmark to the clipboard, and then pasting this
bookmark to a shareable medium.

1. On the Bookmarks tab, right-click the bookmark to be removed and click 'Copy to Clipboard.'

2. Paste the copied URL of the bookmark (using Ctrl + V onWindows).

The copied URL can be pasted in the URL Field of STEPWorkbench, and the user can search the respective
objects.

Note: You may send the copied URL to other STEP users so that they can navigate to the object or to the
search criteria.
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Menu Items
The STEPWorkbench menu bar provides access to many aspects of STEP's functionality. Some of the
options in these menus are also available via a right-click menu accessible elsewhere in STEP. For instance,
users may add a product to a product family by selecting the product family, and then selecting Maintain >
Insert > Product in the menu bar, but they may also perform the same action by right-clicking on the product
family in the Tree. However, some options, like changing the view target, are only available in the menu bar
dropdown menus. Each of the menu bar sections are detailed on subsequent topics.

Note: Many menu options can be used with a keyboard shortcut. For a list of the keyboard shortcuts, refer
to the STEPWorkbench Keyboard Shortcuts topic in the Getting Started documentation.

File—The File menu provides access to import and export actions as well as general STEPWorkbench
tasks, such as running bulk updates, changing passwords, and emptying the Recycle Bin. For more
information, refer to the File Menu topic.
Edit— In addition to administration actions like copying and pasting, the Edit menu also provides access
to tasks like spelling checks, managing assets, and editing unique keys. For more information, refer to the
Edit Menu topic.
View—The View menu contains options that change how data is displayed in the workbench. For more
information, refer to the View Menu topic.
Navigate—The Navigate menu contains searching options and the ability to find similar objects. For
more information, refer to the Navigate Menu topic.
Format—The Format menu allows for setting styles such as bold or italics and inserting character tags.
For more information, refer to the Format Menu topic.
Maintain—The actions available on the Maintain menu pertain to data maintenance at the object level.
Data such as LOVs and attribute values can be merged. Data can also be forcefully deleted, duplicated, or
approved. Links and new objects can be created in this menu. For more information, refer to the Maintain
Menu topic.
Window—TheWindow menu provides actions for changing the presentation of the STEPWorkbench.
For more information, refer to the Window Menu topic
Help—The primary function of this menu is to link users to the online documentation. For more
information, refer to Help Menu topic.
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File Menu
The file menu contains actions that are related to maintaining the workbench from a performance level, such
as cleaning the recycle bin, purging old revisions, scheduling bulk updates, as well as defining imports and
exports.

Each of the options on the File menu are defined below.

Translate

The Translate menu allows users to translate products, classifications, and names of images and documents,
product values, index words, LOVs (List of Values), units, attribute names, free text cells in tables in the
workbench, and to import translations.
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By selecting 'Data Objects' or 'Setup Objects,' the Request Translation wizard will display. This process
results in the creation of a translation file that will include either data objects (objects that contain usable
customer data) or setup objects (objects that help organize the data objects). For more information on data
object translations, refer to the Structured XML Translation topic and the Structured Translation for Setup
Objects topic in the Translations documentation.
The 'Manual Excel Translation Export' is best used for a specific set of use cases, namely when there is
not much content to translate, the translator does not have access to STEP, or the objects to be translated
are setup objects. For more information on performing a manual Excel translation, refer to the Starting a
Manual Excel Translation Export topic in the Translations documentation.
The 'Import Translation' allows users to select an external translation file.
The 'Change Translation' allows users to change configurations.

For more information on the translate functionality, refer to the Translations documentation.

Import

The Import menu contains actions for bringing data into STEP.

The 'Data...' option loads the Import Manager. For more information, refer to the Import Manager topic in
the Data Exchange documentation.
The 'eCl@ss' option launches the ECLASS Classification import wizard. ECLASS is used to group
materials, products, and services. For information on how to best use ECLASS and its importer, refer to
the ECLASS Format topic and the ECLASS Classification Import topic in the Data Exchange
documentation.
The 'Images & Documents...' option, while on a Tree node that contains assets (images and documents),
will load the Import Images and Document wizard. For more information, refer to the Import Images and
Documents Wizard topic in the Digital Assets documentation.
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The Business Rule from Editable Format allows users to manually import business rule definitions in the
editable format described in the VCSI: Editable Business Rules Format topic of the Configuration
Management documentation.

Export

The Export menu contains actions for getting data out of STEP for external management.

The 'Data...' option loads the Export Manager. For more information, refer to the Export Manager topic of
the Data Exchange documentation.
The 'Schedule Data Export...' allows you to create a data export that executes at a specific time or
repeatedly. This option starts the Schedule Data Export wizard. For more information, refer to the
Scheduling a Data Export topic in the Data Exchange documentation.
The 'Images & Documents...' option, while on a Tree node that contains assets (images and documents),
loads the Export Images and Document wizard. For more information, refer to the Export Images and
Documents Wizard topic in the Digital Assets documentation.
The 'Compare System Setup Exports' option enables you to migrate systems and allows users to
determine which items should not be added to the new system. This option will compare two STEP XML
files that are exported from two STEP systems, such as a production system being compared with a
development system.

Reports

Selecting 'Reports' option will load the Reports wizard.
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For more information on the reports wizard, refer to the Reporter documentation.

Bulk Update

Bulk updates allow you to perform one or more actions on multiple objects at the same time.

The 'Run Bulk Update' option will start the Bulk Update wizard.
The 'Schedule Bulk Update' option will allow users to create repeatable bulk updates.

For more information, refer to the Creating a Bulk Update topic and the Scheduling Bulk Updates for
Collections topic in the Bulk Updates documentation.

Schedule Category Profiling

Category profiles (also called data profiles) are used to take a snapshot of data that would be displayed in the
category profile tab. This snapshot does not update as new changes are made. With this action, the 'Schedule
Category Profiling' wizard will display and users may schedule the updates of existing profiles and the ability
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to copy profiles as well. For more information, refer to Generating, Updating, and Scheduling a Data Profile
topic in the Data Profiling documentation.

Business Module Manager

A business module is a functional configuration which handles use cases based on common practices
observed in the industry. The Business Module Manager allows an administrator to install a pre-configured
data model for a business purpose, such as the 'sell side' of the product enrichment process, or the 'buy side'
for the vendor data onboarding process. Business module installation can include the creation of product
objects types, classification objects, lists of values types, etc. The 'Business Module Manager' option displays
on the File menu for all users. The install functionality is available for users who are assigned the 'Install
Business Modules' setup action privilege.

For more information, refer to the Business Module Manager topic in the System Setup documentation.

Save

While saving in STEPWorkbench is automatic, the Save option allows users to force a save without leaving a
field.

Change Password

During any session, any user may change their own password. Enter your current password in the 'Old
Password' field, then enter the new password twice in the 'New Password' and 'Retype Password'
parameters. Click 'Save' to complete the update or 'Cancel' to leave the password unchanged.
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Empty Recycle Bin

This action purges the 'Not In Use' objects in the Tree Recycle Bin. For more information, refer to the 'In Use
and Not In Use Objects' section in the Approval of Objects topic.

Select the 'Empty Recycle Bin' option to display the Confirm Purge dialog. The number of items that will be
removed is displayed. Click 'Purge' to permanently delete the items, or 'Cancel' to leave the Recycle Bin
unchanged.

This action is also available via by right-clicking on the recycle bin.

Empty Recycle Bin Before

This action allows users to purge the recycle bin of anything created before a specified date.
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This action is also available via right-clicking on the recycle bin.

Purge Old Revisions

This is a global purge of revisions contained within a specified workspace. A further description of this
functionality is available in the Revisions section of the System Setup documentation.

Check integrity of external assets...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself.
This can reduce the size of the database significantly, and for DTP tools depending on having the referenced
high-resolution images directly available on the file system, replication from DB to file system of these images
can be avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File
Structure topic of the Digital Assets documentation.

The 'Check integrity of external assets...' option is enabled on systems set up to store images in a file system
and not in the STEP database. If a Classification is selected, the user can click this menu item to examine if all
images in the selected classification have been successfully migrated from the database to the file system.

The integrity of the file system for storing digital assets can be double-checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu. This starts a background
process reporting if any assets are missing or have been changed against expectations.

When errors are found, the assets with wrong or missing content are added to a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A check of approximately 10,000 asset files on standard hardware can complete after one minute. Thus,
expect that the integrity check might take some time on systems with many assets.
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Pre-generate Thumbnail Cache...

This option will generate thumbnail cache of images and documents manually. This action allows any
selected image or images in a classification folder to display as thumbnails without having to wait for them to
generate.

For example, on the Image and Documents tab of a classification folder, if the image thumbnails are delayed
in displaying, then Pre-generate Thumbnail Cache from File menu can be run to generate them in a
background process.

For more information, refer to the Image Cache Processing Plugin Parameters and Triggers topic in the
System Setup documentation.

This option is disabled by default. To enable it, ask an authorized user (one with the Setup Action = Maintain
System) to perform the following steps.

Note: Although this automates the loading process, there will be delays during upload.

1. Under 'System Setup' tab, navigate to 'Users & Groups.'
2. Select 'System Settings' tab.
3. Go to 'Image & Document Settings' flipper.
4. Set 'Pre-generate thumbnail cache on upload' = Yes. On upload of image or document, the thumbnail will

be generated automatically.
For more information, refer to the 'Pre-generate Thumbnail cache on upload' section of the Image and
Document Settings topic in the System Setup documentation.

Close Window

This option closes the active workbench window.

Exit STEPworkbench

This will exit the STEPWorkbench completely by closing all active windows.
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Edit Menu
The Edit menu allows for typical text editing actions, asset editing actions, unique key editing, and spell check.

Undo

This action reverses the last action of the user.

Note: It does NOT restore character-by-character changes in text editors.

Redo

Once an action is undone by selecting 'Undo', a user can then select 'Redo' to repeat the action.

Cut

Standard 'cut' operation to remove the selected characters.

Copy

Standard 'copy' operation to duplicate the selected characters.

Note: If a folder is copied, the subfolders will NOT be copied.
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Paste

Standard 'paste' operation to insert the copied characters at the selected point.

Paste and Match Style

Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. For
more information, refer to the Style tag section of the Tags topic of the System Setup documentation.

Paste Link

Allows the copied object to be linked into another object (e.g., linking an attribute into a second attribute
group). Creates a new instance of the same object (not a copy), just in a different location.

For example, if a user has an image for a product line that will live under multiple parents, the Paste Link
action can be used. The user selects the asset, and then selects another location that will serve as a parent
object. The paste link option can be used to create a link, giving this object two parents. This action will not
work on products as products can only have one parent.

Some considerations with this action are:

an attribute must exist in at least one attribute group,
if the data must be shown in the Web UI, then an attribute for display purposes should be created

Note: The Paste option is available based on the selected node. For example, when selecting a product
node and placing it into a classification folder, only the 'Paste Link' option is available. However, if a
product is to be moved to another product family, when selecting the target family after cutting the original
product, 'Paste Link' is disabled.

Select All

Standard 'select all' operation to mark all visible objects for another action, like copying or deleting.

Spelling

Allows a user to check the spelling of available text.

When the 'Automatic Spell Check' option is selected, as users type, incorrectly spelled words are displayed in
red text.
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If the 'Automatic Spell Check' is disabled, then selecting the 'Spell Check' action while in a field checks that
field's spelling. If a user selects one of the incorrectly spelled words and navigates back to the Spelling menu,
STEP will offer possible spelling corrections.

Asset

When an asset is selected in Tree, the 'Asset' menu shows various options to manage and change assets.

Note: If no object is selected or a non-asset node is selected, all of the 'Asset' menu options are disabled.

The 'Edit Asset' action will open the asset in the program that is associated with the selected file type, like
Adobe Acrobat for PDFs.
The 'External Viewer' will open the asset in a program on the user's local computer.
The 'Replace Asset Content' action will allow users to replace the asset with local assets.
The 'Create Local Content of Asset' option initiates an asset push and downloads the asset.
The 'Update System Properties' action refreshes the asset's system properties in the 'Images &
Documents' tab of the asset.
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After selecting the 'Create Local Content of Asset' action, the 'Delete Local Content of Asset' option is
enabled and allows a user to delete that downloaded asset.

Edit Unique Key Values

Unique Keys provide a special way of designating objects for identification outside of STEP. Selecting the
'Edit Unique Key Values' action on an object with active unique keys will display the 'Edit Unique Key Values'
dialog, allowing users to edit any unique key related attributes on the object.

If there are no active unique keys for the selected object, then the following message displays.

For more information, refer to the Unique Keys topic of the System Setup documentation.

Remove / Insert / Add Options

At the bottom of the Edit menu are two options that will change based on the selected node or current view.
The following are a sampling of what may appear:

On attribute references

On the sub-products tab of a Product object
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On Lookup tables

The options will allow users to add or remove to the selected node as desired.
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View Menu
The View Menu's purpose is to change the way a user views objects in the STEP system. In this menu, users
may change the viewable workspace, context, and mode, add a filter, change the primary hierarchy, and other
options to customize the view to their needs.

Note: This menu does not edit or change any of the values. For more information to edit these values,
refer to the Maintain Menu topic.

Mode

The 'Mode' sub-menu includes options that allows the user to view STEP data in a variety of ways, dependent
on the need. These options are mirrored on the toolbar. For more information, refer to the Toolbar topic.
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Normalmode is the view where the majority of object maintenance occurs. From the toolbar, it is

represented with the icon.
Translationmode shows the split view of the different contexts for objects. To use the Translation mode,

select a Source context from the View menu. From the toolbar, it is the icon. Online Translation can be
done from this Translation Tab. Fields highlighted in green color can be translated within STEP from this
Translation Mode. For more information on translating data into other languages, refer to the Translations
documentation.
Workspacemode shows a comparison of values between Main and Approved workspaces using the
'Approve Workspace' toggle. For more information on workspaces, refer to the Workspaces topic in the
System Setup documentation.

Context mode shows a comparison of values between different contexts. From the toolbar, it is the
icon. For example, this will allow a user to view values for all languages or for all price versions. For more
information on contexts, refer to the Contexts topic in the System Setup documentation.

Revision shows a comparison of values between different revisions. From the toolbar, it is the icon. If
you have selected any object in STEP, then switched to the revision view, it will show a comparison screen
of the two latest revisions. The latest revision is displayed in the first column and the older revision is
displayed next. These revisions are also listed under the Status tab in a product editor. For more
information on managing revisions, refer to the Revisions topic in the System Setup documentation.
Update shows a comparison between objects across workspaces (Main and Approved) and allows the
user to update the object in the current workspace from a source workspace.

Context

When an object is selected, 'Context' displays all available contexts in a dropdown. By selecting one of these
contexts, the viewed context for the current object and all other objects, is changed to the selected context.

Workspace

© Stibo Systems - Internal - 2024.4 - December 2024 75



Workspace shows all available workspaces. It is possible to change the viewed workspace and view objects
as they appear in different workspaces. In this example, there are only two workspaces: Main and Approved.
However, more can be added as desired. For more information on setting up and using workspaces, refer to
the Workspaces topic in the System Setup documentation.

In the toolbar next to the context selector, the toggle allows you to switch between the Main (
) and Approved ( ) workspaces.

Target / Source

The 'Target' and 'Source' sub-menu allows users to choose alternative dimensions to show in the Context
mode.

Depending on the view chosen, this function label changes from target to source.

In the Translation view, this allows the user to select the source language.

In the Workspace view mode, this allows the user to select the target workspace.

In the Context view mode, this allows the user to select a single target as context or multiple contexts to
compare the content.
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In the Revision view mode, this allows the user to select a past revision(s), provided there is a recorded
change in STEP. If the revisions are older than the current session, the 'Other' option will display a
window to select necessary revision for comparison. When the Revision view is selected, the selected
object will show the current version and the immediately previous version. By using target, users may
select specific revisions for comparison.

In the Update view mode, this allows the user to select the source workspace.

Filter

Select a view to filter out empty attribute values, show only mandatory attributes, show only editable
attributes, and/or show only legal attributes.

Primary Hierarchy

An object may be located in multiple hierarchies. When locating objects, there may be a reason that a user
wants the object's path to specify one of those hierarchies instead of all the applicable hierarchies. Changing
this view can be done by switching the primary hierarchy view used for workbench. This path is displayed in
the object details within workbench, but the path is also used when navigating to an object via a search results
set.
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For example, object 12345 is in a supplier hierarchy and a primary product hierarchy. When doing a search for
object 12345, upon clicking the 12345 link in the search results, User A wants the object to be displayed in the
Tree within the primary product hierarchy. User B wants to click on the 12345 link and be taken to the object
within the suppliers hierarchy. Both scenarios can be accommodated when each user sets their own view.

An objects' path can be changed based on the selected primary hierarchy. To change the display view, select
Primary Hierarchy from the View menu, and then select the desired hierarchy. For many, the Primary Product
Hierarchy will be the default selection.

In the below example, Object 0726222 is a product object type being viewed in the Primary Product
Hierarchy. This path echos the location of the object in the Tree tab.

Examples of how objects will be displayed can be demonstrated with the Merchandising Hierarchy selection.
Notice the changed path and the object's location in the Tree tab.
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Select Version

Allows the user to set the default publication or version used for proofing.

New View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be
used. Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing
Objects in the Tree Tab topic. A view allows a user to customize the attributes shown for more than one
object, instead of displaying all attributes for all selected objects.

Remove View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be
used. Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing
Objects in the Tree Tab topic. A view that is no longer needed can be remove with this menu option.

Product Views

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be
used. Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing
Objects in the Tree Tab topic. The Product Views option displays all saved views.

Show Source Context

Attribute names may be translated. This option allows a user to view attribute values in both a foreign
language and in the source language.

Rotate Table

This will flip the selected table so that the columns become rows and vice versa. This is most often used in a
multi-product editor.
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Reload

Retrieves updated information from the database including other users’ changes.

Collapse Tree

Collapses the folders in the Tree navigator.

Disable calculated values

Disables the automatic calculation of calculated attributes. This will make the STEP interface load faster.

If Disable calculated attributes is checked, calculated attributes can be rendered one-by-one by clicking the
Calculate button on a calculated parameter in the product editor.

Default Font Size

Allows the user to change GUI font.

Choose User Display Sequence Attribute

Allows the user to select a user-specific Display Sequence Attribute. This option is different from the Attribute
set under Users & Groups in System Setup. For more information on using Display Sequence Attributes, refer
to Display Sequence Attribute topic in the System Setup documentation.

Toggle Show Hidden Background Process Template

Once selected, any previously hidden Background Process Template will display.
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Default Context

Sets the default context used when logging in.

Logs

Displays Workspace and System Setup logs.
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Navigate Menu
The Navigate menu offers options for moving around the workbench.

Search

The 'Search' action accesses the 'Search' tab, which displays along the left side of the workbench window.
Using the search functionality, users may perform a search of all of STEP objects. For more information on
searching within STEP, refer to the Navigating and Searching topic in this guide.

Search Below

Only after selecting an object will the 'Search Below' action become selectable. Once this option is selected,
the 'Search' tab will perform populate with a 'Search Below' for that object. Click the Search button to perform
this query.

Search

A quick way to display a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displays multiple results and allows the user to select the desired object.
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Go To Next Object

When there are multiple Search results (or typeahead results) from the 'Search' function, the user can opt to
click 'Go To Next Object' to continue on to the next result.

When multiple items meet the criteria for a Search action, the 'Go To Next Object' action will cycle to the next
object in that list, which is ordered by STEP IDs.

Go To Next Object is disabled if the previous Search command has not been used.

Back / Forward

The 'Back' and 'Forward' actions function the same as most web browsers. 'Back' allows users to go to a
previously visited screen, and 'Forward' returns to the screen from which a user went back.

Bookmarks

The Bookmarks sub-menu allows a user to bookmark the currently displayed object or create and name a
search based on the selected object.

© Stibo Systems - Internal - 2024.4 - December 2024 83



Find Similar Product

The Find Similar Product option populates a search based on the attributes and its values of the selected
product. When this option is selected, a window will appear prompting the user to check off common attributes
to search for.

Important: Attribute values from calculated attributes and inherited attribute values are not searched

Note: The selection dialog shows only the attributes which have values (inherited from context, inherited
from hierarchy, local values, and calculated values).

When the attributes are selected, click the 'Select' button, and the Advanced Search Tab is displayed with the
object type and the selected attributes with their values. After clicking the 'Search' button, the selected product
(s) which match the search criteria are displayed.
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Note: This search is recommended for externally maintained attributes with validation base types of Text,
LOV, and Numeric. It is not recommended for attributes with validation base types like Number, URL,
Date, Condition, Multivalued Text, or Multivalued LOV, etc.
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Format Menu
The Format menu contains items for stylizing and transforming text in the workbench.

Style

This option allows setting either bold or italics. Users may create their own styles, which will show in this
menu.

Users can apply style formatting to selected strings of text such as bold, italics, or custom style tags. The
secondary 'Style' menu contains a list of additional styles. Selecting any will change the selected text. To add
more styles to the list of options, refer to the Tags topic in the System Setup documentation.

Selecting 'Other' from the extended Style menu displays a bank of all the custom styles in the STEP system.
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Note: Formatting is limited to free text fields.

In this example, bullets are applied to the Long Description field. The word 'flash' is bold.

Clear All Styles

This action clears all applied styles on the selected text.

Character Tag

The 'Character Tag' action allows for the insertion of custom-made character tags.

© Stibo Systems - Internal - 2024.4 - December 2024 87



To learn more about editing character tags, refer to the Tags topic in the System Setup documentation. In the
example below, a phone character tag is used, followed by a line break, and then a multi-item separator.

Selecting 'Other' from the character tag menu displays a bank of all the character tags in the STEP system.
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Insert Special Character

This is an embedded character map. It shows the most recently used characters and offers a complete
Unicode character range.

Selecting the 'Insert Special Character' option displays a pop-up of the most recently used symbols.

Selecting the 'Other...' option on this pop-up will generate another dialog that allows for selecting all of the
special characters, as well as changing the character set to choose from.
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Maintain Menu
Maintain menu provides the user to maintain STEP data by inserting, linking, merging, deleting, approving
and others. Some options, such as Customer MDM Monitoring and User Anonymizer, are only available if the
functionality is activated via a license and/or add-on component. Many options have additional actions and
are explained below.

Insert

The 'Insert' action allows the user to create an object based on the currently selected object. The options are
disabled based on the selection.

Note: Right-click an appropriate Tree hierarchy node to create products, classifications, entities,
publications, and assets. For more information on object creation, refer to the Creating Objects in the Tree
Tab topic.
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The following options are available in the Insert sub-menu:

Product – If the user is within the primary product hierarchy, this option creates a new product beneath the
selected hierarchy.
Classification – If the user selected a classification hierarchy, this option allows creation of a new
classification folder beneath the selected classification with the predefined classification object types.
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Classification Root – If the user would like to have a classification root to store images or configurations
or to link products in the classifications folder, this option creates a classification root with a set of
predefined classification root object types that are listed.
New Entity Node – If the user selected an entity root, this option creates a new entity object based on one
of the predefined entity types.
Entity Root – A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root
object types.
New Publication... – Allows the user to create a new publication. If the user has already selected a
publication hierarchy, this option displays the 'Create Publication' dialog with the default object type
selected. The user must provide a name of the publication and 'Page Template,' 'Product Template,' and
'Publication Template' to create a new publication.

Note: The 'Create' button in the ‘Create Publication’ dialog is enabled only if the user has selected a
publication template.

New Publication Group – Allows the user to create a new publication group within the selected
publication group. If a publication group is selected, this option displays the ‘Create Publication Group’
dialog with the predefined set of object type.
New Publication Section... – Allows the user to create a 'New Publication Section' from the 'New Section'
dialog. Complete the Section Name and select the Page Template from the dropdown list.
New Page Template... – Allows the user to create a new page template. After selecting a 'Publication
Group,' this option displays the 'Create New Page Template in STEP' wizard.
Orphan Attribute – This allows the user to add an attribute as an orphan attribute to a product by
searching or browsing from System Setup tab. For information, refer to the Linking Orphan Attributes topic
in the System Setup documentation.
Asset – Allows the user to create placeholder with ID and name for a new asset on the selected
classification folder. The user may choose an asset object type from the Create Asset dialog, then asset
content can be added.
Attribute – Allows the user to create a new attribute in the selected attribute group in System Setup.
Attribute Group – Allows the user to create a new attribute group in System Setup.
List of Values – Allows a user to create new list of values under Lists of Values Group / LOVs in System
Setup. The user can add ID and Name in the 'Create LOV' dialog.
Dimension – This option creates a new dimension when a user selects the 'Contexts' node in the System
Setup. For more information on dimensions, refer to the Dimensions and Dimension Points topic in the
System Setup documentation.
Dimension Point – Allows the user to create new dimension point. A user must select a dimension under
System Setup > Contexts > Dimension (for example 'Language'). The label of this option changes
dynamically based on the selection of dimension, so the option ‘Dimension Point’ is never displayed. For
example, if the user has chosen 'Language' as Dimension, this option is labeled 'New Language'.
Action Set – This option creates a new setup or user action. A 'Create Action Set' dialog displays with ID
and Name to be filled when user selects the option Action Set. Creating a setup or user action is based on
which node is selected in System Setup. For more information on action sets, refer to the Maintaining
Action Sets topic in the System Setup documentation.
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New Image Conversion Configuration… – A wizard displays to create new image conversion
configuration and save it for reuse in the selected classification folder. For more information on image
conversions, refer to the Image Conversion Configuration topic in the Digital Assets documentation.
Create Transformation Lookup Table – Allows the user to create a transformation lookup table under
the selected classification. For more information, refer to the Transformation Lookup Tables topic in the
Resource Materials online help documentation.
New Event Queue – The user can create a new event queue in System Setup. For more information, refer
to the Creating a New Event Queue topic in the System Setup documentation.
New Asset Push Event Queue – The user can create a new asset push event queue in System Setup
and it creates a new event queue. The event queue can have any number of asset push configurations
running from it. For more on assets push events, refer to the Creating and Maintaining Asset Push Event
Queues topic in the Digital Assets documentation.
New Asset Push Configurations – A new asset push configuration is created under the selected Asset
Push Event Queue. For more on assets push configurations, refer to the Creating and Maintaining Asset
Push Configurations topic in the Digital Assets documentation.
STEP Workflow –When the user first selects 'Workflows' in 'System Setup', this creates a new workflow
under System Setup >Workflows. The STEPWorkflow designer window displays. The user can also
create a workflow by right-clicking on the 'Workflows' folder. For more information on workflows, refer to
the Workflows documentation.
Background Process to Monitor Deadlines –When first selecting the System Setup >Workflows node,
this option starts a background process for checking STEPWorkflow items that have exceeded their
deadlines. Refer to the Deadlines and Escalations in Workflows topic in the Workflows documentation.
User – Users are created by first selecting System Setup > Users & Groups > Group where the user
belongs. When a user selects a Group and selects this option, the 'Enter New User' dialog displays. For
more information on users in STEP, refer to the Working with Users topic in the System Setup
documentation.
Group – Groups are created by first selecting System Setup > Users & Groups > and selecting the
necessary node to hold the group. For more information on groups in STEP, refer to the Working with User
Groups topic in the System Setup documentation.
New Supplier – Supplier users are created in System Setup > Supplier Group. A new supplier can be
created by first selecting the supplier group.
Create Package – Creates a package by first selecting System Setup > Change Package. After the user
has selected the change package option, a 'Create Change Package' dialog displays. Enter an ID and
Name of the Package. For more information on packages, refer to the Change Packages topic in the
Configuration Management documentation.
New Business Condition – Creates a new business condition under Global Business Rules in System
Setup. Business Conditions can also be created under Workflows in System Setup. For more information
on business conditions, refer to the Business Conditions in the Business Rules documentation.
New Business Action – Creates a new business action in System Setup under Global Business Rules.
Business action can also be created under Workflows in System Setup. For more information on business
actions, refer to the Business Actions in the Business Rules documentation
New Business Library – Creates a new business library in System Setup under Global Business Rules.
Business libraries can also be created under Workflows in System Setup. For more information on
business libraries, refer to the Business Libraries in the Business Rules documentation
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Setup Group Root... – Creates a new setup group root under System Setup. When the user selects this
option, the 'Create Setup Group Root' dialog displays with a set of object types. The user may create a
new setup group root based on the object the object type selected.

Link

The 'Link' action provides a list of object or reference types for linkable actions. This menu only shows the
relevant options as active if it is available for the selected object.

Based on the source object there are different link options available with keyboard shortcuts shown in the
above screenshot.

When a user selects a product hierarchy and clicks on Link > Product, the product is linked to the selected
product via a product reference type dropdown.
When a user selects a product hierarchy and clicks on Link > Asset, the asset is linked to the selected
product via an asset reference type dropdown.
When a user selects an attribute, it can be linked to classifications.
When a user selects a classification, it can be linked to products.
When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, refer to the Creating a Product Attribute Link topic
in the System Setup documentation.

Merge

Depending on the selected object, the user can merge attributes, LOVs, and LOV values. For more
information, refer to the Merging Attribute Values topic, the Merging Values in an LOV topic, or the Merging
LOV Values in Bulk topic in the System Setup documentation.
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Delete

The 'Delete' action sends items to the Tree Recycle Bin. If the selected item for deletion contains child objects,
the user receives a warning that these items will also be deleted. For more information, refer to the Recycle
Bin for the Tree Tab topic.

Note: The keyboard 'Delete' button does not delete objects in STEPWorkbench.

Force Delete and Purge

Selecting an object in the workbench and clicking 'Force Delete and Purge' displays the 'Confirm Force Delete
and Purge' dialog. Click the 'Force Delete and Purge' button to permanently delete the object and purge it
from the recycle bin without any further opportunity to cancel or revive the object and without generating an
event.

The Force Delete and Purge option is also available on the right-click menu when selecting the Tree Recycle
Bin, as defined in the Recycle Bin for the Tree Tab topic. This clears unnecessary data already in the recycle
bin quickly, without going through the various 'approve deletion' actions (if required), and errors reported
about existing references or events on queues.

Unlink Object Type

When in System Setup, this option allows a user with the appropriate privileges to unlink the selected object
type from its parent.

Duplicate

This standard 'duplicate' operation essentially copies and pastes in one click. Users may also right-click while
selecting multiple objects and duplicate each of them. A prompt for a new ID is displayed when an auto ID is
not set, then automatically provides a different name. The user is also allowed to indicate if duplicate
references should be created.
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Duplicate Recursively

A hierarchy can be duplicated when the user selects the top node in the hierarchy and clicks 'Duplicate
Recursively.' The ID should be editable to duplicate recursively since duplicate IDs for the same object type
are not allowed.

In the below example, the ID is auto generated so the duplicate recursively background process ultimately
returns an error.

Make Revision

Allows a user to force a revision on a product and provide a comment for explanation.

Approval

The approval options allow objects to be moved to the Approved workspace.

Approve Object – Approves an object from the Main workspace to the Approved workspace and
changes the red X ( ) to either a green checkmark ( ) or a yellow one ( ). Refer to the Approval of
Objects topic for more information.
Partial Approval – Approve selected parts of the unapproved changes on the selected object.
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Check Approve – The 'Check Approve' action allows the user to refer to if anything is barring
successful approval of an object. In the example below, mandatory values are missing.

Approve Deletion – For an approved object to be removed from the Recycle Bin, the object must be
Approve Deleted. If a previously approved object is deleted, in the Recycle Bin it displays a red '(in Use)'
header:

Performing an Approve Deletion changes the header to 'Not in Use' and allows the object to be deleted.

For more information, refer to the In Use and Not In Use Objects section in the Approval of Objects
topic.

Approve Recursively – Launches a workflow process that approves the currently selected object and
all of its children.

Enable Group for Workflows

This is a disabled legacy option.

Revive

Revives a deleted object, either 'In Use' or 'Not In Use', from the Recycle Bin. For more information, refer to
the In Use and Not In Use Objects section in the Approval of Objects topic.

Revive Recursively

Revives a deleted object as well as all of its children, both 'in use' and 'not in use', from the Recycle Bin. For
more information, refer to the In Use and Not In Use Objects section in the Approval of Objects topic.
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Truncate Log

Once selecting an Event Queue or Asset Push Queue, this option reduces the log to the most recent entries.
For more information, refer to the Event Queues topic in the System Setup documentation.

Customer MDM Monitoring

Selecting the 'Start background process for monitoring Customer Data Policies' option under Customer MDM
Monitoring manually initiates any of the active data policies in the system. For more information, refer to the
Data Policies topic in the Data Governance documentation.

User Anonymizer

This option is available to admin users and is used to anonymize a deleted user within the object change logs,
revision logs, and workflow status logs. For more information, refer to the User Anonymizer topic in the
System Setup documentation.
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Window Menu
TheWindow menu offers actions around the STEPWorkbench window.

New PIM Window

This action will create a new instance of the STEPWorkbench.

Goto Window

This is a legacy option and no longer functions.

Goto Dashboard

This option will display the STEPWorkbench dashboard.
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Zoom Window

This action will center the STEPWorkbench on your primary display.
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Help Menu
The Help Menu has two options: 'Help' and 'About STEP'.

Help

The 'Help' option opens the STEP documentation in your default web browser.

If configured to authenticate, you will be prompted to enter a STEP username and password before online
help is displayed. To enable this functionality, the property
OnlineHelp.Documentation.Authentication.Enabled=truemust be added it to the
sharedconfig.properties file. Authentication is disabled by default.

Note: The authentication option will not work with any Single Sign On (SSO) solutions other than LDAP.
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When you are done with online help, you should click the Logout button located on the far right of the online
help toolbar. Upon logging out, you will be taken back to the documentation login screen.

If authentication is disabled, the Logout button will still display. In this scenario, clicking on the button will take
you to the STEP Online Help welcome page.

About STEP

The 'About STEP' option displays the workbench introductory window.
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Object Editor
When an object is selected from the left panel in STEP (e.g., Tree tab, System Setup tab, etc.), the right panel
displays details on the first tab for the selected object. The left panel can be hidden by clicking the 'X' button.

The kind and number of tabs will vary depending on the selected object. However, all objects will have at least
an ID, Name, Object Type, Revision, Approved, Translation, and Path. These fields are called 'aspects.'

Refer to the Object Maintenance in the Tree Tab topic and child topics for additional information on the
various object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the
documentation (e.g., information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with aspects in the
first flipper called 'Description.' For more information about description attributes, refer to the Description
Attributes topic in the System Setup documentation.
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Advanced Search Tab
The Advanced Search tab allows users to perform simple searches by typing directly into the default search
field. For more on searching, refer to the Advanced Search topic.

Users can also perform more complex searches by selecting and/or combining additional search criteria. For
more information about search criteria, refer to Search Operations on Entire Result topic.
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The 'Save as Collection', 'Export', and 'Bulk Update' operations can be performed on the entire search result.
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STEP Workflow Tab
STEPWorkflow is STEP's native functionality for structuring and to some extent automating processes
around objects in STEP. Typical examples are product onboarding processes and change / governance
processes.

The concept of STEPWorkflows differs from the general concept of a workflow, in that STEPWorkflows are
data-centric, meaning that each instance of a given workflow will always be tied to an object in STEP. As
illustrated below, technically, a workflow instance is a relation between a STEP object and a workflow
definition, which also exists as an object in STEP.

For information on how to configure workflows, refer to the Creating a Workflow topic in the Workflows
documentation.

The STEPWorkflow tab has the Tasks and Profile sub tabs.

Tasks
The Tasks sub tab is the primary interface for working with workflows in STEPWorkbench.

Note: As indicated by the information icon ( ), the list of actual tasks can be filtered by privileges.

© Stibo Systems - Internal - 2024.4 - December 2024 107



1. Open a workflow section to display details.

Workflow states are displayed for each workflow as configured by an administrator. The number of tasks
for each state is displayed.

2. Click the Refresh button to update the number of tasks in the workflow states.
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3. Click the Show All Items button to display all tasks in all displayed states, regardless of the assignee.
Only users with the STEPWorkflow Administrator privilege have access to this button.

4. Click the Show All Items assigned to me or any group I am a member of button to display tasks
directly assigned to the current user or to any group that the user is a member of.
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5. Click the Show All Items assigned to me button to display only tasks that are directly assigned to the
current user.

6. Click the filter button to select a collection and filter the list of displayed tasks.

For example, to view objects in the workflow where the 'Color Attribute = Blue', perform an 'Object Type =
Attribute' search on the Advanced Search tab, then save the result as a collection. Select that collection to
filter the objects and display only those where the color is 'Blue'.
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Profile

To work with a profile: 

1. Click a Profile link to display details of the configuration.

2. Click the Edit Configuration button to modify the data being profiled.

3. Click the Update on-demand data button to run the profile and update the data displayed.

4. Click the Copy to Clipboard button to save the displayed data to your computer's clipboard

5. Once saved to the clipboard, the profile data can be pasted into Excel for further analysis.
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System Setup Tab
Schema objects are maintained from the System Setup tab. Examples of such objects are Attributes, Action
Sets, Contexts, LOVs, Object Types, Tags, Units, Users & Groups, Workspaces, Reference Types, and many
more. Most actions performed require Super User access. This is where the core components like integration
endpoints, STEPWorkflow, Web UI, and business rules are created and configured.
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Additional information on the System Setup objects and functions can be found throughout the online help.
For example, information on workflows is available in the Workflows documentation, while information on
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integration endpoints is available within the Data Exchange documentation. Information for general functions
that are not covered in independent guides (e.g., attributes, references, users and groups) can be found in the
System Setup documentation.
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Toolbar
The features accessible on the toolbar, (located beneath the menu bar), are geared towards navigating
between objects and viewing object data in different ways.

The features available on the toolbar are described below.

Stibo Systems Logo

Clicking the Stibo Systems logo toggles between the STEP dashboard and the STEPWorkbench. For more
information regarding the dashboard, refer to the Global Dashboard topic of the Data Profiling documentation.

Context

'Context' is a filter that allows a user to view object data defined by, for example, country or language.

To select the context, click the dropdown and then choose the desired context. It is useful to check that the
context is properly set because viewing data in the wrong context is likely to cause significant confusion. For
more information regarding contexts, refer to the Contexts topic in the System Setup documentation.

Approved Workspace
The ApprovedWorkspace button toggles the user's view of a given object:

indicates you are working in the 'Main' workspace where object values can be edited.

indicates you are in the 'Approved' workspace where you cannot edit values, but you
can examine values that have been approved.

For more information on workspaces, refer to the Workspaces topic in the System Setup documentation.
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View Mode

View Mode enables the user to view data in a variety of ways, dependent on the need. Click a 'View' option to
present data in different ways, as described below:

Normal - The default view of the STEPWorkbench. With this view selected, users can examine a listing of
all relevant attribute and metadata associated with that object.

Translation - Users can view all object-related data in up to two languages. The data is presented in a
comparison display format. Attributes that require translation are automatically highlighted in green. More
information of translations is available in the Translations documentation.

Workspace - Users can refer to object data as it appears in both the 'Main' and 'Approved' workspaces.
This comparison view can be useful to allow a user to view which values have changed since the object
was last approved. However, if the object is in 'Never been approved' status, only the 'Main' workspace
displays when this view is active. For more information on workspaces, refer to the Workspaces topic in
the System Setup documentation.

Revision - Users can view the current state of an object's data as well as all previous revisions in a
comparison display format. By default, current and previous versions are displayed. The number of
revisions viewable at the same time is configurable. For more information on revisions, refer to the
Revisions topic in the System Setup documentation.

Context - Users can view all of an object's data for two or more available contexts in a comparison display
format. The number of contexts viewable at the same time is configurable. For more information regarding
contexts refer to the Contexts topic in the System Setup documentation.

Update - Users can view and compare the values of an object's attributes in both the Approved and Main
workspaces. The 'Compare and Update' tab clearly displays differences between the workspaces.

Navigation

To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, click
the 'Back', 'Forward', or 'Reload' buttons, respectively. When clicked, these buttons behave in a way similar to
most web browsers' 'Back', 'Forward', and 'Reload' functions.
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URL

To maximize navigability of the STEP tool, all objects may be accessed via an in-tool URL. As with the URL
field in a standard web browser, a product can be displayed within STEP by pasting its unique URL into the
URL field. Sharing an item's URL is effective for directing another STEP user to a specific object. The STEP
URL always begins with 'step://'; where web URLs begin with 'http://' or 'https://.'

Search

This field allows searching for specific objects in the hierarchy by typing their ID, name, or key into the 'Search'
field. When the desired item appears in this field, click on it to display the object. For more information
regarding the Search field, refer to the Search topic in the Getting Started documentation. For more
information on keys, refer to the Unique Keys topic in the System Setup documentation.
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Tree Tab
This section contains information about how to create and remove local overrides and information about table
dimension points.

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.

Object Description

Products It is used to store actual product information. Alternative name is 'Blue folder'

Classifications It is used to store assets (Images and documents), configurations, and link products.
Alternative name is 'Yellow folders' or 'Secondary classification.'

Index Words An Index structure needs to be created in STEP, in the same way as a ‘Classification
Hierarchy,’ and products are linked into this structure.

Entities It is used to store the party, supplier data, or contact information. Alternative name is
'White folders.'
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Object Description

Publications It is used to store print (Example: InDesign) documents and print related configuration
like templates, versions, commercial data, and dtp documents. Alternative name is
'Green folders.'

Collections Collections are containers for storing different sets of objects to perform bulk update or
export data.

eCatalogs It is used to create electronic product catalogs. An electronic product catalog is a data
file containing product and price information for a specific product selection. Alternative
name is STEP sync.

Recycle Bin Deleted objects (products, assets, classifications, configurations and entities) are
moved to recycle bin from the Tree tab.

It is used to create electronic product catalogs. An electronic product catalog is a data file containing product
and price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, refer to the Basic STEP Concepts
topic and the Object Maintenance in the Tree Tab topic.
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Object Maintenance in the Tree Tab
Regardless of the particular object type or hierarchy that you are working with, the general principles of
maintaining objects in the workbench are the same, and are described in the All Objects topic. This includes
general information on creating, editing, approving, and deleting objects.

Note: The All Objects information should be read and understood prior to focusing on any of the object
type specific information (links below), as the basic information that is common to all object types is not
repeated in the type-specific sections.

Beyond the general object maintenance topics, additional information on working with specific object types in
Tree, including details about the various editors and functionalities available on them can be found in the
subsequent topics in this guide:

Assets

Classifications

Collections

Entities

Products

Recycle Bin for the Tree Tab

Publications: Information about maintenance of objects in the green publication hierarchy is not covered in
this guide. It is located in the Publication Hierarchy section of the Publisher (Adobe InDesign Integration)
documentation.

Note: All actions are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The
information in this guide focuses strictly on the means for carrying out the various actions, and assumes
that all required privileges are available to do so. More information on privileges is available in the Privilege
Rules topic in the System Setup documentation.

A variety of components are also available for maintaining objects in Web UI. For more information, refer to
the Web User Interfaces documentation. Additionally, objects are often created or maintained within
workflows, or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are
outside the scope of this material, but additional information is available in the relevant guides throughout the
STEP Online Help.
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All Objects
This section covers the basic functionality of creating, editing, and deleting objects in the Tree, as well as
providing an overview of the commonalities between the various object editors. Regardless of the particular
object type or hierarchy that you are working with, the general principles of creating and maintaining objects
are the same.

It is helpful if the Basic STEP Concepts topic has been read and understood prior to reading this material.

A variety of components are available for creating and maintaining objects in Web UI. For more information,
refer to the Web User Interfaces documentation. Additionally, objects are often created or maintained within
workflows, or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are
outside the scope of this material, but additional information is available in the relevant guides throughout
STEP Online Help.

Note: All actions are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values.

The information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege Rules
topic in the System Setup documentation.

Refer to the relevant section(s) below for detailed information on working with objects in the workbench:

Approval of Objects
Creating Objects in the Tree Tab
Deleting Objects in the Tree Tab
Editing Objects in the Tree Tab
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Approval of Objects
This section introduces the user to the concept of approvals in STEP, and provides detailed information on
how to carry out approvals in the STEPWorkbench.

Approval of objects in the Web UI is handled via a Partial Approval action button on a Node Editor screen.
Refer to the Partial Approval in Web UI topic in the Web User Interfaces documentation.

Approval Overview
The data in STEP is logically divided into two workspaces named Main and Approved.

The Main Workspace is the editable 'draft' Workspace where data is initially born and enriched. The Approved
workspace holds approved data deemed ready for production.

In a typical setup, data from the Approved workspace is made available to downstream systems. Data cannot
be edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation
called approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or
other operation.

The approval operation only applies to objects that are workspace revisable. These are:

Product objects
Classification objects
Asset objects
Entity objects configured to be workspace revisable

All other objects in STEP (like attributes, references, etc.) will be identical in the Main and Approved
Workspaces and changes made to these will be reflected automatically in both workspaces. These objects
are known as being 'Globally revisable'.
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Detailed information on how to carry out approvals in STEPWorkbench can be found in the Approving an
Object topic. This guide also contains a detailed description of the approval symbols that are visible in the
different object editors in the Approved Symbols and Messages topic.

Note: All actions are controlled via privileges. Some users may not have access to approve objects, or
may only have options to approve specific object types, hierarchies, or attribute values. The information in
the subsequent topics assumes that all required privileges are available to carry out the described actions.
More information on privileges is available in the Privilege Rules topic in the System Setup documentation.

In Use and Not In Use Objects
When an object is approved in STEP, it cannot be purged from the Tree Recycle Bin. This restriction prevents
approved objects that show on the Approved workspace from being removed erroneously. 'in Use' indicates
that an object is in the Approved workspace, while 'Not In Use' means that the object is only in the Main
workspace. For more information, refer to the Recycle Bin for the Tree Tab topic in this documentation or the
Recycle Bin for System Setup topic in the System Setup documentation.

'In Use' objects cannot be individually deleted nor are they included in the Purge action. The 'Approve
Deletion' action is required for each 'In Use' item.

When an object that is not approved is deleted, the Tree Recycle Bin shows the 'Not In Use' indicator. This
means it will be purged with the 'Empty Recycle Bin' option.
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If an object that is approved is deleted, it continues to display in the Approved workspace until an Approve
Deletion or Approve Deletion Recursively action is performed.

An approved object can be removed from the Approved workspace by manually performing a Force Purge
operation from the BGP screen after a purge operation fails (due to the object being 'in use'), or, from the
Maintain menu. Additionally, you can force purge approved objects which have not yet been approved for
deletion from the Tree Recycle Bin, by running a scheduled Recycle Bin empty operation that has 'Force
Purge' selected within the Schedule Recycle Bin wizard.

The key difference with the System Setup Recycle Bin and the Tree Recycle Bin is that all of the System
Setup objects in the Recycle Bin are flagged with 'Not In Use' since nothing in the System Setup is
constrained by Approval status.

Note:When in the Approved workspace , neither the Tree nor the System Setup recycle bin are displayed.

indicates you are working in the 'Main' workspace where object values can be
edited.
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indicates you are in the 'Approved' workspace where you cannot edit values, but you
can examine values that have been approved.
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Approving an Object
This topic describes how to approve an object in the workbench. When an object is approved, it moves to the
Approved workspace.

Data Ownership
The concept of data ownership is very important in relation to approvals. For an object to be fully approved, all
data that the object owns must also be approved. When data changes, the object that owns that data is
considered 'modified' and can potentially become 'unapproved.'

The figure below shows data owned by a product object (the largest box).

A product owns its parent link (also true for classifications, entities, and assets).

The product owns local values, but not inherited specification attribute values. Thus, when these are
modified at an ancestor level, this will not affect the product’s approval status. Also, the object's local
values (that is, assigned at the product level), will be approved.

The product owns all local references and links for which it is the source. When a reference or link is
modified, it is the source that is changed while the target is unaffected. Attribute values on the reference or
link are also owned by the source object.
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Approving an Object
To approve an object, right-click on the object and select one of the available approval options.
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You can also use the options on the Maintain menu.

© Stibo Systems - Internal - 2024.4 - December 2024 129



Note: If 'approval' is a task within a workflow, then objects can alternately be approved from the task view.
Refer to Working with Tasks in Workflows in the Workflows documentation.

Approve Objects is available when theMain workspace is selected.

Approving objects is available for:

Classifications

Products

Images & Documents

Entities (set up to be workspace revisable)

The status of an object in the various workspaces can be viewed in the Status tab in the Workspaces section
of the relevant editor.
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Once object editing is complete, and the object is ready for publishing, approving the object copies the current
object values into the Approved workspace.

Conditions to approve an object

Objects must be approved from the Main workspace.

An object cannot be approved if parent objects are not yet approved (approving must be done from the top
down in the hierarchy).

A reference or link cannot be approved if the target does not exist in the ApprovedWorkspace, i.e., if a
product or classification is referenced with another product, asset, or classification, then the referenced
product, asset, or classification needs to be approved first before the actual product or classification is
approved.

If attributes, references, links are mandatory, objects cannot be approved if there are no values or targets.

Externally maintained attributes, references or links are not under revision control. Values and references
will automatically be reflected in the ApprovedWorkspace and modifying the data will not affect object’s
approval status.

The user must have sufficient approve privileges.

To easily check differences in the Main and ApprovedWorkspaces, select Partial Approve, as discussed
in the Partially Approving an Object section below.
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When approving, the object's revision number changes automatically.

An entire hierarchy can be approved using the Approve Recursively option. For more information, refer
to the Approve Recursively section below.

Partially Approving an Object
It is possible to approve an object that has a reference or link to another object that does not exist in the
ApprovedWorkspace. In this instance, the object will become 'partially approved,' meaning that the object
and all data that can be approved will be approved. However, the reference or link will not be approved. If the
target for the reference or link is later approved, the source will need to be approved again for the reference or
link to be updated in the ApprovedWorkspace.

Partial approvals can also be performed deliberately - both manually and programmatically. Specific
attributes, references, links, and the object name can be selected for approval. The attributes, references,
links, and names are sometimes referred to as 'part objects.' These part objects cannot exist in the Approved
Workspace without the object to which they belong. Thus, when the first part object is approved, the object will
need to be present in the ApprovedWorkspace.

Usage

Partial approval of selected elements of the object is particularly helpful in situations where certain elements
of the object need to be available for usage (in the ApprovedWorkspace) before the rest of the object or its
elements can be approved.
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For example, consider that there are two users who perform changes for a product and then approve the
product. If the product is completely approved, then it can be difficult to identify which user performed specific
changes. In this case, using the Partial Approve will allow the user to approve only their own changes and
leave the rest of the changes to be approved by the other user who made those changes.

Approving partially

1. In the Tree, select the object to partially approve.

2. Right-click the selected object and click Partial Approve. Alternatively, from the Maintain menu, click
Approval, and click Partial Approve.

3. On the Partial Approve dialog, select the checkboxes for the element(s) to be approved.

4. Click the Approve Selected button.

Note: The attribute groups displayed to a user in the Partial Approve dialog are controlled by privilege
rules. For more information, refer to the Privilege Rules topic in the System Setup documentation.When an
attribute is linked to multiple attribute groups that a user has privileges to, the attribute will display to the
user in all of these attribute groups.

Partial Approve Compare View Dialog

The dialog shows which elements of the selected object have been changed since the last approval of the
object.

Besides name, parent object, and default DTP Template, the type of elements listed are attributes,
references, and tables. For each element the values in Main and ApprovedWorkspaces are listed.
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For detailed information about the value for an element, click the Details…link to display a detailed view of the
element showing the values for the Main and ApprovedWorkspace:

In the above example, the value for the attribute has changed. Values only present in Main Workspace are
marked with a green background color. Values only present in Approve Workspace are marked with a red
background color.

Note: The detailed view differs slightly depending on the element type selected.

All elements are selected by default. To deselect all elements, click the checkbox next to the All Elements
node.

You can select the element(s) to approve by clicking the check boxes next to each element. You can also
select a whole element group, i.e., attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click
the - sign next to the element group. To expand all elements in the dialog, click the Expand All button. To
collapse all elements in the dialog, click the Collapse All button. To check if the selected elements can be
successfully approved, click the Check button to display an approve report that summarizes the results.

Clicking the Approve Selected button will approve the selected elements of the object and the Approve
status of the object will change accordingly. Privilege rules apply to Partial Approve as discussed in the Action
Sets topic.

This functionality is also available in the Web UI. For more information on this feature, refer to the Partial
Approval in Web UI topic in the Web User Interfaces documentation.

Suppress Re-translation

Typically, approval of a translated product in a source language causes the Translation status of the product
to be set to 'Re-translation needed'. In the Partial Approval dialog, this behavior can be suppressed by clicking
the Suppress Re-translation checkbox. All existing translation relations with status 'Up to Date' will retain
that status. This is useful when only minor changes are approved and no re-translation is needed. For more
information, refer to the Translations documentation.
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Note: To get a list of language variations of the object that potentially will be affected by the approval,
hover the cursor on the 'Suppress Re-translation' label.

Check Approve
Consider a product that has multiple attributes linked and has mandatory values and references which needs
to be approved after the changes. The 'Check Approve' option easily confirms if the product can be approved
completely with a detailed report.

To determine if you are allowed to completely approve an object, run 'Check Approve' as follows:

1. In the Tree, click the object to be approved. The editor shows the object contents in Main and Approved
Workspaces.

2. Right-click on the object and select the Check Approve option. Alternatively, on the Maintain menu, click
Approval, and click Check Approve.

If you only have changed attribute values for which you have the Approve privileges, the 'Complete
Approval Possible' dialog box displays.

If the product cannot be approved (for example, due to mandatory values or references being empty),
the dialog provides details, as shown below:

Note: If you changed attribute values for which you do not have the Approve privileges the approval
options are unavailable.
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Approve Recursively
Approving objects recursively searches for unapproved objects linked to (or below) a selected hierarchy node,
and approves these objects, copying them from the Main Workspace to the ApprovedWorkspace. This is
useful and time saving, for example, when multiple images have been imported and checked and should all
be approved, compared to reviewing and approving each object individually.

Approving Recursively is available for:

Classifications

Products

Images & Documents

Entities (setup to be workspace revisable)

The status of an object in the various workspaces can be displayed using the Workspace View Mode of the
relevant editor.

To recursively approve:

1. Select theMain Workspace.

2. In the Tree, select the hierarchy containing the objects to be approved.

3. Right-click the hierarchy object and click Approve Recursively. Alternatively, on the Maintain menu, click
Approval, then click Approve Recursively. A dialog displays the name of the selected hierarchy node, a
count of the objects within the hierarchy, and other information.

Note: Approve Recursively automatically performs a search for unapproved Objects. Click the Skip
Analysis button if desired.
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4. Optionally, type a name for the process.

5. Click theOK button to start the approve process and display a dialog with information.

6. ClickGo to process button to open the Process view showing details of the process and a report of
approved objects. The hierarchy displays an Approved status to indicate that it is copied into the Approved
Workspace.

Approval Feedback
Depending on Approve privileges, the following warnings and dialogs may be displayed after clicking
Approve Object or Partial Approve.

For more information about user privileges, refer to the User Actions and Error Descriptions topic in the
System Setup documentation.

Approve Object Feedback

If you have modified attribute values for which you do have Approve Privileges and at the same time you have
modified attribute values for which you do not have Approve Privileges, an 'Unable to approve' object dialog
displays.
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If you have modified attributes values and do not have Approve Privileges, then the 'Approve' option is
disabled in the right-click menu.

If you have modified attributes values for which you do not have Approve Privileges, a 'Missing privileges'
dialog displays.

Partial Approve Feedback

If you have modified attribute values for which you do have Approve Privileges, and at the same time you
have modified attribute values for which you do not have Approve Privileges, a Partial Approve dialog box
displays.
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In the example above, the user can approve all attribute values in 'Audio Accessories 1' and 'Audio'. Only
attributes that the user has permissions for are displayed.

Approve Recursively feedback

After running Approve Recursively for a hierarchy node, review the feedback in the Background Processes
tab.

1. On the BG Processes tab, click Approve Recursively, open the Active or Ended Processes node, and
click the relevant process.

2. In the Background Process tab, open the Execution Report.

If the process or approval was successful, the report shows 0 errors and 0 warnings. Details are provided if
errors were found.

The following example shows a missing mandatory attribute value error, which caused the object to not be
approved.
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Approve Recursively dialog

The following information is included on this dialog:

Finding Unapproved Objects: Analyze the hierarchy and provide the count of the products,
classifications, assets, or entities which are currently in unapproved status.

Empty mandatory links / values in Main workspace: Display details about mandatory values, links, or
references that are missing for the products, classifications, assets, and entities.

Start Process with Description: Enter a name for the background process. While this option is not
mandatory, it is recommended to easily identify the process during review.

Skip Analysis: When the number of child products is large, the analysis of unapproved or missing
mandatory values and references can be time consuming. Click this button to stop the analysis and
skip the report, but proceed with the approving recursively background process.

Context Dependent Approvals

Object approval happens in the current context and only applies to data visible in that context.

To illustrate this concept, refer to the figure below in which object 'P' has values for the attributes Color and
Width in the Main workspace. While Width is not dimension dependent, Color is dimension dependent and
has different values in two contexts: 'Blue' in the English context and 'Bleu' in the French context. If the
object is approved in the English context, only the data visible in the English context is reflected in the
ApprovedWorkspace. Because of this separated approval, the object must also be approved in the
French context to be completely approved, indicated by a green checkmark in the Approved parameter.
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Until all contexts are approved, the object in the English context has the status 'Approved in Current
Context on [date + time]', indicated by a yellow checkmark, and the object in the French context has the
status of 'Last Approved on [date + time]', indicated by a red clock.

If Color is set as a mandatory attribute in the French context but is left empty, then an empty mandatory
attribute warning will display when attempting to approve the object in the French context.

All mandatory attributes will be checked upon approval to notify is any are empty in the context in which the
object is being approved. For example, in the first of the images shown below, the value added for the
mandatory attribute 'Color' in the English context is 'Blue'. The object can be approved in this context
without any issue. The approval icon is for the current context only, so in this example, the English context
displays the partial approval icon.
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When the View Mode is changed from Normal to Context, the empty mandatory attribute alert is shown in
the French context.
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When changes are made to both contexts, the approval icons are updated to show 'Approved in Current
Context' and 'Last Approved'.

When the object is approved in both contexts, the object is fully approved, displaying a green checkmark
for both contexts.
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If a change is made in one context, for example, changing the Color attribute value in the French context
but leaving the value for the Color attribute in the English as is, the object regains full approval once the
object is approved again in the French context.
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Approved Symbols and Messages
An object can contain both workspace revisable data and globally revisable data. The Approved symbols and
messages indicate the status of the workspace revisable data on a product, classification, image, or
document. The status can be viewed in the Approved parameter on these objects.

For details on the approval process, refer to the Approving an Object topic.

For more information on revisability, refer to the Revisions topic in the System Setup documentation.

Approved Status Symbols
Approved
Symbols

Status Description

Unapproved
(Never Been
Approved)

An object is unapproved if it has never been approved or if revised data
on the product, classification, or images & documents in the current
context is not approved.

For example:

An object has never been approved.
Revised data has been changed in current context without
being approved. Revised data includes attribute values,
references, object names, or tables.

Examples of changes to revised data include:

A change in object name.
A changed value on an internally maintained attribute.
If an attribute has been linked to a product.
If reference links to objects have been made.

Note:When linking a product to classification and in case the
classification object type owns the product links, then the product
does not get the Unapproved symbol. For more information, refer to
the Object Types and Structures topic in the System Setup
documentation.

Approved Revised data on product, classification, or images & documents is
approved in all contexts.

© Stibo Systems - Internal - 2024.4 - December 2024 145



Approved
Symbols

Status Description

Note: No data in any context needs to be approved.

Last Approved Revised data has been approved and then subsequently changed.

Partial Approve
(Approved in
Current Context)

Revised data has been approved in current context but a reference,
object name, or value needs to be approved for the object to be
approved in all contexts.

If you view another context, then you typically notice that:

A dimension dependent reference is not approved.
A dimension dependent value is not approved.
A dimension dependent object name is not approved.

When all the dimension dependent references, attribute values, and
object names have been approved, the symbol changes from yellow
Partial Approved symbol to a green Approved symbol.

Approved Status Messages
The following messages (with the user, dates, and time) are displayed for workspace revisable data.

Unapproved / Never Been Approved

An object that is newly created and has never been approved is shown as below:
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Approved

An object that is approved in all contexts is shown as below:

Last Approved

An object attribute or reference that is modified shows is as shown below:

Note: The 'Last Approved' message also displays if using the 'Partial Approve' option on an object. If
'Approved in Current Context' is displayed, then an object is also partially approved but a different
message displays (as described in the Approving an Object topic).
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Partially Approved / Approved in Current Context

An object that is approved in only some contexts displays as shown below:
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Creating Objects in the Tree Tab
Regardless of the particular object type or hierarchy that you are working with, the general principles of
creating objects in the workbench are the same, and are described below. Tree icons are set during object
type creation according to preference and may be different in your system.

Note: All actions are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The
information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege
Rules topic in the System Setup documentation.

Objects can be manually created in the Tree via right-clicking or using the Maintain menu.

Create a new object via right-click

1. Select a parent under which the new object should be created. Note that if the new object should be
created as a root node on the Tree tab, the Maintain menu must be used (refer below).

2. Right-click on the parent and select the appropriate 'New...' option. The options will vary based on the
selected parent. For example, note the differences between the available options on a classification and
an entity, as shown below.

3. Selecting the right-click option will open a Create dialog, appropriate for the selected object super type
(e.g., Create Assets for assets and Create Entity for entities). The options available in the dialog are based
on the data model defined in System Setup. For example, the Object Type selection will vary based on the
allowable object types under the selected parent, and ID will only be available for population if the object
type being created does not have autogenerated IDs applied.
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Note: The following restrictions apply to the ID for all objects: 

Maximum 40 characters.

Only the standard ASCII printable characters in the range of 32-126 are allowed.

4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking
Create completes the creation of the new object, which is then accessible in the Tree. If a Name is not
supplied, the object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation,
the object will display in the Tree using the Name entry. For example, two new objects have been added
under Customer C in the screenshot below. The first did not have a Name supplied, while the second did.

Create a new object via the Maintain menu

From the menu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use this method when adding a new root node to Tree. Additionally, note that
the available options differ based on the active selection when the menu is accessed. For example, the below
shows the available insert options when a classification has been selected, whereas the publication-related
options would be enabled if a publication object had been selected instead.
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Many of the available options will only be enabled when an appropriate selection has been made on the
System Setup tab. For example, an attribute group must be selected for the Attribute or Attribute Group
options to be enabled.
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Deleting Objects in the Tree Tab
Regardless of the object type or hierarchy that you are working with, the general principles of deleting objects
in the workbench are the same and are described below.

Prerequisites

All actions are controlled via privileges. Some users may not have access to create or delete objects or may
only have access to edit specific object types, hierarchies, or attribute values. The information below focuses
strictly on carrying out the various actions and assumes that all required privileges are granted. More
information on privileges is available in the Privilege Rules topic in the System Setup documentation.

Delete Objects
Objects deleted in the Tree tab are moved to the Recycle Bin for the Tree, where they can be revived or
purged. To fully delete an object, the deletion must be approved, and the object must be purged from the
Recycle Bin. For information on the Tree Recycle Bin, refer to the Recycle Bin for the Tree Tab topic.

Important: As an alternative, an object can be deleted from the Tree and also purged in a single step
using the 'Force Delete & Purge' option in the Maintain menu. This option bypasses the Recycle Bin. Do
not use this option if deletion events are required for output to downstream systems since a
DELETEAPPROVAL event is not generated for 'Force Delete & Purge'. Refer to the Force Delete and
Purge heading in theMaintain Menu topic of theGetting Started documentation.

To delete from the Tree:

1. Select an object (or multiselect using Ctrl or Command) in the Tree.

2. Choose a delete method:

Right-click the selection and click Delete.

© Stibo Systems - Internal - 2024.4 - December 2024 152



From the Maintain menu click Delete.

3. Review the Delete confirmation dialog, which varies slightly based on the object selected for deletion and
the number of objects to be deleted.

Analyzing nodes to be deleted progress bar - displays as needed when large numbers of objects
are being deleted. The Delete button is disabled while the analysis is running. Although the table is
empty during the analysis phase, the impacted object types are displayed in the header.

The view options buttons - allow display of the primary image when available.
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The object to delete table - includes the names of objects to be deleted and the number of impacted
objects.

Sub Products - when deleting a classification, select Unlink to leave the sub product in the hierarchy,
or select Delete to delete the selected objects and the sub products linked to the classification.

This is not an option for products; all child objects for products are automatically deleted.

Deleting a large number of objects, such as a parent object with more than 1,000 objects, uses a
background process (BGP) to move the objects to the recycle bin. This allows the user to continue
other activities in the workbench while the BGP runs.

The number of objects that triggers a BGP is determined by the case-sensitive property
Delete.InBackgroundProcess.RequiredNodeNumber=1000. The default is 1,000. For on-prem
systems, the property is included in the sharedconfig.properties file on the application server.
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4. Click Delete or Delete in background to proceed with the deletion or click Cancel to close the dialog
without making any changes.

5. Review the 'Delete report' dialog or details of the BGP execution report, including the Delete Objections
andWarnings if displayed.

To delete an object, a number of conditions must be met. For example, the object must not be referenced
by any other object and must not be active in any workflow. When the deletion conditions are not met, the
confirmation window displays the errors (Delete Objections) that must be corrected prior to deletion.

Approval may be required for the deletion to take effect. For example, if an object has been referenced by
another object and that reference has been approved, removing the reference must also be approved (by
approving the change on the referencing object) to resolve the deletion objection.

If no errors or warnings are displayed, click Close.

If errors or warnings are displayed in the ‘Delete report’ window or the ‘Delete large number of objects’
BGP, it is recommended to note the issues, click Close, and manually resolve them. Review the
warning section to decide if the Force Delete option is a good choice.
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The Force Delete button allows deletion of objects with errors and warnings from the ‘Delete report’ or
the ‘Delete large number of objects’ BGP if the object is not in use (instantiated in the Tree) and
typically involves restrictions (as defined on the dialog) if the deleted object is later revived. In either
case, Force Delete uses a background process to perform the deletion and the process can be
monitored on the BG Processes tab within the Force Purge or Delete Nodes queues.

If the object is in use, the 'Force delete report' dialog displays success or the objections that must be
resolved manually before deletion can succeed.

6. View the deleted object(s) in the recycle bin. For information on the Tree Recycle Bin, refer to the Recycle
Bin for the Tree Tab topic.
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Editing Objects in the Tree Tab
Objects can be easily edited within the Tree tab, and general principles for editing are the same, regardless of
the type of object. The available tabs will vary based on the object type selected, as well as other
considerations such as data model and licenses. Some tabs are common across the various object super
types, while others appear only on specific object types or subsets of object types. Additionally, some editors
appear on more than one super type, but have differing functionality based on the type of object that has been
selected.

This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

Note: All actions are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The
information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege
Rules topic in the System Setup documentation.

When an object is selected, the main portion of the screen displays a corresponding editor. The main editor
for the object is the first tab, which is Classification in the below example.

All objects will have an ID, Name,Object Type, Revision, and Path field. Objects that are subject to approval
(known as 'workspace revisable') will also have an Approved field.

ID cannot be changed once an object has been created, so the field appears yellow, meaning it is not
editable. For details, refer to the Creating Objects in the Tree Tab in this documentation.

Revision and Approved data is auto-populated by the system, so these fields are also not editable.
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Conversely, object Name andObject Type can be edited (assuming the user has privileges to do so), so
those fields appear white.

Note: Any number of attributes may be added to objects under the Description flipper. However, not all
data shown in the Description section is an editable attribute. Fields such as ID, Revision, Approved,
Translation, and Path are aspects of the object (not attributes), and are not editable. Name and Object
Type are also aspects of the object, though these may be edited.

Some object types only support Description attributes, meaning all object data is accessed under the
Description flipper. For object types that support Specification attributes, data is organized by attribute
group, and clicking the magnification icon (indicated by a 1 in the screenshot below) will collapse or expand
each group, allowing users to focus on the relevant data. All attributes have a validation base type applied that
determines the allowable data that can be entered, and is indicated by the icon to the right of the attribute
name below (2). Detailed information on attribute validations is available in the Validation Rules topic in the
System Setup guide.

To edit data, click in any editable field. Text attributes can be edited by typing directly into the field, while LOV
attributes will provide a dropdown from which users can select a value, as shown below (3).
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Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2
opens the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, refer
to the STEP Workbench Keyboard Shortcuts topic within this guide. The data fields available for editing will
depend entirely on the data model and will vary for each implementation.

Note: Data edited in the workbench is auto-saved, with the change / save being applied as soon as the
user exits any field. Therefore, no explicit save action is ever required by the user.

If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will
change the approval status (if the object had been previously approved). Refer to the Approval of Objects
topic within this guide for more information on approvals.

Multi-Editors
Objects can be multi-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally,
objects of the products and classification super types have a Sub Products tab that can be used for multi-
editing. Functionality for editing objects is comparable, regardless of how the multi-editor interface is
accessed.

Right-clicking in any row header will expose the Rotate Table option which can be used to access the
preferred orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active
selection.). Editing in this manner allows for easy copy / paste of values between objects using Ctrl + C and
Ctrl + V.

Right-clicking in any data cell will expose the Hide Equal andMark Different options, which are especially
useful when working across multiple objects as they will hide all equal values, or highlight all different values,
respectively.
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Additional options for viewing data are available using the Viewmenu located in the upper left corner of the
multi-editors.

The default view option is to Show all which displays all data on the object, similar to what would be available
in a single-object editor. Additional options can be configured using the New View option. Clicking this opens
a dialog for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the
user can select the attributes to be included in the view.
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The dialog defaults to having only "legal" attributes shown, meaning those attributes that are valid for the
object, as well as standard aspects of the object such as ID and Name. Note that object aspects are italicized,
while attributes (which are always specification attributes) are shown in standard text. By default, all available
attributes and aspects are shown in both the left and right panels. The dropdown in the upper left corner also
has options to expose standard attribute search / browse functionality, though typically the Legal Attributes
selection is used as this prevents a user from defining an invalid view. The 'Show only' and 'Do not show' radio
buttons are applicable to the right panel, where the data for the view is defined. The Add button is used when
an attribute or aspect has been selected in the left panel and should be added to the view (the right panel).
The Remove button is used when an attribute or aspect has been selected in the right panel that should be
removed the view. The Add All and Remove All buttons are used to add or remove all attributes and aspects
from the view. Clicking Save stores the new view.

Once one or more views have been created, they are available for selection from the Viewmenu under
Product views.
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An existing view can be edited using the Edit view option, and a view that is no longer needed can be
removed with the Remove view option.

Note: Views are user-specific and machine-specific, so a view created by one user will always be
available for that user when using the machine on which they created the view, but will not be available for
any other user or for the same user working from a different machine. Workbench views are stored in an
XML file on the user's local machine at C:\Users\[user]\STEPUserViews[UserID].xml. If the file is deleted,
the configured views will no longer be available.

Right-Click Editing Options
Additional editing options are available by right-clicking within the various editors. These include standard cut
/ copy / paste options, as well as more exotic options which are briefly described below.

Note: Not all options are available and/or enabled at all times. Some options are available only for
particular attribute validation types, and others are available only on specific editors and/or object types.
Menus also change based on whether the right-click takes place on the column or row header, or within
the active editable value field, as well as when a single object / column / row has been selected vs. when
multiples are selected.

Character Tag: Used as a quick option to add tags to attribute values without having to enter the Rich
Text Editor. Character tags that have been defined for the system will be available as sub-options to the
Character Tag selection. For more information, refer to the Tags topic in the System Setup.
Edit: Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell
check, special characters, etc.
Filter: Used to filter the displayed data under any flipper, by values, and is exposed by clicking the column
header. This can be especially useful when working with attribute groups with a large number of attributes
in them as it allows users to filter based on empty / populated, greater than / less than, etc.
Footnote (Insert / Edit): Used to add an additional piece of information (e.g., a footnote) to an attribute
value. Footnotes are added / edited within the Rich Text Editor so using these options will open that dialog.
Note that footnotes are only supported for use in conjunction with STEP tables. Using footnotes within
attribute values that will output in something other than a table will not yield the expected results. For more
information on footnotes, refer to the Tags topic in the System Setup.
Hide: Used to hide a particular row or column from view, and a hidden row or column is exposed by
clicking on the row indicator or column header.
Hyperlink (Insert / Edit, Follow, End): Used for adding hyperlinks to attribute values. Highlight text
within the attribute value and select the insert option to provide a hyperlink to be assigned to the selected
text. After inserting, and with the cursor at the end of the hyperlinked text, use the end option. This ends
the hyperlink so that subsequent text does not become part of it. Use the edit option to edit a previously
inserted hyperlink. Select the follow option while the cursor is within the hyperlinked text to follow the
hyperlink. For more information, refer to the Tags topic in the System Setup.
Inline Reference (Insert / Edit, Copy as): Used to add inline references to attribute values. Inline
references are used to re-use values present within another attribute, object Name, or ID. This avoids
duplication of data by maintaining the data only once, and re-using it from that source as needed. For
example, a description attribute may need to dynamically include the object Name, e.g., '[Name] is a great
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product!'. Detailed information on working with inline references is available in the Inline References in
Attribute Values topic within this guide.
Insert Special Character: Used as a quick option to add special characters to attribute values without
having to enter the Rich Text Editor. Opens an editor allowing for selection of the most recently used
special characters, with an option to access a full Unicode character menu. For more information, refer to
the Tags topic in the System Setup.
Override: Used to manually populate a local value to override a calculated (derived) value. This option is
only enabled on calculated attributes. For more information, refer to the Calculated Attributes topic in the
System Setup.
Recalculate: Used for on-demand display of calculated attribute values in the editor if they have
previously been disabled via the 'Disable calculated values' option in the View menu. For more
information, refer to the Calculated Attributes topic in the System Setup.
Rotate Table: Used to rotate the data display. As a right-click option, it is only enabled from row / column
headers when multiple objects are selected. For a single object, it can be used to rotate the data under a
flipper only via keyboard shortcut (Alt + F11).
Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows
/ columns.
Sort: Used to sort data based on attribute value rather than attribute name or display sequence. This
option is exposed when a column header is selected, and requires a sort selection (Ascending,
Descending, or None).
Style: Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter
the Rich Text Editor. Styles that have been defined for the system will be available as sub-options to the
Style selection. For more information, refer to the Tags topic in the System Setup.

Additional Information
In addition to the main editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functions within them vary based on the
selected object. Therefore, they are described in the context of the type of object being edited, in the
subsequent sections of this guide:

Assets
Classifications
Collections
Entities
Products
Recycle Bin for the Tree Tab

Publications: The publication hierarchy and its associated objects are detailed in the Publication
Hierarchy section of the Publisher (Adobe InDesign Integration) documentation.
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Inline References in Attribute Values
Inline references can be embedded in attribute values for attributes that have Text, Text (exclude tags),
Numeric Text, and Numeric Text (exclude tags) validation base types. An inline reference use case
follows:

You are working with product objects whose model number is the same as their STEP ID (for example,
'12345'). On these objects there is an attribute called 'Product Description' that needs to dynamically
reference the object's model number within the text of the attribute. For a Product Description such as
'Acme lawn mower, model number 12345,' the inline reference to the STEP ID would populate '12345.'
Using an inline reference in this instance helps to avoid duplication of effort—since the product's model
number already exists in STEP as its ID, there is no need for users to manually enter it a second time into
the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system
resources. For example, it may be easier for users to use an inline reference to pull in a STEP ID than to
create a calculated attribute using the formula 'StepID()'.

One attribute value can include several inline references. An inline reference can reference either a single
attribute or an attribute group.

Inserting an Inline Reference using Workbench
1. Select the relevant node. The corresponding editor appears.
2. Click on the leftmost tab within the editor, which is different depending on the object type (for example,

'Product', 'Classification', 'Images & Documents', 'Publication,' and so forth).
3. Activate the Value field of the relevant attribute where you want to create or edit the inline reference. Or,

highlight the field, right-click, and select Edit to launch the larger value editor.

Note: Pressing Alt + F2 will also open the value editor.

4. Place the cursor at the position in the Value field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

5. Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference
to edit an existing inline reference.
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6. The Inline Reference dialog displays.
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7. To return a value or values from another object in STEP, not the name or ID of the current object, click the
ellipsis button ( ) to the right of theObject field. Ignore this field if you plan to return value(s) from the
current object instead.
Click the ellipsis button ( ) to display the 'Select Object' dialog, search for or browse to the object that
holds the value(s) that you would like to return, then click Select to choose the object.

8. Select Resolve To Object ID to return the value of the STEP ID of the chosen or current object.
9. Select Resolve To Object Name to return the value of the STEP Name of the chosen or current object.
10. Select Resolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion

of the Inline Reference dialog.
11. Click the ellipsis button ( ) to the right of the Attribute field to open the 'Select Attribute or Attribute

Group' dialog.
12. Search for or browse to the relevant attribute or attribute group for the inline reference, and then click

Select.
13. For Attribute Name(s), check the Include box if the name of the attribute(s) should be included in the

inline reference.
14. In the Separator field, type a separator to be used between the name and value of the attribute. The

default is the equals sign (=). Note that the Separator field is not activated unless the Include box has
been checked.
For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:
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15. Under Attribute Value(s), select the relevant Aspect from the dropdown list. Available options are 'Value
(s) and Unit(s),' 'Unit(s),' and 'Value(s).'

16. In the Attribute Separator field—which is only valid when an attribute group has been chosen for the
Attribute selection—type in one or more characters to specify how the attribute values should be
separated. The default is the semicolon character without a following space (;).
The following screenshot shows:

(1) An attribute group called 'Manufacturer Information' selected for Attribute
(2) A separator of = placed between the attribute name and attribute value
(3) An attribute separator of ; placed between each attribute within the group
(4) How the attributes and attribute values resolve in the inline reference.

17. ClickOK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes
The Attribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued
attributes. Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag
(multisep). The multisep tag is a Character Tag in System Setup and comes standard with STEP systems.
STEP stores the values of multi-valued attributes with the multisep tag between them, and this tag typically
renders as a forward slash (/).
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If a multivalued attribute is used in an inline reference, the rendering setup for the multisep tag will be shown
between each of the values. In the below example, the 'Country of Origin' attribute has four values. When
rendered in the inline reference, these four values are separated by the forward slash (/) character.

For more information on STEP character tags, refer to the Tags topic in the System Setup documentation.

Copying Attribute Values as Inline References
An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then
paste it into the value editor of another attribute as an inline reference. This inline reference can then be edited
like any other inline reference.

1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor
field.

2. Right-click and select Copy as inline reference.

© Stibo Systems - Internal - 2024.4 - December 2024 168



3. Navigate to the 'destination' attribute value and select the value editor field.
4. Right-click and select Paste.

5. The value appears in the destination field as an inline reference.

Note: The copied 'source' attribute value is connected to the 'source' object, meaning that any time an
attribute value is coped as an inline reference and pasted elsewhere, the inline reference will never pick up
the attribute value from the current object but only from the 'source' object. Also, STEP IDs and STEP
names cannot be copied as inline references.

© Stibo Systems - Internal - 2024.4 - December 2024 169



Inserting an Inline Reference using Web UI
Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted
into an attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference in Web UI is similar to adding one in the workbench. For instructions, refer to the
Rich Text Editor section of theWeb User Interfaces documentation.
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Assets
This topic covers information specific to the asset super type that is important to know when working with
assets. For general object maintenance information (applicable to all object types rather than specific to
assets), refer to the All Objects topic.

An asset is any product-related electronic file, such as images (tiff, eps, jpeg, etc.), Word docs, Excel files,
PDFs, PowerPoint files, text files, etc. Images are a common asset so they will be the focus of this section. In
most cases, the terms 'asset' and 'image' are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality
check be performed by users with graphic arts knowledge. Ideally, this check occurs prior to import into STEP
so that only approved images are available in the system.

Classification of Assets
Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated
from other classification hierarchies (e.g., those used for alternate structuring of products, import / export
configuration storage, etc.).

The recommendation is to have one classification object type and instance for each asset object type. For
example:
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Within the individual type-based classifications, additional levels can be modeled if necessary. A common
option is to work with a 2-level folder structure based on the first characters of the asset file name. For
example:

With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets.
Instead, assets are typically located via references from other objects and/or via searches. STEP does not
require that the image hierarchy have multiple levels. Assets can be stored in a single folder (e.g., a flat
structure). However, this is not typically recommended as it can be impractical to navigate the hierarchy as the
number of assets increases.

The same asset object can exist below multiple different classifications. However, this functionality is typically
only used for cases where suppliers upload assets. These assets will initially go into supplier-specific
classifications and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation
New asset object types are defined in STEP the same way any other object types are, via the System Setup
tab. One key difference between asset object types and other object types, such as products or
classifications, is that there are no parent-child relations between assets, as asset instances live in
classification hierarchies.

Asset object types are defined in STEPWorkbench System Setup under 'Object Types & Structures.' Apart
from the built-in generic type 'Assets', it will be a flat list of the different asset object types required for the
setup. For example:
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On older systems, you may observe asset object types that are file-type specific. For example: JPG Image,
Word Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather
than the file type. This is done for clarity as it is often more important to understand the purpose of the asset.
For example, an asset is not just a PDF file, instead it is an Installation Manual, a Product Brochure or an
Owner's Manual. One advantage of the purpose-based setup is that it is possible to restrict reference types to
point to the specific types of assets and not just to generic file types.

With the move away from file type specific asset object types, asset object types cannot be applied
automatically when digital media files are imported into STEP as there is no 1:1 relationship between file
types and asset object types. It is possible to have object types automatically applied upon import when a file-
based approach is used, but this functionality generally does not weigh up to the disadvantages of the
approach.

Asset Objects and Digital Media Files
A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and
digital media files in STEP. Thus, it is possible to work with asset objects that do not have "content", i.e., are
not tied to any digital media files. Furthermore, the content can be dimension-dependent so that an asset is
tied to different files in different contexts. Finally, an asset can have different content in different historical
revisions.
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As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects
(not to the actual media files) that relations are modeled (using references).

Image Variants and Handling
Different publishing projects impose various requirements on the use of images. For example, a high-
resolution image in STEP may be a TIFF. However, for the web, a jpeg is needed. Or, if the high-resolution
image is an EPS, a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high-resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines. When using an image conversion, the
images in STEP must be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configuration topic in the Digital
Assets documentation.

More Information
For specific details about working with assets in the workbench, refer to the Maintaining Assets topic and the
Linking Assets to Products topic.

For information on working with assets in Web UI, refer to the Asset Handling in Web UI topic in the Web User
Interfaces documentation.

For information on importing, exporting, and managing assets, refer to the Digital Assets documentation.
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Maintaining Assets
This topic covers information specific to the Asset super type that is important to know when working with
assets. For general object maintenance information (applicable to all object types rather than specific to
assets), refer to the All Objects topic within this guide.

Creating Assets
The basic methods for creating an asset are the same as any other object type, as described in the Creating
Objects in the Tree Tab topic within this guide. However, there are a few considerations that are specific to
assets that users should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated. When assets
are created in STEP via import of a digital media file, this association happens automatically. However, when
assets are created using standard object creation methods in Tree (e.g., right-clicking on a classification
folder and selecting 'New Asset'), it is only the placeholder that is created. An asset created in this manner will
initially have no system properties and no content. For example:

A user can right-click on the asset and select Replace Asset Content to open a dialog where a digital media
file can be selected from the local machine. STEP will automatically read and populate the properties of the
asset, and a thumbnail of the digital media file will display. For example:
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To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols
for an initial implementation). More information on importing assets is available in the Importing Assets
section of the Digital Assets guide.

Asset Editor
General information about editing objects in STEP is available in the Editing Objects in the Tree Tab topic
within this guide and is not repeated in this section. However, assets have some additional editing options
specific to working with digital media files, which are described.

Images & Documents

The Images & Documents tab is the primary workbench interface for assets. It has three sections, described
below.
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1. The Description flipper contains the same basic information as other object types. Additional Description
attributes can be made valid for assets to support data such as keywords or asset descriptions.
Specification attributes cannot be made valid for assets.

2. The System Properties flipper displays data that is read automatically from the digital media file. This
information cannot be edited.

3. The asset thumbnail has a number of options available for editing assets. Additional right-click options are
also available when the asset itself is right-clicked from the Tree. All of the options that are specific to
assets only (accessible from right-click on the thumbnail or the asset) are described below.
Create Local Content of Asset: Creates a local version of the asset specific to the current context.
Refer to the Asset Dimension Dependencies section below for more information.
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Delete Local Content of Asset: Deletes the content of an asset that is not dimension dependent.
Deletes the local (context-specific) content of the asset if the asset is dimension dependent. Refer to the
Asset Dimension Dependencies section below for more information.
Edit Asset:Opens the digital media file for editing in an external program, in addition to an Edit Asset
dialog in STEP. Upon completion of editing in the external program, click save within the program to
store the edited asset to a temporary directory. Then click OK in the Edit Asset dialog in STEP to have
STEP retrieve the edited file from the temporary directory and store this in the asset. Note that the media
file will open in the application associated with the file type. For example, for files ending with .xls, Excel
will automatically be launched. This may be different from computer to computer. One user’s computer
may open up EPS images in Photoshop, while another user’s computer may open the same file types in
Illustrator.
Export Images & Documents:Opens the Export Images and Documents wizard to make selections to
export the currently selected asset(s). Refer to the Export Images and Documents Wizard topic in the
Digital Assets guide for more information.
External Viewer:Opens an external viewer for viewing the asset. This is comparable to the Edit Asset
function in that the program that is utilized is specific to the file type and the user's computer settings. It
differs in that any changes made to the asset in the external program are not saved back to STEP.
Image Viewer:Opens an image viewer within STEP for the user to examine the actual asset (as
opposed to just the thumbnail).
Push Asset(s): Initiates asset push for the selected asset(s). Refer to the Asset Push section of the
Digital Assets guide for more information.
Replace Asset Content:Opens a dialog for the user to select a digital media file for the asset. Refer to
the 'Creating Assets' section above for more information.
Save to disk:Opens a standard save dialog allowing the user to select a location on their local machine
to save the digital media file to.
Unlink asset:Only enabled if the asset has been linked directly into a publication, in which case it
unlinks the asset from the publication. Refer to the Publication Hierarchy section of the Publisher (Adobe
InDesign Integration) documentation for more information.

References

The References tab displays the classifications that the selected asset is linked to, and allows for linking to
additional classifications using the Link to Classification link. Each asset must be linked to at least one
classification, but may be linked to many. Links can be removed by right-clicking on the row indicator and
selecting 'Remove Link to Classification'. The Name of each classification displayed is hyperlinked for easy
navigation, and revision, approval, and translation statuses are also displayed.
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Note:While the maximum number of references to one object node is limited to 10,000 instances, this
value can be changed; however, it is against Stibo Systems recommended practices to use this many
references. Before changing this value, contact Stibo Systems for assistance.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects
that the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place).
The display of the Referenced By tab on an asset will vary slightly from system to system, based on the data
model.

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a source for the
reference, and a reference will be created from the object selected in the dialog to the currently selected
object that you are standing on (e.g., current object = target, dialog selection = source). If any attributes are
available on the reference and editable, they can be edited within this interface. References can be
removed by clicking the (X) on any existing reference. Additional information on configuring and working
with references is available in the Reference and Link Types topic in the System Setup.
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2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what
is described for the Reference Flippers section above. The only difference is that this area displays
references that have not been placed in attribute groups for display purposes.

3. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publisher (Adobe InDesign Integration) section of the online
help.

Status

The Status tab provides general information about objects, including revisions, translation status, and
approval status. For more information on these basic settings, refer to the Status Tab topic in the Products
section of this guide. For assets specifically, this tab also includes an Asset Push Status section that
describes the status of assets for the various asset push configurations on the system. For more information,
refer to the Monitoring Asset Push topic in the Digital Assets guide.

State Log

The State Log tab allows users to view the recent history of the object across all workflows in which it has
been entered. Refer to the State Log Tab topic in the Workflows documentation for more information.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's
privileges (only tasks that the user has the rights to address are visible). When relevant tasks and privileges
are in place, the user is able to act on the tasks from this editor, including to edit data and move tasks through
the workflow. More information on the Tasks tab is available in the 'Moving Tasks through aWorkflow in
Workbench' topic in the Workflows guide.

Asset Dimension Dependencies
Individual asset object types can be made dimension dependent using the Dimension Dependencies
parameter on the object type. This configuration will only affect the STEP Name of assets, meaning that it
allows for individual assets to have a different name based on the indicated dimension dependencies (e.g.,
'Red Hat' in English and 'Chapeau Rouge' in French when the dependency is Language).
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It is also possible to make the content of assets dimension dependent so that an asset in STEP can be tied to
different digital media files in different Contexts. This is configured using the Image & Document Settings >
Dimension Dependencies parameter in System Settings.

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on
asset dimension dependencies, this should be avoided. As mentioned, the setting is global, meaning that
special procedures must be implemented for creating assets that are to have the same content in all contexts.
Thus, if you import a digital media file (and via this create an asset instance) in a context that does not use the
top-level dimension point for the dimension on which asset content depends, the content will be created only
in the dimension point the current context uses.

For additional information, refer to the Image & Document Settings topic in the System Settings
documentation.
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Custom Asset Metadata
When importing assets into STEP, System Properties attributes can be automatically created in STEP on the
asset, and then populated with the image metadata detected on the incoming assets. The image metadata
must be formatted as either XMP (Extensible Metadata Platform) or EXIF (Exchange Image File).
Determination of which metadata attributes should be housed in STEP is configured manually.

In an image file, image metadata is stored as plain text in XML format. Based on the configuration file and
import shown below, the Creator, Subject, and Description metadata will be written to STEP. In the following
sample, some rows have been removed for brevity, as indicated by '...'.

Prerequisites

The user should have a basic understanding of XML, the XML structure of image metadata, and XPath before
proceeding with configuration. The configuration file uses XML to define attribute names and the XPath query
to retrieve metadata. For more information, search the web.
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XMP Configuration File

The custom asset metadata configuration file uses the instruction 'XmpConfiguration' to define the name of
the system attributes being created in STEP and the XPath that defines how to retrieve the image metadata.

XPath is an XML query language STEP uses to search the XML within an image file and identify the desired
metadata. The XMP configuration file defines the XPath queries to be run against an image file being
imported.

The following sample configuration file defines three metadata attributes (Creator, Description, and Subject),
and the XPath query required to find the corresponding metadata.

In the above example, the 'creator' attribute is defined by the text:

name="Creator" unit=""

The XPath to find the creator metadata is defined by the text:

xpath="/*[name(.)='x:xmpmeta']/*[name(.)='rdf:RDF']/*[name(.)='rdf:Description']/*
[name(.)='dc:creator']/*[name(.)='rdf:Seq']/*[name(.)='rdf:li']"/>

Refer to the online version of this topic for another example.

Using an XMP Configuration File

1. Create and save a custom asset metadata configuration file using XmpConfiguration instruction as shown
above, that defines:
the image metadata attribute name(s)
the appropriate XPath to the required metadata on the image

2. Save the configuration file to the STEP server in the same directory as the sharedconfig.properties file.
3. Edit the sharedconfig.properties file and include the case-sensitive XMP.ConfigFile property as follows,

where 'customxmpconfiguration.xml' is the name of the configuration file created above.
XMP.ConfigFile = /workarea/customxmpconfiguration.xml
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4. Save the sharedconfig.properties file.
5. Restart the STEP server to apply changes to both configuration files.
6. Import an image that includes the metadata attributes defined in the XMP configuration file.
7. Navigate to the imported asset to view the metadata assets on the System Properties flipper.

Custom attributes are identified in the STEP asset editor by the text 'asset.' which is prepended to the
attribute name (for example, 'asset.Creator').

Important: Custom coding by Stibo Systems can be used to allow attributes to be displayed in
workbench with names other than 'asset.[attribute name]'. For more information, contact Stibo Systems.
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Linking Assets to Products
If the asset’s name can be matched to the product, then this function can be performed when the asset is
imported. If not linked at this time, there are two ways that the interface allows the link to be made: a) from the
product or b) from the asset.

There are three ways to link images to products:

From the product
From the asset
From import

Note:While the maximum number of references to one object node is limited to 10,000 instances, this
value can be changed; however, it is against Stibo Systems recommended practices to use this many
references. Before changing this value, contact Stibo Systems for assistance.

Linking Assets to Products (From Products)

1. Select the product and then select the References tab.

2. Navigate to the Image References section of the References tab. Click on the + symbol to link the image
to the correct area. For this example 'Primary Product' will be used as it is the most common reference
type made.

3. A search window displays.
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4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of
the image will appear when the product is selected.

Note:When assets are linked to products, you must designate what type of reference is being made.
For example, is it an image that represents the product? Is it an accessory to the product? Or a related
document? This reference type denotes that the image being linked to the product is a direct
representation of that product. When you make such a reference, a thumbnail of the image is attached
to the product. The thumbnail will only appear for this reference type. It is possible to link more than one
image to the reference type if the reference type is set to allow multiple references 'yes.'

Linking Assets to Products (From Assets)

1. Select the image in the Assets folder in the Tree. Then, select the References by tab.

2. If it is not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary
Product Image' to link the image to the product.
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3. Navigate to the Product in the pop up window, and select it.

4. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a
thumbnail of the image will appear when the product is selected as illustrated in the below image.
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Linking Assets to Products using the Import Manager

This method is best used for large amounts of products / assets linking. Ideally, you should already have a file
in Excel that has the products and desired Image ID set up according to how you want them to be after import.

Note: If you only need to link a few assets to products, then it is more efficient to link them via the interface.

1. Go to File and select Import, then Data. An 'Import Manager' window will appear. On 'Select Data
Sources', click the ellipsis button ( ) next to 'Filename' and select your file.

2. Proceed to the 'Map Data' step. Select a source column and click theMap button. Map the column holding
IDs to 'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the
'Asset Reference' radio button, select the 'Primary Image' radio button. For more information on mapping,
refer to Inbound Map Data - Map in the Data Exchange documentation.
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3. Click OK to close the Map To dialog.
4. If the image IDs were not found or the import file data was not done correctly, then columns will appear in

red. For information on input files, refer to Asset Reference - Map Inbound in the Data Exchange
documentation.

Note: If the image IDs were not found or the import was not done correctly, then columns will appear in
red.
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STEPXML Import

It is also possible to link the images to product via STEPXML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>
<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">

<Products>
<Product ID="18210" UserTypeID="Item" ParentID="18209">
<Name>18210 M B</Name>
<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>

</Product>
</Products>

</STEP-ProductInformation>
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Classifications
This topic covers information specific to the Classification super type that is important to know when working
with classifications. For general object maintenance information (applicable to all object types rather than
specific to classifications), refer to the All Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings.
For example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate
subfolders under the 'Assets' classification folder. Product objects could also be linked into classifications to
provide alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor
The primary editor for classification objects is the Classification tab.

This tab will display all description attributes that are valid for the classification. Note that only description
attributes are available on classifications (as opposed to products, which can also have specification
attributes). More information on description attributes is available in the Description Attributes topic of the
System Setup documentation.

Sub Products
When on a classification, the Sub Products tab is used to display objects of the product super type that are
linked into the classification via Product to Classification links. When the selected classification does not have
product children (e.g., classifications used to house assets or configurations), the Sub Products tab does not
provide any meaningful information.
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Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly
into any editable field. Standard editing capabilities are available within this interface (as described in the
Editing Objects in the Tree Tab topic within this guide), including copy / paste functionality using Crtl + C and
Crtl + V. Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide
Equal, and Mark Different selections - all of which are self-explanatory and can be especially useful when
editing multiple objects.
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Two views are available using the Rotate Table option. As shown above, the view can be organized to have
attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Right-
clicking within the header field exposes different options than within the data fields, including options to add
and remove products.

Selecting Remove Product deletes the product to classification link between the objects, but does not delete
the product itself.

Selecting Add Product opens a dialog allowing the user to browse hierarchies to select a product to link, as
well as specifying the link type to be applied.
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Note that the same functionality is available using the Add Product link at the bottom of the Sub Products
editor.

References
The References tab is where all references of which the selected object is the source can be viewed and
edited (assuming proper privileges are in place). In addition, if the object has privileges applied, has objects
visible in other contexts, or has any linked attributes, that information can be viewed (and in some cases
edited) on this tab.

The display of the References tab on a classification will vary slightly from system to system, based on the
data model. If the selected object has classification reference types for which the object is a valid source,
those will appear on this tab, in addition to the default section options.
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1. Reference Sections: References can be placed in attribute groups for display purposes. All references
for which the selected object is a valid source that have been placed in attribute groups will display first on
the screen, with the section title being equal to the name of the attribute group. References can be added
by clicking the plus button (+) on the reference. This will open a dialog allowing the user to select a target
for the reference, and a reference will be created to the object selected in the dialog from the currently
selected object that you are standing on (e.g., current object = source, dialog selection = target). If any
attributes are available on the reference and editable, they can be edited within this interface. References
can be removed by clicking the ( ) on any existing reference. Additional information on configuring and
working with references is available in the Reference and Link Types topic in the System Setup
documentation.

2. Ungrouped Classification References: The functionality is identical to what is described for the
Reference Sections section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes. If all references that are valid for the selected object
have been placed in attribute groups, the Ungrouped Classification References section will not be
present.

3. The Applied Privileges section allows users to apply privileges to the selected classification. Detailed
information on creating and editing privileges is available in the Privilege Rules section of the System
Setup documentation.

4. The Visible Objects in Other Contexts section displays subproducts that are visible in another context,
which is only applicable if classification hierarchies have been set to be dimension-dependent in System
Settings. Refer to the Classification Hierarchy Settings topic in the System Setup documentation for
detailed information.
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5. The Attributes section allows the user to view attributes linked to the classification, as well as to add new
links using the Link to Attribute link. When attributes are linked to a classification, they are available to be
populated on any objects of the product super type that reference the classification (assuming the
attributes are also made valid on the applicable product object type). The exact columns available will
depend on the data model and the attributes that have been made valid on the attribute links. Whether or
not the various attributes are editable will also depend on the setup of the data model. However, an ID and
Name field are always shown, with the attribute name being a hyperlink that can be used to navigate
directly to the attribute. An Attribute Groups column is also present, displaying the attribute group(s) that
the attribute is in. A Mandatory column is present and if checked, product objects that reference the
classification cannot be approved until a value has been provided for the attribute. Note that mandatory
settings on the attribute itself apply globally, while mandatory settings on the attribute link apply only to
product objects that reference the classification at which the attribute is linked (or reference a classification
that is inheriting the link). More information on mandatory settings is available in the Mandatory Attributes
topic in the System Setup. If the attribute link is inherited, the row cannot be edited and the 'Inherited from'
column will display the parental node where the attribute has been linked, which is hyperlinked for easy
navigation. More information on linked attributes is available in the Inheritance in the Product Hierarchy
topic within this guide and in the Attribute Links topic in the System Setup documentation.

Referenced By
The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects
that the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place).
In addition, if the object is used by a match code or is used by any publication, that information can be viewed
on this tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

1. Reference Sections: References can be placed in attribute groups for display purposes. All references
for which the selected object is a valid source that have been placed in attribute groups will display first on
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the screen, with the section title being equal to the name of the attribute group. References can be added
by clicking the (+) on the reference. This will open a dialog allowing the user to select a target for the
reference, and a reference will be created from the object selected in the dialog to the currently selected
object that you are standing on (e.g., current object = target, dialog selection = source). If any attributes are
available on the reference and editable, they can be edited within this interface. References can be
removed by clicking the (X) on any existing reference. Additional information on configuring and working
with references is available in the Reference and Link Types topic in the System Setup documentation.

2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what
is described for the Reference Sections section above. The only difference is that this area displays
references that have not been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the
match code will display. For example:

More information on match codes is available in the Matching, Linking, and Merging documentation.

4. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publication Hierarchy section of the Publisher (Adobe
InDesign Integration) documentation.

Images & Documents
The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets
that are housed within that classification). Note that assets can be tied to classifications in two ways: as child
products, or via image and document references. Assets are typically referenced to classifications only when
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the classification contains non-asset children for which the asset is relevant. In any case, assets referenced to
classifications are not visible on the Images & Documents tab. This is in contrast to how the same tab
functions for products, where the tab displays all assets referenced to the selected product. However, for the
displayed assets (those that are child to the classification), the functionality available for interacting with the
assets is the same as what is available for referenced assets on a product, which is described in the Images &
Documents Tab topic.

Tables
The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to
present consolidated data across multiple objects, such as object name, part number, and price. For more
information, refer to the Tables topic.

Status
The Status tab provides information about the status of the object, including revision history, translation
status, and approval status. Products and classifications share a common Status tab, which is described in
the Status Tab topic.

State Log
The State Log tab displays the history of the selected object across all workflows. If the object has ever been
in a workflow, a section is displayed per workflow and the history of transitions of the object within that
workflow can be viewed. Detailed information on the State Log tab is available in the State Log Tab topic in
the Workflows documentation.

Tasks
The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's
privileges (only tasks that the user has the rights to address are visible). When relevant tasks and privileges
are in place, the user is able to act on the tasks from this editor, including to edit data and move tasks through
the workflow. More information on the Tasks tab is available in the Moving Tasks through aWorkflow in
Workbench topic in the Workflows documentation.
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Collections
Collections provide a valuable tool for data maintenance tasks. A collection is a container for storing sets of
objects from Tree and System Setup, independently of their placement in the hierarchies. A collection can be
created via a search or an import, and all objects in a collection can be updated at the same time.

Collections and collection groups are found in the Collections hierarchy on the Tree tab. A 'collection group'
can hold multiple collections and other collection groups. Refer to Creating Collections or Creating Collection
Groups topic for more information.

Dimension dependencies and workspaces, among other settings, impact the results of a collection created
from a search. For more information, refer to the Collection Considerations topic.

For more on data maintenance of collections and collection groups, refer to the Maintaining Collections topic.

Temporary Collections
The 'Temporary Collections' node is system-generated to store read-only collections created by a process,
such as bulk update background processes, exports, profiles, and Web UI basket. The right-click menu on
this node does not allow manual creation of new user collections nor deletion of existing temporary
collections.

Temporary collections created by background processes (BGPs) are deleted automatically when the BGPs
are deleted via the sharedconfig.properties file case-sensitive entry
AutoDeleteBackgroundProcesses.AgeInHours.[processname]=[hours]. In this setting, the

© Stibo Systems - Internal - 2024.4 - December 2024 199



[processname] designation is replaced with the name of the BGP and the [hours] designation is how long
to wait before deleting BGPs. For more information on this property, refer to the Create a Background
Processes Maintenance Plan topic within the System Setup documentation.

For example, running a bulk update BGP creates three temporary collections. Setting the
AutoDeleteBackgroundProcesses property with 'BulkUpdate' as [processname] allows the related bulk
update temporary collections to be deleted when the bulk update BGPs are deleted, based on the [hours]
setting.

Manually deleting temporary collections is necessary when background processes have been manually
deleted. Select a temporary collection, on the Maintain menu, click 'Force Delete & Purge', and select one of
the following options:

'Purge collection contents' - removes the contents of the collection but does not remove the root node.

'Purge collection node' - removes the contents of the collection and also deletes the collection root node.
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Collection Considerations
Collections created from a search include a URL that identifies the search criteria. However, unlike other
URLs in STEP, a collection URL does not include settings like workspace or context.

To illustrate:

The URL for an object in the primary product hierarchy includes Context1 and workspace Main:
step://product?editor=Product&versionid=204372&contextid=Context1&id=235113&workspac
eid=Main

The URL for a search on a list of three IDs (18212, 18213, and 18216) but not the context or workspace:
step://search?args0.0=searchString%3d18212%0a18213%0a18216%2cuniqueKey%3dIDKey&searc
h0.0=IDListCriteria

The URL for a search on objects with a value of 'blue' for the COLOR attribute but not the context or
workspace:
step://search?args0.0=IncludeDataContainers%3dno%2csearchString%3dCOLOR%c2%a0%28COLO
R%29+%253D+blue%2cRegExp%3dno%2cMatchCase%3dno%2cIncludeInheritedValues%3dno%2cRecyc
leBinOnly%3dno&search0.0=ValueCriteria

Essentially, a collection created by a search operates as a saved search. The absence of the context and
workspace data in the 'Search URL' parameter allows the search to be rerun and a collection to be refreshed
on a different context / workspace. This also allows the results from a search collection to differ based on the
current settings. Understanding this flexibility can explain why results vary. Settings that can cause different
search results include, but are not limited to, workspace, context, dimension points, and privileges.

Important: The content of a collection created from a search displays the search results from the last time
the search was refreshed by using the Refresh option on the collection.

Workspaces and Collections Created from Search
Workspace is one setting that can cause the same collection created from a search to return different results.
To illustrate, consider a search that uses the 'Search from List' criterion with the IDs of three objects and that
was run from the Main workspace. None of the three objects are approved. The search is saved as a
collection.
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On the Tree tab, the collection displays the three objects, shows a count of 3 in the 'Estimated Amount of
Objects' parameter, and the 'Search URL' includes the list of IDs from the search.

© Stibo Systems - Internal - 2024.4 - December 2024 202



Changing the workspace to 'Approved' continues to display the same results since the collection has not yet
been refreshed.

Right-click the collection and select 'Refresh' to run the search with the current settings.
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The refreshed search in the 'ApprovedWorkspace' does not include any of the objects returned when
originally searched, which means the ThreeObjects collection in this workspace is empty.

To display the unapproved IDs again in the Main workspace, refresh the collection again with that workspace
selected.

Language-Dependent Search and Exports
Search results are dimension-dependent. A search in one context can display one set of objects while the
same search in another context can display a different set of objects.

Important: The recommended method that addresses dimension-dependency is to search on the
attribute ID with a wildcard (*) since it allows users to export results regardless of the context that the
search was performed in, or the context selected for export.

When searching and using collections with context-dependent data, consider the following:

Because the name of a language-dependent attribute can be different based on context, name is not a
reliable criterion for repeatable searches. Searching based on an attribute name can return unexpected
results depending on the selected context. Instead, use the 'Search from List' criterion with the ID option to
search on the object's ID, since the ID is the same regardless of the selected context or value changes.

For example, consider an attribute with name of 'Description' in the English context and the name of
'Descripción' in the Spanish context. In both contexts, the ID is the same. While in the Spanish context,
searching for attribute name of 'Description=100%*' returns zero results because the attribute name is
'Descripción' and no attribute name of 'Description' exists in the Spanish context. To find the intended
information, use the 'Search from List: ID' option, as defined in the Search: Search from List topic.

Important: Regardless of the context selected during search, the exported file includes data based on
the Context parameter on the Advanced step of the Export Manager. For details, refer to the Export
Manager - Advanced topic in the Data Exchange documentation.
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When exporting search results or exporting a collection made from search results, the context selected
when performing the search is used in the 'Displaying # of # results' list of objects found and the Export
Manager Advanced tab Context field determines which values are exported.

If a search or a collection from an Advanced Search is based on a language-dependent attribute's Name,
the export file is blank if the context selected in the Export Manager does not match the context selected
during the search or collection creation.

To export objects with their relevant language-dependent attribute values, regardless of the context in use
during search or collection creation, use the 'Search from List' criterion with the ID option from the dropdown
(as defined in the Search: Search from List topic). This ensures that the attribute values are identified by
object IDs which are the same for all contexts.

The example outlined below illustrates how creating a collection from search results can return different
objects, based on the dimension-dependent values in the context being searched.

This search is performed in the 'English US' context for the value 'Blue' in the 'COLOR (COLOR)' attribute.
The search finds three objects with the value.

One of those objects has a translated value of 'Azul' for the language dimension point in the 'Spanish MX'
context. The other objects have no value for the attribute.
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Performing the same search again in the 'Spanish MX' context returns no records since the value of 'Blue'
does not exist for any of the records in the searched context.
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Creating Collections
In workbench, collections can be created in two ways:

1. Using the Advanced Search tab, perform a search, and create a collection of the results

2. Using an import file, create a collection of the contents

Regardless of how they are created, if a collection contains fewer than 10,000 objects, these can be inspected
in the Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat
structure regardless of any parent-child relations that may exist between the objects, and regardless of the
parents and/or children the objects have when viewed elsewhere in STEP.

Note: This topic and the Collections section do not address Web UI functionality, however, to allow for the
best performance, the Web UI Collection Content Screen has the same 10,000 object restriction.

In Web UI, objects can be manually added to and removed from a collection. This functionality is not available
in the workbench.

Creating a Collection from Search
The most common way to create a collection is by creating a search. Refer to the Collection Considerations
topic for important information about how saved search results can changed based on the current settings.

To create a collection from search, follow the steps below.

1. Navigate to the Advanced Search tab, enter in the needed search criteria, and click Search to verify the
results. For more on how to search, refer to the Navigating and Searching topic in the Getting Started
documentation.

2. Click the 'Save as Collection' button.
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3. Select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a
collections group folder), enter a collection name (the ID is autogenerated), and click OK.

A background process runs, and the new collection is created and displays under the specified folder.
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4. As needed, right-click the collection and run a bulk update, or export the objects.

Note: The initial search criteria used to locate the included objects is stored on the collection, which
allows for later updates of the collection. To learn more about editing searches to update collections
refer to the Maintaining Collections topic.

Creating a Collection from File Import
Collections can be created from a text or CSV import file containing STEP IDs of products, assets, or
classifications. Objects in the import file must already exist as the import will not create or update objects, only
place them in a collection.

Important: If the import file includes only attribute values or unique keys of the products, assets, or
classifications to be added to the collection (and does not include the STEP ID), you must use the steps
defined in the Creating a Collection from Search section above.

To create a collection from a file:

1. In the Tree, right-click the Collections top node or a collection group to determine where the new collection
will be saved, and select 'Create Collection From File...'.
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2. In the 'Create Collection From File' dialog, locate the file that lists the IDs of the objects to be imported as a
collection.

Important: The file must not contain headers or any other data.
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3. While the 'Collection ID' is autogenerated, for the 'Collection Name' parameter, add a Name for the new
collection.

4. For the 'File Contains' parameter, select if the import file contains IDs of products, classifications, or
assets.

5. Click 'OK' to start a background process which will create the new collection.
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Creating Collection Groups
Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.

Creating a Collection Group
1. Depending on where you want the collection group to live, either right-click the top-level Collections node

or an existing collection group in Tree and select Create Collection Group....

2. In the 'Create Collection Group' dialog enter a Name (ID is autogenerated) for the new group.

3. ClickOK.
Once created, collection groups can be selected to hold new collections, or more collection groups can be
created under them. For more on how to create collections, refer to Creating Collections in this
documentation.
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Maintaining Collections
Collections can be a valuable tool for data maintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects
with data anomalies could be grouped in a collection via search criteria. Once the data is corrected, the
objects with updated information no longer meet the search criteria. Thus updating the collection
automatically removes any updated / fixed objects from the collection. In this way, only the objects that still
need to be fixed are displayed in the collection.

This topic addresses the various ways users can interact with and maintain collections.

Delete

Edit Search Criteria

Export Data Below

Refresh Data

Run Bulk Update

Republish

Search Below

Collections can also be maintained via the Web UI. For more information, refer to the Collection Content
Screen section of the Web User Interfaces documentation.

Delete
Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
They will still reside under their original nodes in Tree and System Setup. All collections and collection groups
below a collection group must be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placement in STEP as well. In this case, it would be best to just updated the collection through
proper maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and click Delete.
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Additionally collections and collection groups can also be deleted from the Maintain menu via the Delete
option.

For more on creating searches, refer to the Navigating and Searching documentation.

For more on how to use bulk updates, refer to the Bulk Updates documentation.

Edit Search Criteria
To edit a collection created from a search:

1. Right-click on the collection and click 'Edit Search Criteria'.
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2. On the Advanced Search tab, modify the original search criteria if necessary.

Alternatively, if a collection was created using a search criteria, the 'Search URL' displays in the collection's
Description section for the Search URL parameter. Copy and paste the URL into the workbench URL
parameter to display the Advanced Search tab with the search criteria and make adjustments if needed.
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For more information on searches, refer to the Navigating and Searching topic in the Getting Started
documentation.

Export Data Below
The Export Manager wizard allows a user to export data on demand and to create or modify an export
configuration.

1. If a user wishes to export all objects in the selected collection based on the selected format and the
mapped data, they can right-click on the collection and select Export Data Below.

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as
needed.

For more information on exporting, refer to the Creating a Data Export topic in the Data Exchange
documentation.
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Refresh Data
Only collections created from search results can be updated for the most up-to-date information and object
groupings, as objects in a collection that no longer meet the search criteria will be removed from the
collection. Refer to the Collection Considerations topic for important information about how saved search
results can changed based on the current settings.

To start a refresh in workbench, right-click on the collection and select 'Refresh'.

Note: The 'Refresh' option isOnly available if the collection is created from a search.

To start a refresh in Web UI, go to the collection content screen, select the desired collection, and click the
'Refresh collection' action.
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Note: For more on how to setup a refresh in Web UI, refer to the Scheduling a Collection Refresh in Web
UI topic in the Bulk Updates documentation.

Run Bulk Update
This option allows the user to interact with the objects in the collection in a number of ways. To name a few,
the objects could be submitted into a workflow, assigned to a user group, or have an attribute updated.

1. Right-click the desired collection and select Run Bulk Updates.

2. Complete the steps in the Bulk Update wizard to make the same updates to all objects in the collection.
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For more on how to use the bulk update wizard, and the various operations that can be applied to collections
or a group of collections, refer to the Bulk Updates documentation.

For information on how to schedule bulk updates for collections in Web UI, refer to the Scheduling a Collection
Refresh in Web UI topic in the Bulk Updates documentation.

Republish
The Republish action generates events on products, classifications, or assets in the collection. Common
setup is to use this option for on-demand creation of a republished event. For example, to generate events for
all objects in a collection that has never been published by an event queue.

For more information on events, refer to the Events topic in the System Setup documentation.

1. To republish an event, right-click on the desired collection and select 'Republish...'.

Note: Users must have the privilege to maintain event queues in order to use this action.
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2. Clicking the action launches a wizard where users can choose the appropriate event queue from the
dropdown menu.

3. Users can also enter in a Process Description to give a name to the background process, which can be
monitored in the 'Republish Node'.

Search Below
If a certain attribute on some of the items in the selected collection needed to be changed, a user could use
this to locate the items.

When a user right-clicks on a collection and clicks 'Search Below', it allows the user to search only the items in
that particular collection.
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Refer to the Navigating and Searching topic in the Getting Started documentation.
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Collection Properties and Statistics
Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can
provide a quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab
The Description and Statistics sections provide information about the selected collection. Below the sections
are described in more detail.

Description Section

This displays information about the collection:
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ID: Shows the collection ID, which is auto generated.
Name: Shows the name of the collection.
Estimated Amount of Objects: Displays the total number of objects in the collection based on the latest
'Refresh' of the collection. The count is not filtered according to Context / Workspace visibility, privilege
checks, or object types.
Search URL: Displays only on collections created from a search result. To review the search in the
Advanced Search tab, copy the 'Search URL' text and paste it into the URL field then press ENTER. It is
possible to edit the search if needed. For more on searching refer to the Navigating and Searching topics
in this documentation.
Last edited By: Displays the date, time, and user who last worked on the collection.

Statistics Section

The Statistics section gives an overview of which type of objects are included in the selected collection.
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In addition to breaking down the objects by type, it displays the exact number of objects in the entire collection
based on the latest 'Refresh' of the collection.

Note:While viewing the collection in Tree it may appear that there are fewer objects in the collection then
what is reported by the Estimated Amount of Objects field under the Description section or the total objects
reported under the Statistics section. This happens when objects are not approved for the current
workspace and therefore do not show or due to privileges.

Data Profile Tab
The Data Profile tab can display a dashboard to provide a graphical representation of the objects that are in
the collection. This can be modified based on the user's requirement.
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If a profile has never been created, a user can click on theGenerate Profile link to create the collection's
Dashboard.

If it has already been created, it is recommended to click the Update Profile link if it has not been updated
recently.
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For more information on how dashboards and data profiling work, refer to the Data Profiling documentation.

Log Tab
The Log displays details about the creation and modification of the collection, details about which user
performed what actions, and the number of objects in a collection when a collection is refreshed.
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Entities
This topic covers information specific to the Entity super type that is important to know when working with
entities. For general object maintenance information (applicable to all object types rather than specific to
entities), refer to the All Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used to model customer-
related data, such as contacts, addresses, markets, or customers, though they can be used for any number of
data modeling scenarios, including modeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only use description attributes, the application of
category-specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type
validity and all entity instances of a particular object type will have the same attributes available for population.
Additionally, entity handling is limited for publishing (e.g., as part of print publishing solutions as defined in the
Publisher (Adobe InDesign Integration) documentation), and you cannot translate entities using a background
process.

Entities may or may not be subject to approval, dependent upon the revisability settings (globally revisable
entities are the same in the Main and Approved workspaces, while workspace revisable entities adhere to
standard approval concepts). This provides a great deal of freedom in determining how entities are handled,
specifically in terms of how events are generated and processed. For more information, refer to the
Revisability on Entity Object Type section of the Getting Started documentation or the Events section of the
System Setup documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination
of a hierarchical display (with source displayed as child to target, or vice versa). In effect, this makes
classifications unnecessary for use with entities as entities can be classified via entities. Additional
information on this is available in the Entity Reference Types section of the System Setup documentation.

However, entities do retain the standard data modeling capabilities and provide even more configurability.
The Revisability parameter allows you to define an entity object type that does not have to be approved and
also determines how events are processed.

Entity Hierarchy
Any number of entity hierarchies can be added to any system. For example, you may set up address
hierarchies, customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as
part of the implementation process and will likely differ on each system. The following is an example of an
entity hierarchy.
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For more information on hierarchy setup, refer to the Object Types and Structures section of the System
Setup documentation.

Entity Editor
Once the entity hierarchy is created and description attributes are applied to the entity object types, the next
logical step is to start entering values.

Every entity editor includes a References, Referenced By, Status, State Log, and Tasks tab. The labels on
these tabs remains constant, while the label of the first tab differs based on the object type. Each is defined
below.

Note: Only description attributes can be applied to an entity object types and will appear in the entity
editor. Specification attributes are not allowed on entities.

Additional tabs may also be included based on other functionality or Component Models in use for the entity
object, such as Data Containers (as defined in the System Setup documentation), Matching, and Proof View.
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For example, the image above shows an entity modeled as an address. The entity object has several
description attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute
can be modified and maintained. Since this entity object type has been modeled to be globally revisable,
approval is not applicable. Therefore, the Approval Status field is not shown.

References
You can view associated references of an entity object by selecting the References tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an entity object will list valid references. In this tab it is possible to maintain
references from the selected entity to other objects.

Refer to Reference Types topic in the System Setup documentation for more information.

An entity can reference a number of different objects. It is possible to create:

Entity-to-Entity references

Entity-to-Product references

Entity-to-Classification references

Entity-to-Asset references

In the example below, one entity-to-entity reference type is valid on the selected entity object. Clicking the
plus sign (+) button opens an editor for selecting objects to be referenced. Alternatively, you can type the
name of an object in the target field and press Enter.

Targets can be unlinked by clicking the delete ( ) button.

Metadata attributes can be linked on the target reference in References tab.
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The attributes that are linked on to the target reference are editable once the target reference is linked to
the entity reference type as shown in the above screenshot.

For the meta attributes to be visible on target reference type, add the required description attributes under
the Valid Attributes section in System Setup under Reference Type.

Referenced By
Selecting the Referenced By tab on an entity displays valid Reference Types. In this tab, you can maintain
references from other objects to the entity. Refer to Reference Types in the System Setup documentation for
more information.
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An entity object can reference a number of different objects, including:

Product-to-Entity reference

Entity-to-Entity reference

Asset-to-Entity reference

Classification-to-Entity reference

In the example below, one entity-to-entity reference type is valid from an entity to the currently selected entity
object. Clicking the plus sign (+) button opens an editor to select objects that should reference the current
entity object. In the example, a reference from the 'Customer A' entity is made to the current entity object.

Metadata attributes can be linked on to the target reference in Referenced By tab.

The attributes that are linked on the target reference can be edited once the target reference is linked to
the entity reference type as shown in the above screenshot.

To display the meta attributes on target reference type, add the required description attributes under Valid
Attributes section of System Setup under the Reference Type. Refer to the References section above for
an image.

Status
A record of all the changes that have been made to a currently selected entity will be displayed. This record
will allow you to examine the user that made the change and when the change was made.
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You can purge past revisions or revert the old revisions. There is no Workspace, Translation, or Approval
Status sections since entities can be created as globally revisable, meaning they are the same in both the
Main and Approved workspaces.

However, Workspace, Translation, and Approval Status sections are displayed if an entity object type is
created as 'Workspace Revisable' as illustrated in the below images.
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Revisability on object type
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Status tab for a workspace revisable object

State Log
The State Log tab displays the history of the selected object across all workflows. If the object has ever been
in a workflow, a section is displayed per workflow and the history of transitions of the object within that
workflow can be viewed. Detailed information on the State Log tab is available in the State Log Tab topic in
the Workflows documentation.

Tasks
The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's
privileges (only tasks that the user has the rights to address are visible). When relevant tasks and privileges
are in place, the user is able to act on the tasks from this editor, including to edit data and move tasks through
the workflow. More information on the Tasks tab is available in the Moving Tasks through aWorkflow in
Workbench topic in the Workflows documentation.
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Products
This topic covers information specific to the 'product' super type that is important to know when working with
products. For general object maintenance information (applicable to all object types rather than specific to
products), refer to the Object Maintenance in the Tree Tab topic.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product
number, etc. In other words, any item that a company sells that can be ordered.

Product Hierarchy
The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy.
The product hierarchy consists solely of objects of the product super type. The product hierarchy is an
organized hierarchy where all products in the workbench are stored. This is also where products and product
attributes are linked. Although configurable, the product hierarchy is usually a multi-level hierarchy—each
level controlled by its own unique object type. Super users can control the naming convention(s) used to
categorize the products at their different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually
designed to take advantage of this capability, with objects classified according to similar characteristics. More
information on inheritance is available in the Inheritance in the Product Hierarchy topic.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete
objects are represented by cubes.
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All objects of the product super type must exist in the product hierarchy, and may exist only once (e.g., each
object can have only a single parent). The primary purpose of the product hierarchy is proper attribution of
products. That is, in the product hierarchy, products should be grouped according to their similar properties so
that inheritance of attributes, attribute values, and references can best be used. Based on this, it is evident
that the Product Hierarchy is not intended to be used for modeling website hierarchies or other taxonomies
(e.g., merchandising hierarchy, sales hierarchy, etc.) where an object can be represented multiple times.
When a product needs to "live" in more than one location, that can be accomplished using classification
hierarchies. In this case, the product continues to exist in the product hierarchy (and this is considered its true
place of residence). It is then linked into one or more classification hierarchies using references.

Product Editor
The Product Editor is displayed when an object of the product super type is selected in Tree.
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1. If the object has a primary image referenced, a thumbnail version of it displays. The reference type to be
used for the thumbnail display is controlled in System Settings (on the Users & Groups node). Additional
information on this is available in the Primary Image Type topic in the System Setup documentation.
Additional general information on references is available in the Reference and Link Types topic, also in the
System Setup documentation.

2. The Product tab (known as the Product Editor) is the primary interface for working with product objects in
the workbench.

3. The Description section displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in the Tree Tab topic. Some information displayed is common
for all implementations, while other information is specific to the data model and configuration of each
system.

4. Specification attributes are displayed in sections, with the section name matching the attribute group.
Sections can be expanded / collapsed. When attribute groups have sub-groups, configuration determines
whether the parent group or the child sub-group is displayed as the section name. This is set via the
'Product Editor, Group attributes by top group' parameter in System Settings (on the Users & Groups
node). Additional information on this is available in the Product Information Manager Default Settings topic
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in the System Setup documentation. More general information on attributes is available in the Attributes
topic, also in the System Setup documentation.

5. Attribute values can be edited by clicking into any editable field. Additional information on the various
editing options is available in the Editing Objects in the Tree Tab topic. By default, attributes are displayed
in alphabetical order within each section. However, if an attribute display sequence has been configured,
this overrides the alphabetical sorting. More information on attribute display sequence is available in the
Display Sequence Attribute topic in the System Setup documentation.

Additional Editors
Refer to the additional topics listed below for information on the other editors available on products.

Category Profile: Allows users to configure and view profiling data and dashboards for the objects under
the selected node. Refer to the Data Profiles topic in the Data Profiling documentation for more
information.
Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists
are often used to store pricing information. Refer to the Commercial Data section of the Publisher (Adobe
InDesign Integration) documentation for more information.
Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from
parental objects). Refer to the Images & Documents Tab topic within this guide for more information.
Product Variants: Allows the user to generate and manage a family of products, which are basically the
same, only varying on the values of a small sub-set of their attributes. For example, clothing and shoes
both offer good use cases for product variants as these items may come in multiple sizes and colors, but
are otherwise identical. The product family holds all data for the item (e.g., a particular shoe), while the
variants hold only the various combinations of the color and size varieties (e.g., size 7 red, size 8 blue,
etc.). The Product Variants tab is only displayed if the system has been configured to support variants. For
more information, refer to the Product Variants topic in the System Setup documentation.
Proof View: Allows users to preview a close representation of how a product will look when mounted onto
an InDesign page based on a selected publication version and product template. For more information,
refer to the Print Proof View section of the Publisher (Adobe InDesign Integration) documentation.
Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit
these references. Refer to the Referenced By Tab topic.
References: Allows users to view all objects that the current object references, and add / remove / edit
these references. Refer to the References Tab topic.
State Log: Allows users to view the recent history of the object across all workflows in which it has been
entered. Refer to the State Log Tab topic in the Workflows documentation for more information.
Status: Allows users to view basic information about the object, including revision history, translation
status, and approval status. Refer to the Status Tab topic for more information.
Sub Products: Allows users to view and edit all child objects of the selected object in a table format. Refer
to the Sub Products Tab topic for more information.
Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to
present consolidated data across multiple objects, such as object name, part number, and price. For more
information, refer to the Tables documentation.
Tasks: Displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in
place, the user is able to act on the tasks from this editor, including to edit data and move tasks through the
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workflow. More information is available in the Moving Tasks through aWorkflow in Workbench topic in the
Workflows documentation.
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Inheritance in the Product Hierarchy
Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the
child products that exist under the parent product can inherit the value - meaning that the value is present on
the child, as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the
value can be locally edited on the child (e.g., a different value supplied so the child no longer inherits the value
from the parent). Note that value inheritance also applies to references, meaning that if a reference is
populated on a parent, it is also available on the child in the same way as an attribute value. However,
references must be explicitly configured for inheritance to be in place, while attribute values will automatically
inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. This means that
attributes can be linked to specific nodes / categories so they only appear for those categories and their
children. For example, consider a company that manages data for both batteries and clothing. Size might be
applicable to both categories of objects since both batteries and apparel have sizes assigned. However,
sleeve length and voltage are characteristics applicable for clothing and batteries, respectively, and it could
be confusing to have a 'Voltage' attribute on a clothing item. To avoid this, the 'Voltage' attribute could be
linked to the 'Batteries' category, while the 'Sleeve Length' attribute could be linked to an 'Upper Body Apparel'
category.

Inheritance perpetuates throughout the hierarchy, no matter how many levels are present (e.g., inherited
attributes and values appear on children, grandchildren, etc.). When attributes are considered applicable to all
products, regardless of category, they are called 'global attributes'. For example, attributes such as Price,
Description, and Manufacturer Name. Thus, these attributes are linked to the top level in the product hierarchy
and are inherited down to all products beneath, no matter how many levels there are.

Attribute inheritance only means that the attributes are available for all of the products beneath where they are
linked. The process of linking attributes to different levels does not have anything to do with the actual values
that will go into the attributes for any particular product. In the 'Voltage' example, when linking that attribute,
you are only concerned with making that attribute available to all the battery products—not with the actual
voltage for any given product. However, if many batteries under a parent shared the same value, the value
could be populated on the parent to inherit down to the children. Any children varying from the parent value
could then be edited individually, while those having the same value as the parent do not need to be updated
further. Note that attribute inheritance within the product hierarchy is only available with specification
attributes, and is not available with description attributes. Further note that this topic focuses on inheritance
solely within the product hierarchy. However, it is important to be aware that attribute inheritance can also be
used within classification hierarchies that are used to organize product objects. Attributes can be linked to a
classification, making them available for all products linked into that classification (or a child classification).
More information on attribute inheritance with classifications is available in the Classifications topic within
this guide, and within the Attribute Links topic in the System Setup guide.
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Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a
level too high in the hierarchy. With such a setup, a single change could mean that thousands or millions of
products would have to be updated in downstream systems and many systems are not geared to handle
massive feeds like that.

When working with products and/or creating new products, users should be mindful of inheritance,
considering both the inheritance of the available attributes, as well as their specific values or references. It
may be helpful to consider the following:

Is the hierarchy granular enough to allow products within the category to be grouped so that all products
only have the relevant attributes, or are additional category levels required to obtain this granularity?
Which attributes are required for the products in the category and/or subcategories?
If product variants are used, which attributes should be maintained at the family level and which ones
should be maintained at the variant level?

Note: Data can also inherit from dimensions (e.g., language or country). More information on this is
available in the Dimension Dependent Data section of the Contexts topic in System Setup.

Linking Attributes to Products
To make attributes valid for products, they must be linked to the appropriate tree nodes in the product
hierarchy. Some attributes will be global attributes (applicable to all objects in the product hierarchy) and are
linked to the “Product Hierarchy” root node. These global attributes are then valid for all products. Other
attributes apply only to specific categories of objects, and are then linked directly to those categories, making
them available for all objects within that category (if also set as valid for those object types). Attributes should
not be linked to individual leaf objects, as each one would have to have the link individually applied. Instead,
attributes should be linked to some parental folder in the hierarchy above the objects needing to use the
attribute.

Before proceeding, be aware of the following:

Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes are made available for the children "under" the node at which they are
linked (being mindful that "under" means "actual children" in the product hierarchy, whereas it means
"objects with a reference to" when dealing with classifications).
Linked attributes apply only to objects of the product super type. For example, linking attributes to a
classification object that holds assets does not make those attributes available on the child assets.
Only Specification attributes can be linked to products or classifications. Description attributes cannot be
linked attributes.

Linking Attributes

1. Select the product group or classification and click the References tab.
2. Expand the appropriate flipper (Linked Attributes from Product Hierarchyon product objects or

Attributes on classification objects), then click Link to Attribute.
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3. In the standard search / browse window that displays, locate the appropriate attribute(s) and click Select.

Localizing an Attribute Link

Local attribute links can be created to override inherited attribute links.

1. Select any existing inherited attribute link and right-click on the row indicator.
2. Select the Create Local Link option.
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This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the same way as inherited links, though removing a local link re-applies the inherited link.

Unlinking a Linked Attribute

Unlinking an attribute does not delete the attribute from STEP; it removes the link so the attribute is no longer
available for population on the selected node (and child nodes, if applicable). Note that attribute links must be
removed from the same node to which they were added. In other words, trying to remove an inherited attribute
link is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it
must be removed on the parental object that holds the link. However, care should be taken in doing this as it
will remove the link for all child groups, and will need to be re-linked at those lower child levels if it is still
needed there.

1. On the References tab of the object, expand the appropriate flipper (Linked Attributes from Product
Hierarchy on product objects or Attributes on classification objects).

2. Right-click on the row indicator and select Remove Link to Attribute from the context menu (or use Ctrl +
“-”). Multiple attributes can be unlinked simultaneously by multi-selecting.

Note: If an attribute has been linked locally, removing the link only removes the local link, and the
inherited link will again take effect.

Additional methods for maintaining attributes links

Attribute links can be added and removed in a number of ways, in addition to what has been described above.
These include:
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References tab of the attribute itself
Maintainmenu, then Linkmenu when a product or classification is selected
Editmenu, then Link to Attribute / Remove Link to Attributemenu when a product or classification is
selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values
There are many advantages to setting common values:

When an update is needed, the value is only entered once in the product group instead of – potentially –
separately, across hundreds of products.
When new products are added to the group, they automatically inherit the product group’s values.
The translation of product group values only need to be performed once, as opposed to translating the
same value every time for individual products.

As mentioned above, it is possible to set attribute values for an individual product, but consider a situation
where all products within a product group share common attribute values. For example, a set of hats that
share a common description and features.

There are two ways to approach this: 1) keep all common values with the individual product or 2) set the
common value at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the
attribute value is inherited down to all products beneath.

The image above shows three inherited values, which are designated by a green down arrow ( ).

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products
beneath will inherit the same value.
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It is possible to override an inherited value by setting a different value at any subordinate level, e.g., the
product level. This is called a localized value. However, this requires that the attribute be valid for the child
object type (as is the case for the inherited values shown in the screenshot above). Attributes that display as
inherited (indicated by the green arrow) but not editable (e.g., value field is yellow rather than white) are not
valid for the object, so they can only have a common value with all sibling products, which is inherited from a
parent higher in the hierarchy. Detailed information on setting validity of attributes is available in the Validity
on Specification Attributes topic in System Setup.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental
value. Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object
has the null value).

For information on working with and/or setting up inherited reference values, refer to the Inheritance
Example for a Reference section of System Setup.
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Images & Documents Tab
When working with products, the Images & Documents tab displays thumbnails of all assets that are
referenced by the selected product, or inherited from a parental object referencing the asset. When working
with classifications, this tab displays all assets that are child to the selected classification. The functionality for
working with the displayed assets is the same, regardless of whether a product or classification has been
selected.

If more than 50 assets are present, the Next / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially
useful when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size,
file size, and reference type used to link the asset to the selected object.

Interacting with Assets
From the Images & Documents tab, several actions can be taken with the displayed assets.

Edit asset

By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image
to a disk or local PC, and view the image on a larger scale.
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Edit reference type

The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdown will be disabled (grayed out) if there is only one valid reference between the object
type and asset type. If multiple valid reference types are available, selection of the reference type is enabled
and can be edited from this location. More information on references is available in the Reference and Link
Types topic in the System Setup documentation.

Filter the displayed assets

A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays
assets that have the entered value as part of the asset name, as shown below.

Note: The filter automatically applies wildcard functionality so explicit entry of wildcards (*) is not needed.
Entering an asterisk will cause the system to search for assets with an asterisk in their name.
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To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset

The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates
directly to the asset in the classification structure.
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Product Overrides
Product overrides are alternate versions of products and product families that may have differing values,
references, links, and structures. Attributes and values applied to the product family are inherited to the
product override and can be replaced with local values and references on the product override. Product
overrides allow product objects to exist in multiple locations in the product hierarchy and are the primary
building blocks for many print product presentations. A product override allows for the creation of 'pseudo'
product families that are flexible to ever-changing print presentations. They can be thought of as a
workaround for when an existing product family does not contain the exact products needed for a publication
layout and/or its accompanying STEP table(s).

A product override folder can include products from various "standard" (e.g., non-override) product families.
Similarly, a product override leaf object can live under a different product folder (override or standard) than the
folder in which its corresponding standard object resides.

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from
standard products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and
references of a product / product family. This is useful in order to publish a limited version of a product family
without modifying the object itself.
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Example

In this example a product family Ski Jacket Pro has three products. A product override 104061 is created and
based on the product family Ski Jacket Pro. Attributes, values, and references are inherited from the product
family Ski Jacket Pro to the product override folder and can be replaced with local values and references on
the product override.

Two products from the product family Ski Jacket Pro are linked into the product override folder (SKU 00001
and SKU 00002). The product override only contains a subset of the products included in the original product
family Ski Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked
into the product override. These products will have their values inherited from their original structure
instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow icon ( ), if an
attribute or reference is inherited from an overridden product. Inherited values and references can be
replaced with local versions, assuming the relevant attribute and/or reference is valid on the relevant product
override object type.

Creating a Product Override

1. In Tree, select an object for which an override should be created.
2. Right-Click and select New Product-Override
3. In the Create Product-Override dialog,

Click an Object Type
Key in ID and Name
Optional: Click the ellipsis button ( ) to select a product family to adapt values, references, and links
from. The product-override will inherit all values, references, and links from the selected product family.
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Optional: Click 'Adopt Children' if the product-override should also include all products from the
overridden product family.

4. Press Create to create the product-override.

Linking Products into a Product Override

1. In Tree, select the product override
2. Right-click the product override and select Add Children to Override
3. Search or Browse for the products to be linked into the product override

Removing Products from the Product Override

1. In Tree, select the product override
2. Expand the product override and select the product to be removed
3. Right-click and select Remove Child from Override

Creating a Subordinate Product Override

1. In Tree, select the product override
2. Select a product linked into the product override
3. Right-click the product and click Convert to Product-Override
The product will be converted into a product override. Values, references, and links will get inherited from the
overridden product. 
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Referenced By Tab
The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects
that the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place).
In addition, if the object is used by product overrides, has a match code acting on it, or is used by any
publication, that information can be viewed on this tab. Finally, privileges assigned to the product can be
added and edited from this location, and subproducts that are present only in other contexts can be viewed (if
the object is of a dimension-dependent object type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a source for the
reference, and a reference will be created from the object selected in the dialog to the currently selected
object that you are standing on (e.g., current object = target, dialog selection = source). If any attributes are
available on the reference and editable, they can be edited within this interface. References can be
removed by clicking the (X) on any existing reference. Additional information on configuring and working
with references is available in the Reference and Link Types topic in the System Setup documentation.
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2. Referenced by Products, Classifications or Entities: The functionality is identical to what is described
for the Reference Flippers section above. The only difference is that this area displays references that
have not been placed in attribute groups for display purposes.

3. Used By Product Overrides: Displays product override objects that are based on the selected object.
More information on product overrides is available in the Product Overrides topic in this guide.

4. Linked into Product Overrides: Displays product override objects that have the selected object as a
child. More information on product overrides is available in the Product Overrides topic in this guide.

5. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the
match code will display. For example:

More information on match codes is available in theMatching, Linking, and Merging documentation.

6. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publisher (Adobe InDesign Integration) documentation.

7. Applied Privileges: Displays the privileges that have been applied to the selected node. Privileges can be
added using the Add Privilege link, and can be removed by clicking on the row indicator and selecting
'Remove Privilege'. Existing privileges cannot be edited from this interface. Detailed information on
creating and editing privileges is available in the Privilege Rules section of the System Setup guide.

8. Visible Sub-Products in Other Contexts: Displays subproducts that are visible in another context,
which is only applicable if the object type is dimension-dependent. Note that it is not recommended to
make product object types dimension-dependent; instead, it should only be data on objects (e.g.,
attributes and references) that are dimension-dependent. As a result, this flipper is rarely used.
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References Tab
The References tab is where all references of which the selected object is the source can be viewed and
edited (assuming proper privileges are in place). In addition, if the object has associated index words, is used
by any publication, or has any linked attributes, that information can be viewed and edited on this tab.

The display of the References tab on a product will vary slightly from system to system, based on the data
model.
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1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a target for the
reference, and a reference will be created from the currently selected object to the object selected in the
dialog (e.g., current object = source, dialog selection = target). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the
(X) on any existing reference. Additional information on configuring and working with references is
available in the Reference and Link Types topic in the System Setup.

2. Ungrouped References: The functionality is identical to what is described for the Reference Flippers
section above. The only difference is that this area displays references that have not been placed in
attribute groups for display purposes. If all references that are valid for the selected object have been
placed in attribute groups, the Ungrouped Classification Links and Ungrouped Product References
flippers will not be present.

3. Index Words: Allows users to view index words linked to the currently selected object, and to link index
words using the Add Index Words link. Index words are maintained in a dedicated hierarchy where it is
possible to maintain the word itself along with a sort word. More information is available in the Creating an
Index Words Structure topic in the Publisher (Adobe InDesign Integration) documentation.

4. Publications: Publications that the currently selected product is linked to are displayed, and new links can
be created using the Link to Publication or Section link. Additional information about working with
publications is available in the Publisher (Adobe InDesign Integration) documentation.

5. Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental
node in the hierarchy display under the Linked Attributes from Product Hierarchy flipper. The exact
columns available will depend on the data model and the attributes that have been made valid on product
attribute links. Whether or not the various attributes are editable will also depend on the setup of the data
model. However, an ID and Name field are always shown, with the attribute name being a hyperlink that
can be used to navigate directly to the attribute. An Attribute Groups column is also present, displaying the
attribute group(s) that the attribute is in. A Mandatory column is present and if checked, the object cannot
be approved until a value has been provided for the attribute. Note that mandatory settings on the attribute
itself apply globally, while mandatory settings on the attribute link apply only to objects that are child of the
node at which the attribute is linked. More information on mandatory settings is available in the Mandatory
Attributes topic in the System Setup. If the attribute link is inherited (indicated by a green down arrow, , in
the row indicator), the 'Inherited from' column will display the parental node where the attribute has been
linked, which is hyperlinked for easy navigation. More information on linked attributes is available in the
Inheritance in the Product Hierarchy topic within this guide and in the Attribute Links topic in the System
Setup.
The Linked Attributes from Classification Hierarchy flipper is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is a member
of (e.g., has a reference to), rather than attributes that are linked to a parental product. The same
considerations apply in that the exact columns available will vary based on the data model, with ID, Name,
Attribute Groups, and Mandatory columns always being present and functioning in the same way as for
product attribute links. Note that objects shown in the 'Inherited from' column in this case are parental
objects not of the selected object itself, but instead of a classification that is parent to the classification that
the selected object references.
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Status Tab
The Status Tab provides general information about objects, including revisions, translation status, and
approval status. For products and classifications, the Status tab displays the same information, regardless of
the object type. Publications, attributes, entities, and assets have slightly different information available,
though much of it is common to what is described below.

© Stibo Systems - Internal - 2024.4 - December 2024 257



1. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a
historical "snapshot" of an object. The Revisions flipper provides a record of the revisions that have been
made to the currently selected object, including when changes to the object were made and who made
them. Via right-click, users are able to purge old revisions or revert to previous revisions. For more
information on revisions, including how they are generated and how they should be managed, refer to the
Revisions topic in the System Setup documentation.

2. Workspaces: All the workspaces that the selected products are in will display, as well as the revision
number that exists in that workspace. Generally speaking, if the object has been edited since it was
approved, the Main and Approved workspaces will hold different revisions. However, it should be noted
that not all changes to an object generate a revision. More information on this is available in the Revisions
topic in the System Setup documentation. For more information on workspaces in general, refer to the
Workspaces topic in the System Setup documentation.

3. Translation: Translation relations (sources and targets) and status (e.g., Up to date, Re-translation
needed, etc) of the translations display. For more information, refer to the Translations documentation.

4. Approval status in all contexts: Displays the approval status of the object in each context on the
system. More information on approvals is available in the Approval of Objects topic in theGetting
Started documentation. More information on contexts is available in the Contexts topic in the System
Setup documentation.

5. Hidden values: Displays hidden inherited values on the object. Hidden values are those that are inherited
from another dimension (e.g., language or country) rather than from a parental object. More information on
this is available in the Dimension Dependent Data section of the Contexts topic in the System Setup
documentation.

6. Diagnostics: Displays any issues with the object found by system diagnostics. If a problem has been
found, the information can be copied by clicking the file link.
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Sub Products Tab
When the Sub Products tab is accessed on an object of the product super type, all direct children of the
selected node are displayed. If privileges allow, data can be edited on the displayed objects by clicking
directly into any editable field. Standard editing capabilities are available within this interface (as described in
the Editing Objects in the Tree Tab topic within this guide) including copy / paste functionality using Ctrl + C
and Ctrl + V.

Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal,
and Mark Different selections - all of which are self-explanatory and can be especially useful when editing
multiple objects.
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Note that two views are available using the Rotate Table option. As shown above, the view can be organized
to have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis.
Also note that right-clicking within the header field exposes different options than within the data fields,
including an option to add a product.

Selecting Add Product opens a Create Product dialog allowing the user to input data to create a new object,
which will be added as a child to the currently selected node. The options available in the dialog are based on
the data model defined in System Setup. For example, the object type selection will vary based on the
allowable object types under the selected parent, and ID will only be available for population if the object type
being created does not have autogenerated IDs applied.

Note: The same functionality is available using the Add Product link at the bottom of the Sub Products
editor.
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Recycle Bin for the Tree Tab
Objects in the Tree tab Recycle Bin have been deleted from the Tree tab. For information on deleting objects
from the Tree, refer to the Deleting Objects in the Tree Tab topic.

For information on the System Setup Recycle Bin, refer to the Recycle Bin for System Setup topic in the
System Setup documentation.

Considerations

Objects in the recycle bins are not included when searching from the Advanced Search tab, nor from
Search. Recycle bin objects can be searched using the Search in recycle bin option defined below.

Attribute values of objects in the recycle bins cannot be edited. If editing is required, the object must be
revived.

In the Web UI, displaying an object that is in the Recycle Bin displays recycle bin images in the background,
as shown in the image below to indicate it is no longer in the primary product hierarchy. Viewing objects in the
Recycle Bin is allowed when the 'Show Recycle' parameter is checked in the Web UI Tree Navigator
component. For more information, refer to the Tree Navigator Component for Global Navigation Panel topic in
the Web User Interfaces documentation.

To remove the recycle bin background, follow the Resolving Deleted Objects steps below to revive the object,
or permanently delete the object to remove it from displaying in Web UI.
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Resolving Deleted Objects
Deleted objects in the Tree Recycle Bin can be managed as a group from the Recycle Bin node or
individually.

The Tree Recycle Bin can include workspace revisable objects (those that allow approval) which are flagged
with 'in Use' if they are in the Approved workspace and flagged with 'Not In Use' when they have not been
approved. For details, refer to the 'In Use and Not In Use Objects' section of the Approval of Objects topic.

Group actions

To address all objects in the Tree Recycle Bin, right-click the Recycle Bin node and choose one of the
available options described below:
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Search in recycle bin searches for deleted objects in this recycle bin. In Oracle-based systems, by
default this includes both ID and Name, while the default for Cassandra-based systems is by ID but allows
searching Name via an Advanced option.

The options in the Advanced section vary based on the type of database in use.

Cassandra Database Options Oracle Database Options

Match Case on Names – when checked,
capitalization provided in the search field for an
object must exactly match the name.

Match Case on Names and Values – when
checked, capitalization provided in the search
field for an object must exactly match the name
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Cassandra Database Options Oracle Database Options

Include Names (can be time consuming) – when
checked, searches for matches on name and ID;
when not checked, only IDs are searched.

Regular Expression – when checked, search is
based on the RegEx provided.

or value.

Include Inherited Values – when checked,
inherited values are also searched.

Exclude values – when checked, values are
not searched.

Regular Expression – when checked, search
is based on the RegEx provided.

Include Data Containers – when checked,
values in data containers are searched.

Empty Recycle Bin attempts to permanently delete all objects flagged with 'Not in Use' in this recycle bin.
Workspace revisable objects are flagged as 'in Use' when Approve Deletion is required, or events /
references exist for the object. The 'in Use' setting prevents the object from being removed. Resolve the
reported errors or consider the Force Empty Recycle Bin option for test systems, as defined below.

On the Confirm Purge dialog, the Skip Analysis button is enabled while counting the number of objects in
the recycle bin. Review the object counts and click Purge to delete them or click Cancel to close without
changing the recycle bin.

Empty Recycle Bin Before permanently deletes only contents deleted before the specified date and
time. For workspace revisable objects, approval of the deletion is required before removal is allowed.

On the Empty Recycle Bin Options dialog, click the ellipsis button ( ) to display the Date Picker and set
the date and time. ClickOK to close each dialog and perform the purge.
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On the Confirm Purge dialog, the Skip Analysis button is enabled while counting the number of objects in
the recycle bin. Review the object counts and click Purge to delete them or click Cancel to close without
changing the recycle bin.

Force Empty Recycle Bin is not recommended for production data since it ignores deletion approvals,
events, and references and purges objects with an 'in Use' status. This option is intended to remove test
data with fewer steps required when ignoring dependencies is not an issue.

Schedule Empty Recycle Bin allows scheduling recycle bin maintenance, as defined in the Schedule
Empty Recycle Bin topic.

Approve Deletion Recursively attempts to remove the selected object and its children from the
Approved workspace, generates a DELETEAPPROVAL event for the objects, and attempts to run the
Approve Deletion action. This option is valid only for workspace revisable objects (those that allow
approval) that are flagged as 'in Use.'
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If the Approve Deletion Recursively BGP cannot be completed successfully (for example, due to existing
references), the Force Approve Deletion button is displayed in the Approve Deletion BGP execution
report. The Force Approve Deletion button deletes and approves deletion of objects identified in the
execution report with the 'Approve error report' text. A DELETEAPPROVAL event is generated for the
deleted referenced objects.

Important: The 'Force Approve Deletion' button can affect live objects in the Approved workspace
since references may be removed to allow the deletion and approval to succeed.

Individual object actions

To address one or more selected objects in the Tree Recycle Bin, right-click the object(s) and choose one of
the options described below. The options available vary based on the object selected.

Note: If relevant, use group actions as defined in the previous section since they perform better than
individual object actions.

Purge permanently deletes the object if flagged with 'Not in Use' in this recycle bin, with no subsequent
option for revival. Workspace revisable objects are flagged as 'in Use' when Approve Deletion is required,
or events / references exist for the object. The 'in Use' setting prevents the object from being removed. The
number of warnings reported are limited to 100 of each type with a summary of errors at the end of the
background process, but that number can be changed via the case-sensitive
Purge.MaxNumberOfWarnings property. To remove objects from the Recycle Bin on a schedule, refer to
the Schedule Empty Recycle Bin topic.
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Force Delete & Purge removes an object regardless of deletion approvals, events, and references. Using
this option without first approving the deletion does NOT generate a DELETEAPPROVAL event. If deletion
events are required for downstream systems, first approve the deletion (defined below) and then purge the
object (defined above). For more information on events, refer to Events in the System Setup
documentation. A similar version of this option that excludes the recycle bin is available from the Maintain
Menu, as defined in the Maintain Menu topic.

If the Recycle Bin and Object Purge BGP ends with errors, the Force Purge button is displayed in the
Result section on the BGP execution report. The Force Purge button deletes references to objects being
deleted and they are not restored if the object is revived.

Approve Deletion removes the selected object from the Approved workspace and generates a
DELETEAPPROVAL event for the object. For workspace revisable objects only (those that allow
approval), objects are flagged with 'In Use' if they are in the Approved workspace and 'Not In Use' when
they have not been approved. For more information, refer to the 'In Use and Not In Use Objects' section in
the Approval of Objects topic of the Getting Started documentation.

Approve Deletion Recursively attempts to remove the selected object and its children from the
Approved workspace, generates a DELETEAPPROVAL event for the objects, and attempts to run the
Approve Deletion action. This option is valid only for workspace revisable objects (those that allow
approval) that are flagged as 'in Use.'

If the Approve Deletion Recursively BGP cannot be completed successfully (for example, due to existing
references), the Force Approve Deletion button is displayed in the Result section of the BGP execution
report. The Force Approve Deletion button deletes and approves deletion of objects identified in the
execution report with the 'Approve error report' text. A DELETEAPPROVAL event is generated for the
deleted referenced objects.

Important: The 'Force Approve Deletion' button can affect live objects in the Approved workspace
since references may be removed to allow the deletion and approval to succeed.

Revive restores the selected object, and based on dependencies, returns it to the location in the Tree from
which it was deleted. Objects are not always revived exactly as they were prior to deletion, for example, if
an object had references to other objects which have subsequently been deleted, those references are not
present upon revival.

When a reference for an approved object is deleted from the main workspace, the reference metadata is
retained (although not displayed). This enables the metadata to be revived when that reference is revived
from the Tree recycle bin or when the same reference type is recreated. For example, a reference is
deleted from an approved object but not purged from the recycle bin. Subsequently, a reference with the
same source and target is created via an import. Since this 'new' reference for the object matches the
deleted one, it is actually revived from the recycle bin. In this example, the previously deleted reference
and its metadata attribute values are restored.

In rare cases where an object is revived but its previous parent has been purged, a temporary parent folder
is added to the Tree with the expectation that a user will change the parent folder to a more appropriate
location in the active hierarchy.
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Revive Recursively restores the selected object, and based on dependencies, returns it and all child
objects to their previous location in the Tree tab. Objects are not always revived exactly as they were prior
to deletion, for example, if an object had references to other objects which have subsequently been
deleted, those references are not present upon revival.

When a reference for an approved object is deleted from the main workspace, the reference metadata is
retained (although not displayed). This enables the metadata to be revived when that reference is revived
from the Tree recycle bin or when the same reference type is recreated. For example, a reference is
deleted from an approved object but not purged from the recycle bin. Subsequently, a reference with the
same source and target is created via an import. Since this 'new' reference for the object matches the
deleted one, it is actually revived from the recycle bin. In this example, the previously deleted reference
and its metadata attribute values are restored.
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Schedule Empty Recycle Bin
Objects within the Tree Recycle Bin can be automatically deleted and/or purged on a scheduled basis by
using the 'Schedule Empty Recycle Bin' feature. Recycle Bin emptying scheduling is similar to scheduling
other processes in STEP (e.g., data imports, data exports, and bulk updates). The ability to schedule Recycle
Bin emptying at designated times (e.g., overnight) frees users from time-consuming, manual tasks to empty
the Recycle Bin, and allows the Recycle Bin to be regularly emptied with minimal or no user intervention.

The recommendation is to schedule emptying the recycle bin at least monthly and to include all contexts in
use. The 'Data cleanup tools' healthcheck (defined in the Healthcheck Test Index topic of the
Administration Portal documentation) identifies when no schedule exists for emptying the recycle bin, or if
the schedule is not as recommended.

Note: Scheduling is not available for the System Setup Recycle Bin since large numbers of objects are not
generally deleted routinely from System Setup. For more information on the System Setup Recycle Bin,
refer to the Recycle Bin for System Setup topic in System Setup documentation.

Configuration
To set a schedule for emptying the Tree Recycle Bin:

1. Right-click the Recycle Bin in Tree and select Schedule Empty Recycle Bin to display the Schedule
Empty Recycle Bin wizard.

2. On the Delete Options step, set the following parameters:
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Delete objects after __ days in the Recycle Bin: Enter the number of days that an object must be in
the Recycle Bin before it is deleted. The default retention time value is 7. This means that process will
only remove objects from the Recycle Bin that have been approve deleted for at least 7 days or
whatever you have set the retention time to be.

Refer to the next bullet for additional Approve Deletion considerations.

Approve Deletion: Select this option to remove objects and their children from the Approved
workspace, which sends a DELETEAPPROVAL event.

Considerations

The 'Approve Deletion' parameter is not affected by the value provided in the 'Delete objects after _
_ days...' parameter. As a result, when the Schedule Empty Recycle Bin operation runs, if 'Approve
Deletion' is selected, all objects in the Recycle Bin are removed from the Approved workspace,
even if they have not been in the Recycle Bin for the specified number of days.

When an object is removed from the Approved workspace via 'Approve Deletion,' a
DELETEAPPROVAL event is generated for that object. However, if the object is subsequently
purged from the Recycle Bin as part of the same Schedule Empty Recycle Bin operation, the event
is also deleted, since the object that the event is related to no longer exists in the system.

Therefore, if an event-based OIEP is set up to be triggered on DELETEAPPROVAL events, it is
recommended to schedule this OIEP to start at more frequent intervals than the Schedule Empty
Recycle Bin process, since the DELETEAPPROVAL event may disappear before the OIEP is
invoked. For example, schedule the OIEP to start every minute and configure the Schedule Empty
Recycle Bin process to run once a week.

Force Purge: Select this option to attempt to forcefully delete objects from the Recycle Bin that cannot
be deleted via the standard Empty Recycle Bin operation. For example, with this option, objects in the
Approved workspace can potentially be force purged from the Recycle Bin without having first been
removed from the Approved workspace through Approve Deletion.
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Note: To use the Force Purge option, the user who configures the Schedule Empty Recycle Bin
process must have the 'Force Delete and Purge' setup action included in their user privileges. For
more information, refer to the Setup Actions and Error Descriptions topic in the System Setup
documentation.

Click the Next button.

3. On the Select Contexts step, move the contexts from which to delete objects to the Selected list. It is
recommended to include all contexts to ensure complete deletion of data. Click the Next button.

Note: In the rare instance that additional workspaces other than Main and Approved exist on your
STEP instance, this step is named 'Select Workspace and Context' and a list of additional workspaces
is displayed at the top of the wizard screen. Click the checkbox next to each workspace that you want to
select.

4. On the Scheduled Execution step, determine when and how often to empty the Recycle Bin. Click the Next
button.
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5. On the Name Process step, name the batch process for easy identification, and click the Finish button to
complete the setup.

Scheduled Empty Recycle Bin processes are stored on the BG Processes tab (using the batch process name
defined) under the Scheduled Processes node within Queued Processes. They display a status of 'waiting'
and can be edited by clicking the 'Edit' button in the Status row.
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Example

This is one example of how Schedule Empty Recycle Bin works: 

You have an object that has been sitting in the Recycle Bin for the default 7 days, but you have not approve
deleted the item and you run 'Schedule Empty Recycle Bin' now with retention time of 1 day. The object will
first be approve deleted, but it will not be removed from the Recycle Bin since it has only just now been
approve deleted. If you then run 'Schedule Empty Recycle Bin' after, for example, 2 days, then that object will
be removed from the Recycle Bin if it is 'Not in Use' and if last edit date is more than one day in the past. You
can locate that information for an object as shown below:
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Navigating and Searching
This section describes the many different ways you can access specific data in the workbench. STEP
Workbench offers rich functionality for finding both System Setup and Tree objects based on various criteria.
Whether it be by standard navigation, bookmarks, searches using basic, advanced, or drill-down functionality,
STEP provides many ways to locate the required data.

This section includes:

Navigate hierarchies

Find data quickly using the 'Search' function

Find data using 'Advanced Search' function

Perform drill-down searches using the 'Search Result Profiling' page

Use standard bookmarks and 'Search Bookmarks'

Note: Objects within the Recycle Bin are not searched and will not display in search results.

For information on search functionality in the Web UI, refer to the HomepageWidgets topic and the Advanced
Search topic in the Web User Interfaces documentation.
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Navigation
You can navigate the STEP tree structures in the same manner as you navigate Windows folder structures,
following basic desktop computer skills.

Expanding a Folder
Use one of the following methods to display the contents of a folder: 

Click the right arrow ( ) to the left of a folder

Double-click a folder

Collapsing a Folder
Use one of the following methods to hide the contents of a folder: 

Click the down arrow ( ) to the left of a folder

Double-click a folder

Collapse Tree
When any folders in the Tree hierarchy are expanded (item 1), all can be collapsed by using the 'Collapse
Tree' option from the 'View' menu (items 2 and 3). All expanded folder are collapsed (item 4).
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Note: A folder with too many sub nodes displays an x ( ) instead of an arrow and cannot be expanded in
the hierarchy. To view objects beneath such folders, use the Advanced Search Tab or Search
functionality.

Collapse and Expand Items on the STEP Workflow Tab
When on the STEPWorkflow tab, click the right arrow ( ) to expand a section and displays the states for the
relevant process. Click the down arrow ( ) to collapse a section.
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Search
The Search functionality allows the user to locate an object in STEP in a quick and efficient manner. In the
Search field, type the Name, ID, or Key of an object and press Enter or click the 'Go to next object' button ( ).
A single object matching the search displays.

Additional functionality includes:

Use Ctrl+G to go to the Search field.

Use the ID/Name dropdown to select an existing Key and search for a value. Refer to the 'Keys in the
Search function dropdown' section below.

When multiple results match the search, click or Ctrl+E to display the next result.

When you start typing in the Search field, suggested objects that match the text are displayed in a dropdown
as shown below.

All types of objects are searched including classifications, assets, attributes, user names, etc.

Consider the following while searching:

Object IDs and Names are both searched.

Object IDs are searched case-sensitive.

Object Names are searched case-insensitive.

Wild Cards are not allowed.

For multiple results, a maximum of 20 items are displayed. Items can be selected from the menu using either
the mouse or the up arrow and down arrow keys on the keyboard.
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Search options are also available on the Navigate menu.

Keys in the Search function dropdown

The ID/Name dropdown list displays all activated unique keys. Refer to the Creating and Deleting Keys topic
in the System Setup documentation.

Select an active key from this dropdown to identify and delete objects, parents, referenced objects, and
assets. The system displays the object that has the unique key value.

Setting the Primary Hierarchy for searches

A user can set the 'Primary Hierarchy' to be either a primary product hierarchy, classification folder, asset
folder, etc., through the View menu Primary Hierarchy option. Once the primary hierarchy is selected and an
object is searched, first priority is given to the folder that is selected and then the other folders are searched.
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For example, if the Primary Hierarchy is set to Assets, the product will first be searched under assets. Then
clicking on Search again, the user is shown in the actual hierarchy where the product was initially created.
Typically, by default, the object will be searched in the actual hierarchy where it was initially created.

Important: Objects within the Recycle Bin are not searched as part of the Search functionality.
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Bookmarks
Bookmarks are placeholders created by the user that serves as a shortcut for previously viewed objects.

The following types of bookmarks exist:

Standard Navigation Bookmarks

Search Bookmarks

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP
from a different computer.

Standard Navigation Bookmarks
Standard navigation bookmarks are used for quickly accessing specific nodes in the Tree and System Setup
hierarchies.

You can add a standard navigation bookmark by selecting a node in the hierarchy and clicking Add
Bookmark in the Navigate: Bookmarksmenu or alternately by using the Ctrl+D keyboard shortcut. The
bookmark will afterward be accessible in the left side Bookmarks tab.

Search Bookmarks
Search Bookmarks are used for storing specific searches that can then easily be re-run.

To add a search bookmark:

1. Create a search criteria in the Advanced Search tab.
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2. From the Navigate menu, select Bookmarks and click 'Add Search Bookmark'.

3. On the Enter Bookmark Name dialog, type in the bookmark name and click the OK button.

Accessing the Saved Search Bookmark
Search bookmarks are saved on the Bookmarks tab ( ) with a search icon and the bookmark name

provided by the user.
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Saved bookmarks can also be found on the Navigate menu in the Bookmarks option.

When you click on a stored search bookmark, the search parameters are populated. Click the Search button
to rerun the search.
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Editing a Bookmark
Both standard navigation and Search Bookmarks can be edited in the Bookmarks tab by right-clicking the
bookmark and selecting Edit Bookmark in the context menu. You can edit the name of the bookmark and
also the object / search URL if the Edit URL checkbox is activated.

Removing a Bookmark
Both standard navigation and Search Bookmarks can be removed from the Bookmarks tab by right-clicking
the Bookmark in the tab and selecting Remove Bookmark on the context menu.
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Advanced Search
The Advanced Search tab, in combination with the Search Result Profiling page, offers extensive methods for
locating objects in STEP quickly and efficiently.

Generally, there are two approaches to performing searches:

1. If you know specific details about the object to find, use the Advanced Search tab. For example, all
products where the value for the attribute 'Weight' is less than '5 kg', the object is located below the product
folder 'Office Chairs' and is not of the object type 'Item'.

2. If you do not know details, start with a broad search and then narrow it down using the Search Result
Profiling.

Note: Objects in the Recycle Bin are not searched and will not display in search results.

Search Elements
The elements on the Advanced Search tab work together to create and refine a search for objects in STEP.
The numbered elements in the following image are described below.
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1. Search criteria type selector - Click the text to display a list of available search criteria options. Refer to the
Advanced Search Functionality topic for more information.

2. Add criteria / operator button - Click the plus button ( ) to add a new search criterion or hover the mouse
over and hold down the plus button ( ) to display a sub menu and choose anOR operator or an Exclude
operator. Refer to the Advanced Search Functionality topic for more information.
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3. Remove search criteria button - The X button ( ) clears an individual criteria from the search. Click the
Search button to refresh the Results Area.

4. Reset button - Clears all results and search criteria from the Search panel and Search Result Profiling
page.

5. Search button - Runs the defined search.
6. Search result counts - The number of items currently displayed and total number of items found by the

search. If the search finds objects not visible in the current context or objects that you are not privileged to
view, a message is displayed and the objects are not displayed in the search result.

7. Show Details / Hide Details toggle - Hyperlink shows or hides search result details. The details view
displays asset thumbnails. The asset thumbnail is displayed when the search is under a classification
folder and there are assets. Similarly, if the search is for the products and the product is linked to an asset,
the thumbnail is displayed. If no image is linked, 'No Primary Image' is displayed.

8. Search results list - When a search has been executed, the results are shown in a list below the search
box. Clicking one of the results will open the object editor for that particular object in the Search Results
Profiling pane, while continuing to display the search results list. It is also possible multi-selection from this
list and a maximum of 100 results are displayed. The complete result set can be viewed, exported, or
updated using the 'Operations on Entire Result' options below.

Note: The maximum results displayed can be adjusted via the case-sensitive
'DrillDownSearch.Maxresults' property in the sharedconfig.properties file. However, it is not advisable
to adjust the number more than 100 as the system performance diminishes as the number increases.

9. Save as Collection button - Click to open the 'Save as Collection' dialog and save the entire result set as a
collection. Collections are available on the Tree. Refer to the Advanced Search Operations on Entire
Result topic for more information.

10. Export button - Click to open the Export Manager wizard and export the entire result set to a specified file
type. Refer to the Advanced Search Operations on Entire Result topic for more information.

11. Bulk Update button - Click to open the Bulk Update wizard and modify a variety of elements on each item
for the entire result set. Refer to the Advanced Search Operations on Entire Result topic for more
information.

12. Search Result Profiling - Panel displays profiling information about the search including categories and
provides a convenient way to further refine the search. Refer to the Advanced Search Result Profiling topic
for more information.

Search Options
The Search tab dropdown includes a number of options. Each is described in greater detail in the topics that
follow.
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Advanced Search: Data Containers
Advanced Search: Document Content
Advanced Search: JavaScript Search
Advanced Search: Missing Mandatory Values
Advanced Search: Object Type
Advanced Search: Product Override Search
Advanced Search: Referenced Assets
Advanced Search: References and Referenced By
Advanced Search: References and Referenced By
Advanced Search: Revised Objects Changed Since
Advanced Search: Sample Result
Advanced Search: Search Below
Advanced Search: Search from List
Advanced Search: Search in Publication Hierarchy
Advanced Search: STEPWorkflow
Searching for Translation Status
Advanced Search: Unapproved
Advanced Search: Unpushed or Failed Assets

For information on performing optimal searches, refer to the Scheduled Process Recommendations topic in
the System Setup documentation.
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Advanced Search Functionality
This section describes the different types of search criterion available in the STEP system as well as some
basic search functions.

Important: Calculated attribute values are generated on-the-fly. Searching for the value of a calculated
attribute is not allowed since generating all possible calculations would cause substantial performance
issues.

Default Search Criterion
The default search criterion named 'Search' allows you to find objects based on name, ID, attributes and their
values.

A text string entered in the search field will search for object names, IDs, or attribute values where the text
occurs.

If you enter a text string and click the Search button, search finds objects with an ID, and/or a name and/or an
attribute and/or their values matching the entered string. You can further refine standard searches as shown
below.

Note: By default, searches are not case sensitive for name and attribute value searches, but searches are
case sensitive for ID searches. Make case sensitive name and attribute value searches using the
Advanced option 'Match Case on Names and Values.' For more information on the Advanced options,
refer to the Advanced Search: Advanced Options topic.

Search Field Typeahead
Once you start typing in the default search criterion text field, the system suggests possible entries matching
the typed in text (case insensitive), and displays them on a dropdown menu as shown below.
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In the typeahead menu, objects are displayed with their relevant icon, then name, and then ID in brackets.
Attribute values are shown as text.

Items can be selected from the menu using either the mouse or the keyboard 'arrow up' and 'arrow down'
keys. A maximum of 100 items will be displayed.

Note: Using sharedconfig.properties entries, it is possible for a system administrator to control the
behavior of the typeahead. E.g., after how many entered characters should suggestions be shown, etc.
Search for the 'TypeAhead' section on the Configuration tab. For more information, refer to the
Configuration topic in the Administration Portal documentation.

Limiting Results to Matches on IDs
You can limit standard searches to match on ID only by entering 'ID = ' at the beginning of the text field as
shown below.

'id' and 'Id' will also work, as the spaces on each side of the equals sign are optional.
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Limiting Results to Matches on Name
You can limit standard searches to match only on name by entering 'Name = ' at the beginning of the text field
as shown below.

'name' and 'NAME' also work since the spaces on each side of the equals sign are optional.

Attribute Value Searches
Using a standard search, you can limit the result to only match on values for specific Attributes.

Important: Calculated attribute values cannot be searched since they are generated only when viewed or
processed.

There are at least three ways to construct an attribute search query:

1. Start entering an attribute name or ID, then select the relevant attribute from the typeahead menu, to
display attribute name in the text field. Enter a search operator or enter a SPACE and select an operator
from the typeahead menu and enter the value to search for.

2. Enter the attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator
from the typeahead menu, then enter the value to search for.
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3. Enter the attribute name (case insensitive), enter a search operator or enter a SPACE and select an
operator from the typeahead menu, then enter the value to search for.

Note: As shown on the screenshot above, if you have the required privileges you will get typeahead
suggestions on existing values after having specified a search operator.

Attribute Value Search Operators
The following search operators that can be used when performing attribute value and reference metadata
attribute value searches.

Operator Description

< Less than operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)
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Operator Description

<= Less than or equal to operator. Only works for number validated attributes (Validation Base
Type = number, integer or fraction)

= Equal to operator.

> Greater than operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)

>= Greater than or equal to operator. Only works for number validated attributes (Validation
Base Type = number, integer or fraction)

! Operator used for finding objects where the specified attribute does not have values in
current context. The search does not check whether the attribute is valid for a given object.
Also, if the specified attribute has an inherited value (not a local value), then the object will
be listed in the results set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute
values.

!! Operator used for finding objects where the specified attribute does not have local values in
any context. The search does not check whether the attribute is valid for a given object.
Also, if the specified attribute has an inherited value (not a local value), then the object will
be listed in the results set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute
values.

Wildcards in Searches
The following two wildcards are available for performing searches on partial text strings:

* (asterisk ), multi-character, represents any number of characters in a string
? (question mark), single character, represents exactly one character

Wildcards can be used anywhere in the text string.

Note: Searches starting with a wildcard should be avoided since they are significantly slower than other
searches.
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Searches in 'Full Text Indexable' Attribute Values
Searches in values for attributes configured with the 'Full Text Indexable' parameter set to 'Yes' do not work in
the same manner as searches in other attribute values. Apart from common English words like 'in' and 'as,'
each word is indexed as a separate element. For more information about the words that are not indexed,
search the Oracle website for the 'English Default Stoplist.'

For example, consider an attribute named 'Description' that has the following value on a given product:

Black powder coated die-cast aluminum enclosure. Textured surface. Bulk version: Enclosures may
possibly have flaws in the finish such as scratches, dents, discoloration, etc.

If the 'Full Text Indexable' parameter is set to 'Yes' for the attribute, a search for 'Description = aluminum'
returns the product.

If the 'Full Text Indexable' parameter is set to 'No' for the attribute, a search to find this product would
require a wildcard on both sides of the 'aluminum' text like this: 'Description = *aluminum*.

Note: Searches starting with a wildcard (as shown above) are significantly slower than other searches.

By default, if you have not specified an attribute, typeahead for Full Text Indexed attribute value entries is
turned off. If you have specified an attribute, you will first get typeahead suggestions after having entered
three (3) characters of the value entry. Refer to the Search Field Typeahead section above.

While changing this setting is allowed on an existing attribute, it does required special handling. For Oracle
databases, this action requires single-update mode (SUM), as defined in the Single-Update Mode topic. For
Cassandra databases, this action uses Lock-free Schema Change (LFSC) functionality, as defined in the
Lock-free Schema Change topic.

Numeric Value Searches for Attributes with Units
Values for numeric searches with no units are assumed supplied in the default unit for the attribute. For
example, if kg is the default unit for the 'Weight' attribute, 'Weight = 1' will match '1 kg' and '1000 g'. If no
default unit is configured, the search 'Weight = 1' will only match the value '1' with no unit.

ISO Date Searches
If an attribute with the validation type of 'ISO Date,' where the date populated in the field is in the YYYY-MM-
DD format, a search on the populated attribute on objects can be performed using the following key words in
the Advanced Search tab: now, today, tomorrow, yesterday.

While it does not matter if the 'ISO Date' is set to 'Strict Validation' or not, it does matter that the date is written
in the YYYY-MM-DD format. Any other format, including using slashes ' / ' instead of dashes '-' will not work
since searches work by matching only values conforming to the ISO standard (with dashes). For this reason, it
is recommended that 'Strict Validation' be set to Yes, otherwise, the stored values are not guaranteed to be
searchable.
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In the example below, a user searched for an object that has a particular date. The user typed in the name of
the date attribute 'ISO Date', and then used an 'attribute value search operation' followed by the literal date.
(The keywords 'yesterday', 'today' and 'tomorrow' are also available.)

Using the 'Add Criteria' Operator
You can combine different search criteria to create advanced searches with the default 'AND' operator.

The search shown below:

generates the same results as the following search:
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Except for cases where one or more 'OR' operators are used, the sequence of the criteria does impact the
results. When no 'OR' or 'Exclude' operator is used, all criteria are added with the default 'AND' operator,
meaning that all criteria must be met to be included in the results.

Click the add operator button ( ), which applies the 'Add Criteria' operator, to construct a query that includes
more than one criterion.

As an example, the search shown below finds objects that have the value 'Red' for the 'Color' attribute AND
that are present below an 'Apparel' hierarchy node. The order of criteria does not impact the results.
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Using the 'Add OR' Operator
To add an 'OR' operator, click and hold the add operator button ( ), then select 'Add OR' from the menu.

When using 'OR' operators, search is divided into separate parts containing one or more criteria. Each part is
executed separately and the results are then compiled before presenting the final result.

Since it is not possible to work with parenthesis, when working with 'OR' operators it is often necessary to
configure the same criterion on each side of an 'OR' operator.

For example, the search shown below returns all objects where the ID starts with the text '1821' and the color
is 'Aqua,' plus all objects where the name starts with the text '1821' and the color is 'Aero Blue.'

Using the 'Add Exclude' Operator
You can negate search criterion, by using the 'Exclude' operator functionality.

To add an 'Exclude' operator (also referred to as a 'NOT' operator), click and hold the add operator button (
), then select 'Add Exclude' or click an 'exclude' link in the generated 'Search Result Profiling' panel after
displaying search results.

'Exclude' operators appear with red 'NOT' text on the left side of the criteria panel (shown below).
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Continuing with the example above, the search finds objects where all the 'positive' criterion are met, minus
objects where the objects are below the 'Writing Tools' node in the hierarchy.

When using an 'OR' operator, add the same 'NOT' to each section divided by an 'OR' operator.

When no 'OR' operators are used, the sequence of 'NOT' operators do not affect the results.

Note: A search that contains only 'Exclude' operators without an 'Add Criteria' will not generate any
results.
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Advanced Search Result Profiling
After performing a search, the Search Result Profiling panel displays statistics about the search grouped
under the headers Results by Object Type, Results by Position in Tree Hierarchy, and Results by
Value.

Displaying profiling statistics is controlled by the DrillDownSearch.GetStatistics property. The property
is set to 'true' by default, which allows result profiling to display automatically. When the property is set to
'false', the right-hand panel of the Search tab is empty regardless of the search performed.

Apart from displaying information about the results of your search, you can use the panel to further refine your
search. For example, if you start by running a broad search, you can refine it by clicking the links 'Exclude' in
the profile - thereby adding additional criteria to your search. Refer to the example below:

For all types of searches, the Search Result Profiling panel displays the results sorted byObject Type. The
screenshot above shows the Results by Object Type. The search result includes 78 Products of theObject
Type 'Product', 8 Assets (where 7 are of theObject Type 'TIFF Image' and 1 is of theObject Type 'JPG
Image') and finally 1 Attribute.

If you click TIFF Image, an Object Type Search Criteria is added to the search. The search runs again,
finding only objects with theObject Type 'TIFF Image.'

When an exclude option is selected, an additional search criteria called 'Add Exclude' is added as shown
below:
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If you click exclude next to TIFF Image, anObject Type Search Criteria is added to the search, but this time
as an Exclude Criteria. Hence, all objects of theObject Type 'TIFF Image' will be excluded from the search
result.

© Stibo Systems - Internal - 2024.4 - December 2024 301



Advanced Search: Advanced Options
Additional Advanced Search options for narrowing results are available within the Advanced section.

Each of the Advanced options is described below.

1. Match Case on Names and Values - When selected, Name and Attribute value searches are not case
sensitive. For example, this is a basic search with search criteria of 'Search = T-Shirt.'

The search results are displayed with all the objects in STEP that match the search criteria, in this case 'T-
shirt.'
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STEP objects in the search result can include:

Classification / Asset / Product / Entity objects

Special Types objects

System Setup Tab objects

Now, on the search, select the Advanced option 'Match Case on Names and Values.'

With this option selected, the search result will only include attribute values and all the object names in
STEP that match the search criteria in the correct case. Since the previous search results were all a
different case, this search will return no results.
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Note: ID searches are always case sensitive.

2. Include Inherited Values -When selected, attribute value search results will show objects where the
match includes inherited values as well as objects where the match includes locally defined values.

Attribute values with hierarchical inheritance (values with green triangle) will only be included in the search
result when Include Inherited Values option is selected.

Dimension dependent Attributes – Specification or Description attribute values inheriting from other
contexts (values with a red triangle) will also be displayed in the search result even when the user does not
select the option Include Inherited values.
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3. Exclude Values - When selected, attribute values are not searched for the entered search term. If
unchecked, attribute values are searched for the entered term and objects with the search term populated
as an attribute value are included in the search results.

The Exclude Values in advanced search are useful for excluding objects which are having search content
as a value in it. For example, assume there are attributes which has value 'Red' in few objects and there
are objects which has Object Name/ID as 'Red.'

If a typical search is performed, the results for 'Red' are shown below.

If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and
Names matching the search are turned.
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4. Regular Expression - When selected, attribute values are searched using the regular expression entered
in the Search text box. Although establishing an attribute with Validation Base Type of Regular Expression
allows more than 2000 characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only
returns results for matches within the first 2000 characters. For more information, refer to the Regular
Expression topic in the Resource Materials online help documentation.

5. Include Data Containers - Include any search terms contained inside data containers.
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Advanced Search Operations on Entire Result
These operations are found at the bottom of the Advanced Search tab.

Language-dependent searches and exports

When exporting search results or exporting a collection made from search results, the context selected when
performing the search is used in the 'Displaying # of # results' list of objects found and the Export Manager
Advanced tab Context field determines which values are exported.

If a search or a collection from an Advanced Search is based on a language-dependent attribute's Name, the
export file is blank if the context selected in the Export Manager does not match the context selected during
the search or collection creation.

To export objects with their relevant language-dependent attribute values regardless of the context in use
during search or collection creation, use the 'Search from List' criterion using the ID option from the dropdown
(as defined in the Advanced Search: Search from List topic) and paste in a list of the object IDs to search on
and export. Or, perform the search only on the attribute ID along with a wildcard (*) for the attribute value.

Save as Collection
After conducting a search, you can save the search result as a collection.

Click the 'Save as Collection' button ( ) and specify the location, ID, and Name, of the new collection. For

more information on collections, refer to the Collections topic in the Getting Started documentation.
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Export
After conducting a search, you can export the search result by clicking the Export button ( ) at the bottom of

the Advanced Search tab.

On the Select Objects step of the Export Manager, all the objects in the search result are considered. The
objects exported are determined by the selected export format and the other selections made in the Export
Manger. For more information on using the Export Manager, refer to the Export Manager topic in the Data
Exchange documentation.
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Bulk Update
After running a search you can perform a Bulk Update on the entire search result.

Click the Bulk Update button ( ) to display the Bulk Update wizard. The search result is set as the dataset.
For more information on bulk updates, refer to the Bulk Updates topic in the Bulk Updates documentation.

Note: To bulk update only some of the objects in the result, select or multi select in the search result and
then click the 'Run Bulk Update' option on the File menu.
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Advanced Search: Data Containers
The Data Containers search criterion allows users to limit search results to only objects for which data
containers exist for the specific data container types, or those objects for which specific attributes are linked
via data containers.

Searching for objects with information in data containers is available using the standard search criterion and
also using the specific Data Containers criterion. Each method is defined below.

For more information on data containers and the terminology used in this topic, refer to the Data Containers
topic of the System Setup documentation.

Standard Search Including Data Containers

This option searches data containers and other identified objects for the defined values. For more information,
refer to the Examples section below.

1. Click the Search tab, and select Search from the dropdown.

2. Open the 'Advanced' flipper and check the 'Include Data Containers' option.
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3. If needed, click the green plus button ( ) to add additional search criteria.

4. Click on Search to run the search and view results.

Data Containers Only Search

This method requires that the searched data exist in a data container. Matching data outside of data
containers is not displayed. For more information, refer to the Examples section below.

1. Click the Search tab, and click the Search dropdown.

2. In the Search Criteria Type Selector, select the 'Data Containers' search criterion.

3. Supply the Data Container Type parameter and the additional text input parameter as needed:
Continue to the next step without populating either parameter to return all objects for which any data
container of any data container type that has been added.
Click the ellipsis button ( ) for the Data Container Type parameter to limit the search results to only
those objects for the selected data container type. Click Select and then click Search. The search
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returns a list of objects for which the data container type has been added, even when no attribute values
exist in the data container. For more information, refer to the Examples section below.

If necessary, narrow the search using additional search terms in the text input parameter. Type the
selected ‘Data Container’ attribute to display typeahead suggestions. Once selected, the available
operators =, <, >, <=, >=, !, !! are displayed. If the selected attribute has a value in the ‘Data Container’
tab, the values display as a dropdown. However, the search result will be displayed only for the attribute
value which is present for the attribute in the Data Container tab. For more information, refer to the
Examples section below.

4. If necessary, open the Data Containers Advanced flipper and set the following parameters:
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Instance count - specify a number of data container instances an object must have.
Match Case on Values - makes the search case sensitive.
Regular Expression - search data containers using a regular expression. For more information, refer
to the Regular Expression topic in Resource Materials online help.

5. If needed, click the green plus button ( ) to add additional search criteria.

6. Click on Search to run the search and view results.

Examples

The following examples show a variety of searches for values in data containers.

Standard Search for Product Data Container Value

The dataset includes an object with a Flat Crush Test value of '10 kN'. This value is in a product data
container.

Searching for the value '10 kN' with the standard Search criterion returns 0 results.
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Checking the Advanced option to 'Include Data Containers', and searching again, displays the object as a
result.

Standard Search for Entity Data Container Value

In this example, a user searches for all instances of the value 'BAHAMAS' in STEP. Select the standard
'Search' from the dropdown, add 'BAHAMAS' into the text input parameter, open the advanced flipper and
check the 'Include Data Containers' option, and click Search. The results includes Customer A and Customer
B entity objects where 'BAHAMAS' occurs inside a data container, and also includes the 'BAHAMAS' values
that appear outside of data containers.
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Data Container search for Entity Data Container Type

In the example below, a user searches for a data container type called 'Shipping Address' without refining the
search any further. If the user selects 'Shipping Address' as the Data Container Type and clicks Search, a list
of entities for which a data container has been added to an entity under the data container type 'Shipping
Address' will display. In this instance, four entities are listed.

© Stibo Systems - Internal - 2024.4 - December 2024 315



The entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of 'ARGENTINA' in the
Contact tab, but with the value of 'BAHAMAS' on the Data Containers tab.
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When a search is performed on the ‘Shipping Address' data container and the attribute 'Country Code' is
selected, all of the values are displayed. The search result will display the entity ‘Customer B’ only if the value
is ‘BAHAMAS.’ The search result will return ‘0’ if the value selected is ‘ARGENTINA’

Data Container search for Entity Data Container Type and Value

To continue the previous example, if the user refines the search for entities with a 'Country Code' data
container type to only include those data containers containing the value 'BAHAMAS', the user would enter
'BAHAMAS' in the input field. In this example, results returned from the search show two of the original four
entities. This means that a 'Shipping Address' data container has been added to these two entities, and an
attribute within those data containers also contains the value 'BAHAMAS'.
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Advanced Search: Document Content
With the Document Content search criteria you can search for a specified word / text string in text
documents stored as Assets in STEP.

Important: A prerequisite to searching in documents is that they are indexed. Document Content displays
as a search option only in systems that have full text indexable functionality enabled and are not running
In-Memory.

1. Click the Search tab and in the Search dropdown select Document Content.

2. Enter the word / text string into the text field that appears.

3. Click the green plus sign ( ) to add additional search criteria. (Optional)

4. Click on 'Search' to run the search and view results.
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Advanced Search: JavaScript Search
The JavaScript search criteria searches through all JavaScript in STEP. It can match items according to
Business Rules, Match Algorithms, Decision Tables or any other structure programmed through JavaScript.

Follow the steps below to set up a JavaScript Search:

1. Click the Advanced Search tab and click the Search dropdown.

2. Select JavaScript search.

JavaScript Checkbox Options

These checkbox options are available with JavaScript search criteria:

Match Case: If you select this, the search will only return results that match the upper or lower case letters
that are in the search criteria.
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Match whole word only: will return only results that are the exact criteria that were put in that standalone.
An example would be if the letter 'a' were typed into a search, and only results that had 'a' in it that
standalone somewhere in the JavaScript were returned.
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Advanced Search: Missing Mandatory Values
The Missing Mandatory Values search criteria is used for finding Product objects that have validMandatory
Specification attributes without values.

To set a criteria as aMissing Mandatory Values search:

1. Click on the Search tab and click the Search dropdown.

2. SelectMissing Mandatory Values from the dropdown.

Use Cases
1. Product object which has specification and description attribute as mandatory with empty values.

The 'Product Name' attribute is set as mandatory for Item Object Types. For Object 22200, the attribute
value is left empty. In the Advanced Search tab, Missing Mandatory Values search criteria is used with
Object Type ‘ProductsRoot’ search criteria. 22200 is included in the search results.
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2. Description attribute is mandatory and is left blank on entity object.
In this example, the 'Available Sizes' description attribute is set to mandatory. On the address entity ADD_
107837, the 'Available Sizes' attribute is empty. A search is performed that has a 'Missing Mandatory
Values' search criteria with Object Type ‘Entity root’ search criteria. The ADD_107837 object is returned
as a result.
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The search criteria requires no data input or selections to be made. However, it is encouraged to use in
conjunction with another search criteria (by clicking the green + sign) to help further refine the search.

Note: As theMissing Mandatory Values search criteria only works on Product objects, using it in
combination with other search criteria will limit the search result to such objects.

The Missing Mandatory Values search criteria can also be set to exclude Product objects with missing
Mandatory values. This functionality is described in Using Exclude Search Criteria within the Search
Functionality topic.

© Stibo Systems - Internal - 2024.4 - December 2024 323



Advanced Search: Object Type
With theObject Type search criteria you can limit your search result to items of a specificObject Type.
These objects are maintained in the workbench System Setup > Object Types & Structures folder.

1. Click on the Advanced Search tab and click the Search dropdown.

2. SelectObject Type from the dropdown.

3. In the dropdown that displays 'Product' by default, select an object type. Refer to the System Setup
Object Types section below for more information.
Hover on an object type to display a sub menu when available.

When anOther... option is available, click it to display a selection dialog. Use the Browse or Search tab
to select the object type. Click Select to confirm.
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4. If needed, click the green plus button ( ) to add additional search criteria. For example, return only
products with the text 'ACME'.

Note:Without the additional search criterion shown above, the results will be a list of all objects of the
specified type.

5. Click Search to run the search and view results.
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System Setup Object Types
The following object type selections require further information.
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Attributes, Lists of Values, and Units

The Attribute, List of Values, and Unit object type categories do not include sub selections. All of the selected
object types available will be searched for each of these categories.

Special Types

Special Types includes Table Type, Business Rule, Business Library, Business Condition, Business Action,
and Business Function object types.
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Advanced Search: Product Override Search
With the Product Override search criteria you can locate and identify any product overrides present in your
system. You can search for all overrides in STEP or you can narrow your search to overrides of a specific
product. If more concise results are required, you can specify sub-products.

1. Click on the Search tab and click the Search dropdown.

2. Select Product Override Search from the dropdown.

3. In the Overridden Product group, select a radio button :
Find All - Searches for all product overrides.
Find by Overridden Product - Searches for the specified product, as shown in this image. In the text
box, either type the product's name, or click the ellipsis button ( ) to browse or search for a product.
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4. In the Sub Products group, set the following options as needed:
Exact Match on Child Products - When checked, search results must have every sub-product
specified.
Add Child Product - Click the link to select sub products that will narrow the search further by requiring
search results to have exactly the specified sub-products linked to them.

Click the arrow button ( ) on one or a group of rows to display the following menu and perform the action:

Hide - Hides an added child product from list.
Show All Rows - Show all hidden child products.
Add Child Product - Does the same operation as the ‘Add Child Product' link as stated above.
Remove sub product - Removes the selected child product.
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5. If needed, click the green plus button ( ) to add additional search criteria.

6. Click on Search to run the search and view results.
This image shows products with the specified child product, but others child products could exist as well.

This image shows there are no overridden products with only this exact sub product.
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This image shows overrides regardless of sub products.
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Advanced Search: Referenced Assets
The Referenced Assets search criteria is used for finding product objects which has referenced assets to the
specified product.

By default, all local referenced assets for the specified product are displayed.

To set up Referenced Assets search criteria:

1. Click on the Search tab and click the Search dropdown.

2. Select Referenced Assets from the dropdown.

3. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By
running a basic search, it will return results of all referenced assets of the product specified.
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Note: If the product ID and name are the same, or if the product name has numbers as part of its name,
the search result will still display all the local referenced assets of the product specified.

Checkboxes for Referenced Assets Search
When performing a search, there are two search checkbox options that can be selected.

Include Inherited Assets - This option is used when the inherited referenced assets on the specified
product are to be included in the search result.
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Match Case on Names - This ensures that the specified product name is searched matching the case
(case sensitive) and all local referenced assets are displayed in the search result.
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Advanced Search: References and Referenced By
The References and Referenced By criteria work similarly.

To navigate to either of these searches:

1. Click on the Search tab and click the Search dropdown.

2. Select References or Referenced By from the dropdown.

Both options require a reference type selection to begin. Reference types are setup in STEP Workbench
System Setup tab in the Reference Types folder, and the Web UI Advanced Search allows you to pick from
image and document reference types, classification reference types, and product reference types.

© Stibo Systems - Internal - 2024.4 - December 2024 335



Once a reference type is entered, no additional options need to be filled in to start a search. Use the
information at a high level or fill in the other values to drill down further (e.g., multi-supplier item references).
Select a reference source under Referenced By and a target under the References. Plus enter specific
attributes and values to search reference metadata.

References
For References, there are three boxes that can be checked: Include Inherited References, Include Data
Container References, and Finding Missing References.

Include Inherited References: When this is selected, it will show items that have the particular search
criteria passed down to them from a parent folder or level.

Include Data Container References: When this is selected, references that appear on data containers may
appear in the search results.
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Finding Missing References: When the reference type is selected, and this box is checked, the populated
results will show all items that have that particular missing reference.
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Reference Target

The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button.
This will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’
search field.

In this example, the ‘Reference Type’ field is empty. Hence the result is irrespective of the reference type.
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The search result will differ when we specify the ‘Reference Type’.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and
select the appropriate option. For more details on the advanced options, refer to the Search: Advanced
Options topic.
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Referenced By

Reference Source

The user must type the ID / Name of the source to search. It will list the items which have been used as a
source.

Click the ellipsis button ( ) to browse for a reference type for search either type in the reference type ID /
Name for more restricted search.
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If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open
the Advanced flipper and select the appropriate. For more details on the advanced options, refer to the
Search: Advanced Options topic.
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References and Referenced By Metadata Attribute Value Searches

Values for metadata attributes may be searched by using the References or Referenced By search options.
Users may indicate any value to search allmetadata attributes for a matching value. The following pictures
will demonstrate with References, but know that the same holds true for Referenced By.

Alternatively, users may enter an attribute ID or name, operator, and value for a more restricted search.

Note: It is not possible to perform searches on missing metadata values.
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Advanced Search: Revised Objects Changed
Since
With the Revised Objects Changed Since search criteria you can find recently edited objects in the
workbench. To narrow your search, enter an exact date / time to determine how old the changes can be, or
you use intervals of days, hours, or minutes. Revised Objects Changed Since criteria can be combined with
any other search criteria.

1. Click on the Search tab and click the Search dropdown.

2. Select Revised Objects Changed Since from the dropdown.

3. A dropdown appears with the following options:
Date
Interval of Days
Interval of Hours
Intervals of Minutes

Note: Only number values are accepted as input for the options Interval in days, Interval in hours,
Interval in minutes. When Days/day, hour/Hours/H, or minutes/Min/M is suffixed along with number,
the number value is considered.
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For the purpose of this example, 'Date' will be used for the 'Revised Objects Changed Since' search field.
The Date option will provide a data picker, allowing for the selection of the data and time.

4. Click the ellipsis button ( ) and determine the date / time of the oldest objects to search. ClickOK.

5. If necessary, click the green plus button ( ) to define additional search criteria.

6. Click on Search to run the search and view results.
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Interval in days – Specify the number value in the field.

The search result is displayed as shown below with objects which are revised since last 3 days.

Interval in hours –Specify the number value in the field.
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The search result is displayed as shown below with objects which are revised since last 60 hours.

Interval in minutes – Specify the number value in the field.

The search result is displayed as shown below with objects which are revised since last 30 minutes.
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Advanced Search: Sample Result
The Sample Result Search Criterion allows users to refine the search results to only those specified numbers.
When the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a
user enters a random number and clicks on the Search button, the search result will be zero. Hence, this
option should always be appended to an existing search. Add a numeric value for 'Sample Results Size' to
further refine the search result based on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has
125 products. To do so, on the Advanced Search tab add a Search Below criterion and select the appropriate
node to search below. For more on how to search below, refer to the Advanced Search: Search Below topic.
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Now, to append the results with the ‘Sample Result’ search criterion, click the 'Add Criteria' button ( ) and
select 'Sample Results' from the dropdown and enter a sample size and click the Search button. In this
example ‘10’ is the Sample Results Size.

A set of random results display and around the specified sample results size number. Click the Search button
multiple times to change the sample search results.
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Advanced Search: Search Below
The Search Below Search Criteria allows you to limit your search result to objects below a specified node in
the System Setup or Tree tab hierarchy.

Note: The search below option can be applied to the following object types only: attribute, classification,
collection, entity, product, and publication.

1. Click on the Search tab and click the Search dropdown.

2. Select Search Below from the dropdown.

3. Click the ellipsis button ( ) to display the Search Below... dialog. By default the Primary Product
Hierarchy is selected as search criteria.
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4. Select a node in the hierarchy and click the Select button.
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5. Click the Search button

The Results displayed includes only items at or below the selected node. Additionally, the selected node
for the search below criteria will also be included in the search results. In the example shown below, Hats
and Caps Items is also included in the search result
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Advanced Search: Search from List
With the Search from List search criteria you can search using a list of data. This data can be manually
entered into the user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet.
Users may specify whether the entered data should be used to search for object IDs, names, key values,
attributes values (with specification of the particular attribute), or other criteria. This makes Search from List
an efficient and easy way to find large numbers of objects in STEP and, in combination with other available
search option, suitable for highly complex and extensive searches.

1. Click on the Search tab and click the Search dropdown.

2. Select Search from List from the dropdown to display a text field and dropdown with a number of options
based on your system.

In this example, we choose Search from List: ID, which allows specifying the data list in the text field and
searching by 'ID' (selected from the dropdown).

3. Use one of the following methods to enter the data list to search in the text box:
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Manually use the Enter key to create a line break between each value.
Copy data from Excel or any other application where line breaks or tabs are included to separate the
values. Each value must be listed on a line or be separated by a tab delimiter, without any characters
(including bullet indicators and spaces) around it. Refer to the Using a Data List from an External
Application section below.

4. If needed, click the green plus button ( ) to add additional search criteria.

5. Click on Search to run the search and view results.

© Stibo Systems - Internal - 2024.4 - December 2024 355



Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID

Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example
above.

Search from List: Name

Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.

Enter the values to search into the text field. Click Search to run the search and view results.

The search results display with the name of the objects specified in the data list.
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Search from List: Key

Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the
data list.
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It is important to keep in mind that:

Only active keys will be available as an option in the dropdown list.
Active Keys that have values in products can be searched.
Searching for active keys with empty values in a data list field will NOT return search results.

For more on keys and how to activate them, refer to the Unique Keys documentation.

Search from List: Attributes

Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute' from the
dropdown.
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Note: Description attributes are displayed under the product hierarchy node in the folders for which they
are valid.
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The search results display with the attributes specified, in this case it is the attribute 'Color' which holds values
of 'Orange.'
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It is important to keep in mind that:

Only one attribute can be selected from the Attribute Group browse / search window to be used as search
criteria.
Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes
the object that contains the searched value as a local value. While this object may not match an object type
restriction, it points to the origination of the searched text.
Attribute values inheriting from other contexts can be specified in the data list.
Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be
displayed with any search result. (This restriction is not limited to the Search from List functionality.)

Using a Data List from an External Application

Copied data can come from Excel or any other application as long as line breaks or tabs are included to
separate the values. To copy data in, each value must be listed on its own line or separated by a tab delimiter,
(tab key from keyboard) without any characters (including bullet indicators and spaces) around it.

In the example below, IDs have been copied over from an external file. Data can be horizontal or vertical as
long as the appropriate line breaks or tabs are in between the values.
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Advanced Search: Search in Publication
Hierarchy
Objects below a specific publication hierarchy can be searched, and the status or a specific result can be
determined, by using the ‘Search in Publication Hierarchy.’

Keep in mind that this search is not used to search for different templates (such as products, publications, or
page templates) or to search number of objects / links placed in product template. It is only used to search the
objects below a specific publication hierarchy.

Note: To use 'Search in Publication Hierarchy' in the Advanced Search tab, it is recommended to have
prior knowledge of Print Publisher and the publication hierarchy. For more information, refer to the
Publication Hierarchy section of the Publisher (Adobe InDesign Integration) documentation.

To search in a publication hierarchy:

1. Click on the Search tab and click the Search dropdown.

2. Select Search in Publication Hierarchy from the dropdown.
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Note: The search criteria requires no data input. However, it is helpful to further refine the search by
pressing the plus sign button ( ), and entering in information to limit the search results.

3. Supply information for the following parameters:

Search below: Used for choosing a node. Select either the publication group or publication. The search
result will display all matched product objects which are under the selected publication group or
publication.
Search for: Specifies what object is being searched.

Search for

The available options in the dropdown are:

1. Objects linked to Publication / Section: When this option is selected, products and assets linked to a
publication will be displayed in the result.
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2. Objects in Assortment Lists: This is a legacy component.
3. Objects in Baskets: The products saved in a Basket will be displayed in the results.
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4. Object on actual pages: the product and asset are used on actual pages (DTP documents) and will
display the results field.
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5. Object on planned pages: The products and assets used on planned pages will be displayed in the
result.
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Advanced Search: STEP Workflow
With the STEP Workflow search criteria you can search for and monitor STEP workflows. Selecting a
specific workflow from the dropdown list will show all items associated with the workflow. You can also specify
the workflow state to narrow your search.

1. Click on the Search tab and click the Search dropdown.

2. Select STEP Workflow from the dropdown to display two additional dropdowns with options based on
availability in your system.

In this example, 'Sales Item Creation' will be used for the STEP Workflow search field.

3. For the State dropdown, specify the state to search within.
Select a state defined in the workflow to search only items currently in the state.
Select [any State] to search the entire workflow, as shown in this example.
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Select [not in STEP workflow] to search objects which are not present in the selected workflow.

4. If needed, click the green plus button ( ) to add additional search criteria.

5. Click Search to run the search and view results.
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Advanced Search: Unapproved
This criteria is used to identify objects that are not currently approved. These include classifications, products,
images and documents, and entities setup to beWorkspace revisable.

1. Click on the Search tab and click the Search dropdown.

2. Select Unapproved from the dropdown.

3. Select the appropriate radio button and set the checkbox:
Never Approved or Modified in Main: All objects that have 'Never been approved' and have been
'Modified in main'.
Never Approved: Objects (products, classifications, assets & documents, or entities) that are
workspace revisable and that have never been approved.
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Modified in Maintenance: Objects that are modified after the approval or added to in the maintenance
workspace.

Status in Current Context: When this box is checked, only the current context is searched. If unchecked,
all objects in all contexts are searched.
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4. If needed, click the green plus button ( ) to add additional search criteria.

5. Click Search to run the search and view results.
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Advanced Search: Unpushed or Failed Assets
The Unpushed for Failed Assets search criteria allow you to identify assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Error.'

1. Click on the Search tab and click the Search dropdown.

2. Select Unpushed or Failed Assets from the dropdown.

3. Click the ellipsis button ( ) to display the Select Asset Push Configuration dialog.
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4. Select a configuration and click the Select button.

5. Click the Search button to display the Search Results List and Profiling information.
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Note: Click an item in the list to view it, or click a profiling link to update the search results list.

© Stibo Systems - Internal - 2024.4 - December 2024 377



STEP Workbench Keyboard Shortcuts
Within STEPWorkbench there are many shortcut key combinations that allow users to quickly navigate and
make changes through the system. The following tables list and describe the options available for Shortcut
Key options.

Basic Shortcuts
Shortcut Description Shortcut

Key

Copy Creates a duplicate of the information selected that can be pasted
somewhere else.

Ctrl + C

Cut Takes away information that can be pasted into a different location if desired. Ctrl + X

Duplicate This duplicates the item selected, with the option to duplicate references as
well.

Ctrl + J

Go To Next
Object

Finds the next item that matches what the user is looking for based on a
search. The results may differ depending on what tab the user is working
with, or the selected active area.

Ctrl + E

Help When workbench is open, displays a new window that with the STEP Online
Help documentation.

F1

Next Shifts the focus to the next cell. Tab

Paste When information that was either cut or copied from before is placed into an
alternate area.

Ctrl + V

Previous Shifts the focus to the previous cell. Shift + Tab

Redo Goes to the changed sate, if the change was reversed. Ctrl + Shift
+ Z

Reload Reloads the workbench and updates to any changes made. F5

Search This brings the user to the Search field in the upper right corner of the
workbench screen to look up items.

Ctrl + G
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Shortcut Description Shortcut
Key

Select All When the desired area is clicked in or is already the active area, pressing this
key combination will choose everything in this particular area.

Ctrl + A

Undo Goes back to the original state before the change was made. Ctrl + Z

Navigate to Main Side Bar Tabs in Workbench
Shortcut Description Shortcut

Key

Advanced
Search Tab

Leaves the user looking at what they were on in the main frame, but brings
up the Advanced Search Tab along the left hand side.

Ctrl + F

Background
Process Tab

Unless a product is being viewed, this will bring the user to the Background
Processes tab. If a user is on a product, this key combination will not
transpire.

Alt + P

Bookmarks Brings the user to the Bookmarks side tab. Alt + M

System Setup
Tab

Brings the user to the System Setup tab. Alt + Y

Tree Tab This will bring a user to the Tree Tab only if not viewing an item in Tree in
the main screen, or having an item still show up in the main screen even
though navigation has been away from it.

Alt + T

Workflow Tab Navigates to the STEPWorkflows tab. Alt + W

Navigate to Horizontal Tabs within Sidebar Tabs
To navigate to the horizontal tabs within the main tabs in workbench, press Alt + (the letter underlined on the
tab).

For example, if a workflow is selected within System Setup, pressing Alt + S displays the Status tab for the
workflow being viewed because 'S' is the underlined letter for the Status tab.
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Options for shortcut keys to horizontal tabs vary depending on what item is selected and the tab that a user is
on (Tree, Advanced Search, BG Processes, System Setup, Bookmarks, and STEPWorkflow). Not all tabs
have underlined letters for shortcut key options.

General Shortcuts in Workbench
Shortcut Description Shortcut

Key

Add Bookmark When on an object and this is pressed, it will add the item to the
bookmark list on the Bookmark tab.

Ctrl + D

Add Element When adding various elements, pressing this key combination will
often (not in all cases), bring up a dialog allowing the user to add to
the desired list.

Ctrl + Plus

Approve Object When in Main, approves an object that was previously unapproved. Ctrl + Shift
+ J

Mark Different (On
multi-product
display)

In Tree, when viewing multiple products at once, or when viewing
the horizontal Sub Products tab for an item, selecting this key
combination will mark all areas that are different green.

Shift + F12

NewWindow With STEPWorkbench open, this will open an additional STEP
Workbench window.

Ctrl + N

Remove Element When deleting various elements from lists or rows, pressing this key
combination will often remove the desired connection or item.

Ctrl +
Minus
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Shortcut Description Shortcut
Key

Rotate Table (On
Multi-Product
display)

In Tree, when viewing multiple products at once, or when viewing
the horizontal Sub Products tab for an item, this rotates the table
view if the table is the active area.

F11

Toggle attribute
values selection
between blinking
cursor and blue filter

When on a field that is editable, selecting F2 allows the user to write
in the field. When pressed again, the entire field turns blue,
rendering it entered and non-editable, unless F2 is pressed again or
the field is clicked into again.

F2

Insert Options
Shortcut Description Shortcut

Key

Insert Action Set In System Setup, when in the Action Sets, pressing this
key combination will create a child Action in an Action set.

Ctrl + Shift
+ S

Insert Asset The Create Asset dialog appears when in Tree. Ctrl + Shift
+ A

Insert Attribute Displays the Create Attribute dialog in System Setup. Ctrl + Shift
+ T

Insert Attribute Group In System Setup, this creates a new Attribute Group if
sitting on the proper level.

Ctrl + Shift
+ I

Insert Background
Process to Monitor
Deadlines / STEP
Workflow Deadline
Monitoring

This allows a user to set up a background process to
monitor states with exceeded deadlines in the desired
time frame.

Ctrl + Shift
+ D

Insert Character Tag When typing in a field and this is selected, a dialog
appears allowing the user to select from character tags.

Ctrl + R

Insert Classification In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+ C
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Shortcut Description Shortcut
Key

Insert Classification Root In Tree, a new Classification Root or top node yellow
folder is created.

Ctrl + Shift
+ R

Insert Dimension In System Setup, when sitting on the top node for
contexts, clicking these keys will bring up the dialog to
create a new dimension.

Ctrl + Shift
+ D

Insert Dimension Point In System Setup, when on a dimension, selecting this will
create the dimension point.

Ctrl + Shift
+ M

Insert Group In System Setup, when on the node that houses Users
and Groups, selecting this key combination will create a
new group.

Ctrl + Shift
+ G

Insert List of Values In System Setup, when sitting on the top node for List of
Values, pressing this will bring up the dialog to create a
new List of Values.

Ctrl + Shift
+ L

Insert non-breaking
space

Enters a non-breaking space when editing attribute
values.

Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute,
which will appear in italics.

Ctrl + Shift
+ O

Insert Product When in Tree, this will create a new object under the one
selected.

Ctrl + Shift
+ P

Insert Special Character When in a field that allows typing, selecting this brings up
a list of characters that can be selected and inserted into
the field.

Ctrl + Shift
+ E

Insert STEPWorkflow In System Setup, when on the top node for workflows, or
when inside the node for workflows, selecting this will
bring up a new STEPWorkflow Designer window to
create a new workflow.

Ctrl + Shift
+ R

Insert Workspace In System Setup, when on a workspace, selecting this key
combination will create a different workspace.

Ctrl + Shift
+ W
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Linking Options
Shortcut Description Shortcut

Key

Link Asset When on References or References By tab, this allows asset links or
references to be selected and put into the appropriate folders. Note that
the Reference Type can be changed from the drop-down menu in the
dialog that appears.

Ctrl + Shift
+ F

Link Attribute to
Classification

To link an Attribute to an item, select the item that needs the attribute and
select this key combination. Linked attributes will appear in the
References tab under the 'Attributes' section.

Ctrl + Shift
+ Y

Link Attribute to
Product

When on a product, selecting this key combination links an attribute to a
product.

Ctrl + Shift
+ K

Link
Classification to
a Product

This links a classification to a product. It can be found under the
Reference tab under the 'Linked Attributes to Classifications Hierarchy'
section.

Ctrl + Shift
+H

Paste Link Creates a new reference (pointer or link) to an existing / copied object. An
example would be if the user copied a SKU from a blue folder and pasted
it into the yellow folders. Note that object types need to be compatible.

Ctrl + L

Link Product /
Create Link

When on References or References By tab, this allows product links or
references to be selected and put into the appropriate folders.

Ctrl + Shift
+ Q

Style Options
Shortcut Description Shortcut

Key

Bold When typing in a filed, this activates bold text. Ctrl + B

Character Tag Opens the Insert Character Tag dialog for adding character tags to
attribute values.

Ctrl + R

Italic When typing in a field, this activates italic text. Ctrl + I

Non-breaking Enters a non-breaking space when editing attribute values. Ctrl + Enter
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Shortcut Description Shortcut
Key

Space

Special
Character

Opens a dialog showing the most recently used special
characters, as well as an option to select to view all special
characters. Allows user to select a special character to insert
when editing attribute values.

Ctrl + Shift
+ E

Style This key combination can be pressed to bring up the Style box,
where there are a number of styles to choose from.

Ctrl + Y

Rich Text
Editor

Opens the Rich Text Editor in STEPWorkbench when editing an
attribute value.

Alt + F2

Paste and
Match Style

When in a field, if 'text A' is copied from one area and is going to be
pasted into 'text B' that is a different style, pressing this key
combination will make it so the copied 'text A' will past into 'text B'
with the style of 'text B'.

Ctrl + Shift
+ V

Flatplanner Shortcuts
Shortcut Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctrl + Alt + S

Zoom In (In Flatplanner) This zooms in on what is being worked on. Ctrl + Plus

Zoom Out (In Flatplanner) This zooms out of what is being worked on. Ctrl + Minus
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